FlexNet Manager Suite Adapters Reference
Contents

Preface: Adapters................................................................. viii

Part I: Using the BMC Discovery (ADDM) Adapter......................... 9

Chapter 1: Choosing a Configuration........................................ 10
How the Adapter Works................................................................. 11
Components Explained..................................................................... 11
Optional Patterns........................................................................... 12
The FlexNet inventory agent............................................................... 14
Database Table Creation................................................................. 15
The Adapter Executable................................................................. 15

Chapter 2: Installation and Configuration................................. 20
Choosing a Staging Server................................................................. 21
Creating the Staging Database Tables............................................... 21
Installing and Configuring the Staging Tool..................................... 23
Installing the FlexNet inventory agent............................................ 24
Configuring BMC Discovery............................................................. 25
  Installing Optional Patterns.......................................................... 25
  Enabling Optional Patterns......................................................... 27
  Rediscovering Affected Computers............................................... 27
  Account Configuration............................................................... 28
  Validation and Operation........................................................... 29

Chapter 3: Known Issues......................................................... 31

Chapter 4: Appendix A: Details of Patterns................................. 32
Overview of Patterns...................................................................... 33
FileEvidence.................................................................................... 33
  To configure the FileEvidence pattern......................................... 35
InstallAnywhereEvidence.................................................................. 36
InstallShieldMultiplatformEvidence............................................... 37
UnixHardwareData......................................................................... 38
WindowsLastLoggedOnUser............................................................ 40

Part II: App-V Server Adapter.................................................. 42

Chapter 1: Architecture, Components, and Prerequisites.......... 44
  Architecture and Operation for App-V 4.6..................................... 45
<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Set Up and Operations</td>
<td>52</td>
</tr>
<tr>
<td>2</td>
<td>Obtaining (and Deploying) the Adapter Components</td>
<td>53</td>
</tr>
<tr>
<td>2</td>
<td>Command Line for PowerShell Script</td>
<td>57</td>
</tr>
<tr>
<td>2</td>
<td>File Format for .raa</td>
<td>59</td>
</tr>
<tr>
<td>2</td>
<td>Configuring the Adapter</td>
<td>60</td>
</tr>
<tr>
<td>2</td>
<td>Import Evidence and Recognize Applications</td>
<td>63</td>
</tr>
<tr>
<td>3</td>
<td>Issues and Limitations</td>
<td>67</td>
</tr>
<tr>
<td>3</td>
<td>Limitations</td>
<td>68</td>
</tr>
<tr>
<td>3</td>
<td>Investigating Issues</td>
<td>69</td>
</tr>
<tr>
<td>3</td>
<td>Known Issues</td>
<td>72</td>
</tr>
<tr>
<td>4</td>
<td>Data mapping</td>
<td>74</td>
</tr>
<tr>
<td>4</td>
<td>App-V Release 4.6 Data Transfers</td>
<td>75</td>
</tr>
<tr>
<td>4</td>
<td>App-V Release 5.0 (and Later) Data Transfers</td>
<td>76</td>
</tr>
<tr>
<td>III</td>
<td>BMC Atrium and Remedy Integration</td>
<td>79</td>
</tr>
<tr>
<td>1</td>
<td>Architecture, Operation, and Prerequisites</td>
<td>80</td>
</tr>
<tr>
<td>1</td>
<td>Architecture and Operations</td>
<td>81</td>
</tr>
<tr>
<td>1</td>
<td>Prerequisites</td>
<td>83</td>
</tr>
<tr>
<td>1</td>
<td>Obtaining the Adapter Components</td>
<td>84</td>
</tr>
<tr>
<td>2</td>
<td>Installing the Adapter</td>
<td>86</td>
</tr>
<tr>
<td>2</td>
<td>Preparing the Databases</td>
<td>88</td>
</tr>
<tr>
<td>2</td>
<td>Reserving an Atrium Dataset</td>
<td>90</td>
</tr>
<tr>
<td>2</td>
<td>Importing Atrium Jobs and Transforms</td>
<td>91</td>
</tr>
<tr>
<td>2</td>
<td>Configure Atrium Jobs</td>
<td>91</td>
</tr>
<tr>
<td>2</td>
<td>Install the Business Importer and Link with Remedy</td>
<td>95</td>
</tr>
<tr>
<td>2</td>
<td>Tuning Creation of Configuration Items</td>
<td>102</td>
</tr>
<tr>
<td>2</td>
<td>Scheduling the Adapter</td>
<td>103</td>
</tr>
<tr>
<td>2</td>
<td>Verifying Data Export to BMC Atrium</td>
<td>105</td>
</tr>
<tr>
<td>3</td>
<td>Additional Customization of the Adapter</td>
<td>108</td>
</tr>
<tr>
<td>3</td>
<td>Preparing for Large Datasets</td>
<td>109</td>
</tr>
<tr>
<td>3</td>
<td>Updating Connection Details</td>
<td>109</td>
</tr>
<tr>
<td>3</td>
<td>Updating Email Details</td>
<td>111</td>
</tr>
<tr>
<td>3</td>
<td>Turning Off Email Alerts for Export Errors</td>
<td>113</td>
</tr>
<tr>
<td>3</td>
<td>Changing the Log File</td>
<td>114</td>
</tr>
<tr>
<td>4</td>
<td>Appendices</td>
<td>115</td>
</tr>
<tr>
<td>4</td>
<td>Appendix 1: Export of Computers</td>
<td>116</td>
</tr>
<tr>
<td>4</td>
<td>Appendix 2: Export of Applications/Products</td>
<td>120</td>
</tr>
<tr>
<td>4</td>
<td>Appendix 3: Import of Assets</td>
<td>124</td>
</tr>
</tbody>
</table>
Part IV: Using the HPE Universal Discovery Adapter .................. 127

Chapter 1: Selecting a Configuration .................................. 128
    Architecture and Working of the HPE Universal Discovery Adapter ........................................... 129
    The Adapter Executable .................................................................................................................. 129

Chapter 2: Installation and Configuration ............................ 132
    Download Adapter Tools Archive ..................................................................................................... 133
    Selecting a Staging Server ............................................................................................................. 134
    Creating the Staging Database Tables ............................................................................................ 134
    Configuring HPE Universal Discovery System ................................................................................ 135
    Installing and Configuring the Staging Tool .................................................................................... 135

Chapter 3: Operation and Validation ..................................... 138
    HPE-UD Adapter Operation .............................................................................................................. 139
    Validating the HPE-UD Adapter ...................................................................................................... 139

Part V: Oracle Enterprise Manager Adapter ............................. 140

Chapter 1: Understanding the Oracle Enterprise Manager Adapter ...................................................... 141
    How the Adapter Assists in Inventory Gathering ............................................................................. 142
    Prerequisites for the OEM Adapter .................................................................................................. 143
    Components ...................................................................................................................................... 144
    Download Adapter Tools Archive ..................................................................................................... 144

Chapter 2: Installing the Adapter, and More ......................... 146
    Installing the OEM adapter ............................................................................................................... 147
    Grant Permissions to Account ........................................................................................................... 151
    Other Setup Activities ....................................................................................................................... 152
    Inventory-Gathering Accounts on Oracle Servers ............................................................................. 153
    Save Inventory Account in Password Store .................................................................................... 156
    Assign Beacon to Subnet ................................................................................................................. 156
    Configure Collection of Oracle Inventory ....................................................................................... 157

Chapter 3: Modifying the Adapter ......................................... 161
    Reconfiguring the OEM Adapter ....................................................................................................... 162
    Updating Connection Details ............................................................................................................. 162
    Configure Data Staging .................................................................................................................... 163
    Managing Email Alerts ..................................................................................................................... 164
    Configure Logging ............................................................................................................................ 165

Part VI: ServiceNow Integration with FlexNet Manager Suite ....... 166
Chapter 1: Architecture, Components, and Prerequisites...... 167
  Architecture.................................................................................................................. 168
  Prerequisites................................................................................................................ 168
  Download Adapter Tools Archive...................................................................................... 169

Chapter 2: Installation and Configuration................................. 171
  Setting up the Integration.............................................................................................. 172
    Installing the ServiceNow Application for FlexNet Manager Suite........................ 172
    Creating a ServiceNow User..................................................................................... 173
  Setting up Data Flows from ServiceNow to FlexNet Manager Suite........................... 173
    Setting up a MID Server........................................................................................... 174
    Configuring ServiceNow for Export........................................................................ 174
    Configuring FlexNet Beacon for Import................................................................. 176
  Setting up Data Flows from FlexNet Manager Suite to ServiceNow.............................. 178
    Configuring ServiceNow for Import........................................................................ 179
    Configuring FlexNet Manager Suite for Export...................................................... 180
    Configure the Utility for Export from FlexNet Manager Suite.................................... 182

Chapter 3: Operational Details................................................. 185
  Process for Exports from ServiceNow to FlexNet Manager Suite............................... 186
    Export Runs Properties............................................................................................. 187
    Business Adapter Mappings..................................................................................... 188
  Process for Exports from FlexNet Manager Suite to ServiceNow................................. 191
    Import Runs Properties............................................................................................ 194
    Import Transactions Properties.............................................................................. 194
    Transform Maps for ServiceNow Integration.......................................................... 195
    Command-line Tool for Export to ServiceNow........................................................ 199

Chapter 4: Appendices............................................................. 203
  Removing an Earlier Integration Application.............................................................. 204
  Additional ServiceNow Indexes for Performance......................................................... 204
  Exception in Log File for ServiceNow........................................................................ 205

Part VII: XenApp Server Adapter............................................. 207

Chapter 1: Architecture, Operations and Prerequisites........... 209
  Architecture and Operation.......................................................................................... 210
  Prerequisites............................................................................................................... 218

Chapter 2: Setting Up the XenApp Server Adapter............... 219
  Creating the Staging Database.................................................................................... 220
  Installing the XenApp Server Agent........................................................................... 221
  Create a Scheduled Task............................................................................................ 222
  Create Connections for Data Upload......................................................................... 224
Chapter 3: Command-Line Options

XenApp Server Agent Command Line Options

Chapter 4: Validation, Troubleshooting, and Limitations

Validation and Problem Solving

Limitations

Chapter 5: Database Impacts

Affected Database Tables
Legal Information

**Document Name**: FlexNet Manager Suite 2016 R1 Adapter Reference (for on premises implementations)

**Part Number**: FMS-12.0.0-AR01

**Product Release Date**: September 3, 2016

**Copyright Notice**

Copyright © 2016 Flexera Software LLC. All Rights Reserved.

This publication contains proprietary and confidential technology, information and creative works owned by Flexera Software LLC and its licensors, if any. Any use, copying, publication, distribution, display, modification, or transmission of such publication in whole or in part in any form or by any means without the prior express written permission of Flexera Software LLC is strictly prohibited. Except where expressly provided by Flexera Software LLC in writing, possession of this publication shall not be construed to confer any license or rights under any Flexera Software LLC intellectual property rights, whether by estoppel, implication, or otherwise.

All copies of the technology and related information, if allowed by Flexera Software LLC, must display this notice of copyright and ownership in full.

FlexNet Manager Suite incorporates software developed by others and redistributed according to license agreements. Copyright notices and licenses for this externally-developed software are provided in the link below.

**Intellectual Property**

For a list of trademarks and patents that are owned by Flexera Software, see [http://www.flexerasoftware.com/intellectual-property](http://www.flexerasoftware.com/intellectual-property). All other brand and product names mentioned in Flexera Software products, product documentation, and marketing materials are the trademarks and registered trademarks of their respective owners.

**Restricted Rights Legend**

The Software is commercial computer software. If the user or licensee of the Software is an agency, department, or other entity of the United States Government, the use, duplication, reproduction, release, modification, disclosure, or transfer of the Software, or any related documentation of any kind, including technical data and manuals, is restricted by a license agreement or by the terms of this Agreement in accordance with Federal Acquisition Regulation 12.212 for civilian purposes and Defense Federal Acquisition Regulation Supplement 227.7202 for military purposes. The Software was developed fully at private expense. All other use is prohibited.
Adapters

FlexNet Manager Suite relies on software inventory collected from the computers in your computing estate to calculate what licenses are required. While the system includes a full inventory-gathering capacity, it also allows you to import inventory collected by other tools you may already have.

As well, the system uses a considerable amount of business-related data, including organizational structure, and records of purchases, to correctly track your existing license entitlements. This business data can also be imported from other sources in your enterprise.

The data collected by these ‘third party’ tools usually needs to be rationalized in different ways, and mapped into the data fields within the FlexNet Manager Suite database. The interfaces that allow this mapping are called adapters. Several adapters are provided by default with the system, or are available for download from the Flexera Software Product & Licensing Center. You can also build custom adapters for inventory using the Inventory Adapter Studio, or for business data using the Business Adapter Studio, supplied with the product. (These tools are documented in the online help.)

This document collects information on several of the standard adapters available for FlexNet Manager Suite.
The tool from BMC for collecting hardware and software information, previously known as Atrium Discovery and Dependency Mapping (ADDM), from version 11 has been renamed BMC Discovery. This tool can be a useful inventory source as input to FlexNet Manager Suite to help in calculating license consumption as part of assessing your overall license compliance.

To collect inventory information from BMC Discovery and import into the operations databases maintained by FlexNet Manager Suite requires a data adapter. The adapter is documented in the following chapters, listed at left.

**Supported versions**

The BMC Discovery adapter supports inventory import from the following releases of the BMC tool:

- 8.3 (ADDM)
- 9.0 (ADDM)
- 10.0 (ADDM)
- 11.0 (BMC Discovery).
Choosing a Configuration

Topics:
- How the Adapter Works
- Components Explained

The adapter to extract data from BMC Discovery can operate at different levels of detail, and with different overheads, that depend on what level of licensing information you need to collect. This section gives a brief overview of how the adapter works, and explains the different configurations and how to choose between them. You need to choose the configuration appropriate for your enterprise before implementing the adapter.
How the Adapter Works

Although it is downloaded as a single zipped archive, the adapter includes several components to improve your license reporting. The overview of the finished system shows:

• An optional set of patterns that can be deployed to each BMC Discovery instance to improve the initial level of inventory detail collected by BMC Discovery.

• A staging server, which includes a simple SQL database where data collected from BMC Discovery can be massaged for upload to FlexNet Manager Suite. The executable that speeds the data extraction process also resides here. For on-premises solutions, this staging database may optionally reside on the central operations databases server.

• The conversion and upload component, which converts data formats and uploads the result to the central operations databases maintained by FlexNet Manager Suite.

Operation is summarized in this high-level diagram:

Figure 1: Process overview

The diagram shows:

1. Optionally making use of additional patterns packaged with the adapter download, inventory details are collected by BMC Discovery (previously ADDM).

2. The executable FnmAddMStage.exe uses the web API to extract the information from BMC Discovery. This method is used because the export process is 100 times faster than using mappings, and there is no requirement to configure custom mappings for each BMC Discovery instance. This executable optionally writes the gathered data into local XML files (available for inspection when required), and (determined by the mode of operation) also writes the data from these XML files into the staging database.

3. A standard component of FlexNet Manager Suite called a Compliance Reader, executing from the central application server, collects data from the staging database and imports it into the operations databases. This final stage occurs when you run an inventory import to process the incoming inventory.

Components Explained

This section describes each of the components in more detail, with information to help you decide which of these you will implement in your enterprise. Installation and setup follows in a separate section. The components described below are:
Choosing a Configuration

- Optional collection patterns to enrich the inventory detail collected by BMC Discovery (see Optional Patterns on page 12)
- The FlexNet inventory agent (see The FlexNet inventory agent on page 14)
- The scripts for creating the staging database in Microsoft SQL Server (see Database Table Creation on page 15)
- The FnmAADDMSStage.exe executable to extract inventory information from BMC Discovery, optionally write it to XML files, and insert it into the staging database (see The Adapter Executable on page 15).

Optional Patterns

There are six collection patterns in all.

- FileEvidence allows collection of file evidence for use within FlexNet Manager Suite. This evidence may be of two sub-types:
  - Executable files that form part of the application, which are gathered only for Window platforms, and may allow application recognition (particularly to the level of editions and versions)
  - Identification files including ISO tag files, which may be gathered across any platform (including Windows and UNIX-based environments).

The next two collection patterns run both on Windows and on non-Windows devices, instructing the BMC Discovery inventory agent to gather additional data:

- InstallAnywhereEvidence returns the list of package titles found in the repository maintained by Flexera Software's InstallAnywhere
- InstallShieldMultiplatformEvidence returns the list of packages installed by InstallShield Multiplatform, an earlier installation technology developed by Flexera Software.

The next collection pattern is for non-Windows devices only, and uses the FlexNet inventory agent to capture additional data elements and integrate these with the BMC Discovery inventory collected in the standard way:

- UnixHardwareData gets accurate hardware details to allow license metrics for capacity-based license calculations (such as for Processor, Core, IBM PVU, and other license types).

  Note • This pattern relies on the installation of two files, ndtrack.sh and ndtrack.ini, that are not included with the adapter package. These files are available with any installation of the FlexNet Beacon or application server. For more information, see The FlexNet inventory agent on page 14.

The last collection pattern contains instructions for the BMC Discovery inventory agent to pull additional data from the Windows Registry and WMI on Windows-based computers:

- WindowsLastLoggedOnUser recovers information about end-users that is required for user-based licensing (such as Named User license types).
To help you assess which of the patterns you wish to use, the following table summarizes the available collection patterns. The default state, whether the pattern is enabled or disabled, is shown in the **Pattern** column. The **Footprint** column details the additional installation impact (other than loading the pattern into BMC Discovery) required for the collection pattern (the downside of using the pattern), and the **Impact** column shows what will *not* work if you omit this pattern (the downside of *not* using it).

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Footprint</th>
<th>Impact of omitting pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>FileEvidence</td>
<td>No installation required.</td>
<td>An application that</td>
</tr>
<tr>
<td></td>
<td>This pattern is configurable for paths searched (per platform), and for file name extensions used for tag files. Search times on target machines will depend on configuration and the numbers of installed applications found.</td>
<td>- Is not already correctly recognized by BMC Discovery (perhaps because it is installed but not currently running), and</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Relies exclusively on file evidence (as distinct from installer evidence) for recognition within FlexNet Manager Suite will not be recognized for inventory collected through BMC Discovery without this pattern.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>While the Application Recognition Library rarely makes use of file evidence for Windows-based applications, some publishers including IBM and Oracle make use of special identity files. Software identity tags are also in increasing use, and these are identified using this pattern.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Likely impact of omitting this pattern in total is medium (through the loss of identity files). Likely impact of leaving executable gathering turned off is low.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><em>Note</em> • Within FlexNet Manager Suite, file evidence is also required for application usage tracking; but no application usage tracking is possible through the BMC Discovery inventory tool.</td>
</tr>
<tr>
<td>InstallAnywhere Evidence</td>
<td>No installation required.</td>
<td>BMC Discovery does not recognize installation evidence from InstallAnywhere. Unless it recognizes the application by other means, the application will be missed without this pattern.</td>
</tr>
<tr>
<td>Default: Enabled</td>
<td></td>
<td></td>
</tr>
<tr>
<td>InstallShield MultiplatformEvidence</td>
<td>No installation required.</td>
<td>BMC Discovery does not recognize installation evidence from InstallShield Multiplatform. Unless it recognizes the application by other</td>
</tr>
</tbody>
</table>

*Note* • There is no equivalent data available for UNIX-like systems.
### Pattern

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Footprint</th>
<th>Impact of omitting pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default: Enabled</td>
<td></td>
<td>means, the application will be missed without this pattern.</td>
</tr>
<tr>
<td>UnixHardwareData Default: Enabled</td>
<td>Requires less than 13 MB installation (ndtrack.sh and ndtrack.ini), either on the hard disk of the target machines, or on a network share accessible to them all. Run-time is a second or so when triggered by BMC Discovery.</td>
<td>Without this, BMC Discovery does not capture sufficient hardware attributes from servers to support license consumption calculations on license types based on hardware capacity metrics (such as Processor, Core, IBM PVU, and other license types). Assess impact based on the license types you need to support through BMC Discovery inventory (mandatory for capacity metrics).</td>
</tr>
<tr>
<td>WindowsLastLoggedOnUser Default: Enabled</td>
<td>No installation required.</td>
<td>Without this pattern, BMC Discovery does not report any end-user identification that is needed for licenses requiring identification of the individual (such as Named User license types). Note that for general user-based licensing, in the absence of end-user identities, FlexNet Manager Suite will calculate every installation of such software as usage by an unknown end-user, so that only license types depending specifically on identity will be affected. If you wish to allocate license entitlements to specific individuals, you also require this identification. Impact: medium.</td>
</tr>
</tbody>
</table>

**Note**  
For releases of BMC Atrium Discovery and Dependency Mapping up to and including 10.0, there is an additional pattern that improves the details about processors collected by BMC Discovery. This level of detail is required only for Oracle and IBM license calculations (for other licenses, the patterns above are adequate). By contractual arrangement with BMC, this pattern can be provided only to customers approved by BMC. For further information, ask your Flexera Software consultant, who can arrange the necessary approval and provide the pattern for you. Notice that for BMC Discovery release 11.0 or later, the additional pattern is deprecated. BMC Discovery 11.0 (and later) has improved processor information collection which makes this additional pattern unnecessary.

For more information:
- About each of these patterns, please see Appendix A: Details of Patterns on page 32
- About installing these patterns, see Installing Optional Patterns on page 25
- About enabling or disabling each of the patterns, see Enabling Optional Patterns on page 27.

---

**The FlexNet inventory agent**

The FlexNet inventory agent is a standard component of any installation of FlexNet Beacon, and of the application server that is included with FlexNet Manager Suite. For this reason, the necessary files are not included in the BMC Discovery adapter zip archive, since they are already present in any standard product implementation. Installation to suit the BMC Discovery adapter is described in Installing the FlexNet inventory agent on page 24.
For use on Linux or UNIX platforms, the agent has two component files:

- **ndtrack.sh**, an agent responsible for collecting inventory details (in this case, from the BMC Discovery inventory system) and writing them in an intermediate format to a data file, ready for upload to an application server. The script has no active elements until it is triggered by BMC Discovery through one of the enhanced collection patterns.

- **ndtrack.ini**, a text file that contains configuration variables for ndtrack.sh.

The combined disk space requirement of both files is under 13MB.

### Database Table Creation

The staging server requires an operating version of Microsoft SQL Server 2008 or later. Any edition is suitable, including Microsoft SQL Server Express (if its limitations on CPU, RAM, and database size are adequate for your purposes). As described in Choosing a Staging Server on page 21, the staging database may be located on a separate staging server, or on your central (on-premises) operations databases on your FlexNet Manager Suite server.

In the `SQL\` subdirectory of your unzipped adapter archive, the script `ADDM_staging.sql` is provided for creating the staging database, its tables, and its stored procedure. Obviously, this must be run on the SQL Server instance that is to host the staging database.

---

**Important**  
If you have been using an earlier version of ADDM, and are now migrating to BMC Discovery release 11 (or later), you must run the same `ADDM_staging.sql` script to update your staging database schema.

If you are continuing to use ADDM release 10 (or earlier), the update to the staging database schema is not required, and you may omit it for now; but if you choose to apply the upgrade now (so that the staging database is prepared for any future migration to BMC Discovery 11 or later), you must also use the latest version of the `FnmpADDMStage.exe` executable from the same Adapter Tools for FlexNet Manager Suite 2016 R1.zip archive. This executable transfers to BMC Discovery data (for any BMC Discovery/ADDM version) to the staging database, and is schema-aware for the upgraded staging database.

### The Adapter Executable

BMC Discovery supports two ways of extracting inventory data it has collected:

- Using export mapping sets
- Using a web API.

While the former is more commonly used, the BMC Discovery adapter for FlexNet Manager Suite uses the latter, for the following reasons:

- It avoids the need to deploy and maintain export mapping sets on every BMC Discovery instance in your enterprise.
• Performance of data collection can be 100 times faster using the web API. For example, data extraction that can take over 24 hours using mapping sets can be completed in 20 minutes with the web API. This is because the export feature in BMC Discovery is designed for more complex export capabilities and can therefore be slow to perform simple queries. FlexNet Manager Suite requires only simple queries to be executed on BMC Discovery, and these are performed far more efficiently using the web API.

The tool to query the web API consists of two parts:

• **FnmpADDMStage.exe** — A .NET 4.0 console program capable of querying the XML API of BMC Discovery and writing the results into an SQL Server database, and optionally to XML files on the local file system. This program supports command line arguments, available using `FnmpADDMStage -h`

• **FnmpADMSettings.xml** — The self-documenting configuration file for `FnmpADDMStage.exe` which contains the queries executed against BMC Discovery (in the BMC Discovery query language), and can include connection settings for BMC Discovery and SQL Server.

In operation, the executable, `FnmpADDMStage.exe`, extracts the inventory data from BMC Discovery and saves it for further processing. There are different ways that it can save the data, based on the following values of its `method` parameter:

• **Stage** — **Summary BMC Discovery to XML.** Inventory gathered from BMC Discovery is saved to a series of XML files on the staging server. It is not imported into the staging database. The XML files allow for review of the gathered data, but the inventory is not imported into FlexNet Manager Suite from these files.

  
  Tip • The XML file option also allows for disconnected scenarios, where inventory collected from an BMC Discovery server that is out of reach of the staging server can be written to XML, manually copied and transferred to another staging server, and the upload process resumed. See also the Prestaged method below.

• **Staged** — **Summary BMC Discovery to XML/SQL.** Inventory gathered from BMC Discovery is first written to the XML files on disk (for example for review), and then copied into the staging database where it can be imported into FlexNet Manager Suite for use in compliance calculations.

• **Prestaged** — **Summary XML to SQL.** In this mode, inventory is not gathered from BMC Discovery. Instead, the XML files present on the disk from a previous inventory collection (and perhaps reviewed and approved by a human agent in this format) are now copied into the staging database where it can be imported into FlexNet Manager Suite for use in compliance calculations.

• **Stream** — **Summary BMC Discovery to SQL.** Inventory is gathered from BMC Discovery, and loaded into the staging database where it can be imported into FlexNet Manager Suite for use in compliance calculations. In this method, inventory is not recorded in XML files on the staging server.

Default values for the `method` and all other parameters are set in the companion `FnmpADMSettings.xml` file, and these are the values used when the executable is triggered (or run) without other command-line options. The settings file is self-documented, and the matching command-line options are available using `FnmpADDMStage -h`

When the executable writes XML files to (or reads them from) the local disk on the staging server, the files include the following (details are available in `FnmpADMSettings.xml`):
<table>
<thead>
<tr>
<th>Filename</th>
<th>Content</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cluster.xml</td>
<td>Details for each cluster.</td>
</tr>
<tr>
<td>ClusterHost.xml</td>
<td>Computers (host nodes) that are members of a cluster, including a key to the Cluster node to identify that cluster.</td>
</tr>
<tr>
<td>CPUInformationDetail.xml</td>
<td>Details of computer processors.</td>
</tr>
<tr>
<td>DiscoveredPackages.xml</td>
<td>Raw installer evidence gathered by BMC Discovery from the installer technologies supported by each operating system.</td>
</tr>
<tr>
<td>DiscoveredService.xml</td>
<td>A report of particular services, used to help identify capabilities of hosts. This includes the VMMS service used to identify Windows machines with the Hyper-V role enabled.</td>
</tr>
<tr>
<td>DiscoveredVirtualMachine.xml</td>
<td>Raw results from BMC Discovery querying the list of virtual machines on a virtualization host.</td>
</tr>
<tr>
<td>FileEvidenceDetail.xml</td>
<td>File evidence produced by the Flexera.FNMP.InventoryRawData.FileEvidence pattern, covering software tag files and Windows executables.</td>
</tr>
<tr>
<td>FileSystem.xml</td>
<td>Name and size of all local file systems, used to approximate the total disks and storage of host.</td>
</tr>
<tr>
<td>HardwareEvidenceDetail.xml</td>
<td>Hardware details produced by the Flexera.FNMP.InventoryRawData.UnixHardwareEvidence pattern, using information gathered by the FlexNet inventory agent.</td>
</tr>
<tr>
<td>Host.xml</td>
<td>Details of all hosts known by BMC Discovery including their host name, operating system details, unique identification, processor, memory, and other hardware details.</td>
</tr>
<tr>
<td>HostInfo.xml</td>
<td>Raw host details not represented in a Host node, mainly the raw LPAR information from an IBM AIX LPAR environment.</td>
</tr>
<tr>
<td>InstallerEvidenceDetail.xml</td>
<td>Installation evidence gathered using the patterns in the BMC Discovery adaptor, including evidence from installations by Install Anywhere and InstallShield Multi-platform.</td>
</tr>
</tbody>
</table>
### Choosing a Configuration

<table>
<thead>
<tr>
<th>Filename</th>
<th>Content</th>
</tr>
</thead>
<tbody>
<tr>
<td>LastLoggedOnUserDetail.xml</td>
<td>Details of the last logged-on user for Windows systems. (There is no equivalent data available for UNIX-like systems.)</td>
</tr>
<tr>
<td>NetworkInterface.xml</td>
<td>The IP and MAC addresses of each network interface, used to build a list of these addresses for each host.</td>
</tr>
<tr>
<td><strong>Note</strong> ADDM 9.0 introduced the IPAddress nodes which cover both IPv4 and IPv6. Prior to that, the IPv4 IP address was in the NetworkInterface node. This query checks both of these sources.</td>
<td></td>
</tr>
<tr>
<td>SoftwareInstance.xml</td>
<td>Software installations identified by BMC Discovery's pattern language. BMC Discovery queries various properties such as processes and files of a host to determine which software is installed and its version.</td>
</tr>
<tr>
<td>SoftwareInstanceVirtual Machine.xml</td>
<td>These SoftwareInstance nodes are used to represent virtual machines on a host. These records are typically only created when the virtual machine is running.</td>
</tr>
</tbody>
</table>

### Conditions for Use

Use of this executable, `FnmpADDMStage.exe`, imposes the following conditions:

- Within BMC Discovery, the XML-based API must be enabled (by default, it is enabled). BMC documentation for the XML API is available at [http://discovery.bmc.com/confluence/display/90/XML+API](http://discovery.bmc.com/confluence/display/90/XML+API).

- There must be HTTP or HTTPS communication available between the staging server, on which this executable runs, and the server hosting BMC Discovery.

- The staging server requires the .NET 4.0 runtime environment.

- The staging tool must be configured with credentials that provide read access to the BMC Discovery instance. These credentials may either be configured in `FnmpADDMSettings.xml` or supplied on the command line for `FnmpADDMStage.exe` (for details see **Account Configuration** on page 28).

- For linking upstream to the staging database, you can either
  - Use a trusted connection to the SQL server and run the executable under an account that has read/write access to the staging database; or
  - Use service account credentials for SQL through a connection string, which may either be configured in `FnmpADDMSettings.xml` or supplied on the command line for `FNMPAddmStage.exe` (see **Creating the Staging Database Tables** on page 21 for details).
**Important**  It is critical that the `FnmpADDMStage.exe` tool is not run simultaneously with the `ComplianceReader` tool that uploads from the staging database to the compliance server. The adapter executable commences its writing activity with a `truncate` of the staging database to clear old results, an action which (if it occurred in the middle of an upload to the compliance server) could clearly corrupt the imported dataset. While `ComplianceReader` is blocked until `FnmpADDMStage.exe` finishes, you must adjust your schedules to prevent starting `FnmpADDMStage.exe` while the `ComplianceReader` is running.
2

Installation and Configuration

Topics:

• Choosing a Staging Server
• Creating the Staging Database Tables
• Installing and Configuring the Staging Tool
• Installing the FlexNet inventory agent
• Configuring BMC Discovery
• Validation and Operation

For on premises implementations, files are included in your product installation archive for the application server. As well, the latest version of the adapter is available for download from the Flexera Software flexnetoperations website. For cloud implementations of FlexNet Manager Suite, you also require this download: although you do not need to make changes to your central application server, there are additional components you require in the download.

You need credentials supplied by Flexera Software to access this download. Details of the download are included in Creating the Staging Database Tables on page 21.

• The BMC Discovery adapter suits FlexNet Manager Suite releases 9.2.3, and 2014 and later for on premises delivery.

• The build number for this adapter is 12.0 (or higher). You can identify this number by right-clicking on FNMPADDMStage.exe, selecting Properties and looking at the Details tab.

Save the zipped archive to a suitable temporary location, and unzip it.

Full details of setting up the BMC Discovery adapter are included in the following sections, as listed on the left.
Choosing a Staging Server

The FlexNet adapter for BMC Discovery requires a ‘staging server’ that supports installation of the adapter’s executable and of the staging database. Several configurations are possible. The staging server may be installed on:

- A dedicated stand-alone server (or virtual machine)
- Any other suitable machine in your enterprise, such as a print server
- An inventory beacon
- The central application server where FlexNet Manager Suite is installed (for on-premises installations).

The requirements for a suitable server include:

- A Windows-based operating system
- Access to an installation of Microsoft SQL Server 2008 or later, in any edition, where the staging database may be implemented (it may be on the staging server, or on a separate database server)
- The .NET 4.0 runtime environment installed
- Network access to the central application server (when not co-installed there)
- Efficient network access to each BMC Discovery server in your enterprise, using the HTTP or HTTPS protocols.

Note  •  Disconnected scenarios are also possible, using the intermediate XML files saved to disk to allow manual intervention. For more information, see The Adapter Executable on page 15.

Creating the Staging Database Tables

Once you have selected your staging server, and it can access an operating implementation of Microsoft SQL Server running a database instance you intend to use for the staging database, you should use the script provided to create the staging database and set up the appropriate database tables within it. This can be done from SQL Server Management Studio, or from the command line as described in the following procedure.

1. Do either of the following:

   - Download the Adapter Tools for FlexNet Manager Suite 2016 R1.zip archive from the Flexera Software Product and License Center:
     
     a) Using the credentials supplied by Flexera Software with your order confirmation (or as renewed since), log into https://flexerasoftware.flexnetoperations.com.

     b) On the first page, select FlexNet Manager Platform, and on the resulting second page, select the product again.
c) In the list of versions, click the product name for the version you are using (typically the most recent version).

d) In the list of components to download, select the Tier 1 Adapter Tools.zip archive, and save this to a convenient location (such as C:\Temp on a central, accessible server).

- Download the Adapter Tools for FlexNet Manager Suite 2016 R1.zip archive from the Flexera Software Customer Community knowledge base:

  Tip • Access requires your Customer Community user name and password. If you do not have one, use the link on the login page to request one.

b) Take note of the password identified within that article, at the end of the Synopsis.

c) Click the link Adapter Tools for FlexNet Manager Suite.

  In a new browser tab, when you provide the required password, the download of Adapter Tools for FlexNet Manager Suite 2016 R1.zip commences from the Flexera Software account at box.com.

d) In your browser dialog, choose to save the file, and if the browser allows it, direct the saved file to a convenient working location (such as C:\Temp on a central, accessible server).

  If your browser saves the file to a default location (such as your Downloads folder), move or copy it to the appropriate working location when the download is finished.

2. Right-click the downloaded zip archive, and choose Extract All....

3. Navigate through the unzipped archive to Adapter Tools for FlexNet Manager Suite 2016 R1.zip > BMC Atrium Discovery and Dependency Mapping Tools > SQL.

4. If necessary, copy the script ADDM_staging.sql from the SQL\ folder of your unzipped adapter archive to a temporary folder on your staging server.

5. Open a command prompt on the staging server.

6. In the command prompt window, execute the following command, as amended:

   sqlcmd -S ServerName\InstanceName -i TemporaryPath\ADDM_staging.sql

   where:

   • The database ADDM_Staging is created with all necessary tables, indices, and so on.

   • ServerName is the name of the database server hosting the staging database, or its IP address, or “.” (dot) if you are running the staging script on the same server as the database instance

   • InstanceName is the name of the instance to use for the database staging tables (this parameter may be omitted if the instance is the default instance)

   • TemporaryPath is the location where you saved the SQL procedure.
Example:

```
sqlcmd -S 192.100.0.20\Development -i C:\temp\ADDM_staging.sql
```

7. Ensure that the account under which the adapter executable will run has read/write/execute permissions on this database instance. Authentication may be through Windows NT authentication or SQL Server authentication. Using Windows NT authentication, the default account is the username running the FnmpADDMStage.exe adapter. SQL connection is specified as a standard connection string, which you may supply in FnmpADDMSettings.xml, or override with the -c option on the command line.

Tip • Configuration of the account is done through SQL Server Management Studio.

The staging database is now ready for operation.

## Installing and Configuring the Staging Tool

This procedure includes many separate sub-processes to complete the set-up of the adapter executable. We start from the configuration of the inventory reader that uploads inventory gathered by the adapter.

1. Navigate to C:\ProgramData\Flexera Software\Compliance\ImportProcedures\Inventory\Reader\.

   This is the fixed location on the inventory beacon where the inventory reader (reaching out from the compliance server) must find configuration files to control its uploads. By default, the inventory import (starting with the reader) is triggered around 2am. Therefore you might consider scheduling this task for some time such as 10pm daily. The command line for the scheduled task (assuming that you have saved your preferred settings) is simply to invoke the executable. Any parameters not specified on the command line are taken from the settings file in the same folder as the executable.

2. From your unzipped adapter archive, copy the folder BMC Atrium Discovery and Dependency Mapping (found in the path Adapter\Reader\) to the location identified in the previous step. This folder includes at least ten XML files and a reader.config file. This completes configuration for the inventory reader.

3. Create a folder to contain the adapter executable and its configuration file. Location is not critical; a suggested path is under C:\Program Files\Flexera Software. In your chosen location, create a folder such as ADDMAdapter.

4. From the FnmpADDMStage\ folder within your unzipped archive, copy both FnmpADDMStage.exe and FnmpADDMSettings.xml to your newly created folder (such as C:\Program Files\Flexera Software \ADDMAdapter).

5. Open your copy of FnmpADDMSettings.xml in a text editor of choice, and review the self-documenting comments within that file. Modify the following values as required (at the very minimum, correct the IP address of your BMC Discovery server):

   • Update values in the first element describing the downstream connection to the BMC Discovery server, including the IP address, the account name and password for access. Keep a record of the account name and password for registering with BMC Discovery (see Account Configuration on page 28). The default
values are: <server protocol="http" address="10.200.20.138" username="exportuser" password="Pa$$w0rd" timeout="3600"/>

Tip • If you do not wish to record the password in the plain text configuration file, you can use a script to retrieve the password from an encrypted store, and supply it as a command-line option when starting the FnmpADDMStage.exe tool.

- Update the second element for the connection to the staging database. The default values are: <database connection-string="Server=.;Database=ADDM_Staging;Trusted_Connection=yes;"/>
- Update the third element to configure whether, and where, the executable should save XML files of the inventory collected from BMC Discovery. The default value stores any XML files below the location of the executable (but turns off storage anyway): <staging path="." method="stream"/>
  You may wish to redirect the path setting for easier access for human inspection.
- Save your modified settings file.

6. Assuming that you do not wish to trigger the adapter manually every time it needs to run, start Windows Task Scheduler, and create a basic task to run the adapter.

Important • It is critical that you schedule the adapter to run at times which cannot overlap with the inventory reader uploading the results to the compliance server. Check the schedule for the compliance reader on the central compliance server, and avoid this time slot.

By default, the inventory import (starting with the reader) is triggered around 2am. Therefore you might consider scheduling this task for some time such as 10pm daily. The command line for the scheduled task (assuming that you have saved your preferred settings) is simply to invoke the executable. Any parameters not specified on the command line are taken from the settings file in the same folder as the executable.

This completes the configuration of the adapter executable itself. Now we can turn our attention downstream, first to possible installations on target UNIX-based machines, and then to enhancements to BMC Discovery itself.

## Installing the FlexNet inventory agent

If you have chosen to install any of the UNIX-related collection patterns to enhance the inventory collection available through BMC Discovery, the FlexNet inventory agent must be copied either:

- On to each UNIX-based machine that is a target for enhanced inventory collection; or
- To a pre-configured NFS share that is accessible from each of the target UNIX-based machines.

In the following procedure, your choice of either of the above two locations is referred to as the ‘target location’.

(For background information about the FlexNet inventory agent, see The FlexNet inventory agent on page 14. For choosing between the collection patterns, see Optional Patterns on page 12. Further information about deploying the FlexNet inventory agent is available in the separate PDF file FlexNet Inventory Gathering.)
To install the FlexNet inventory agent for UNIX collection patterns:

1. Using the installations of either FlexNet Beacon, or application server, locate the subdirectory that contains the ndtrack files. The default location is C:\Program Files\Flexera Software\Inventory Beacon \RemoteExecution\Public\Inventory.

2. From this folder, copy the two files ndtrack.sh and ndtrack.ini to the target location you selected above (that is, either to a pre-configured NFS file share, or to each target UNIX-based machine). The default location pre-configured in the template file is /opt/lexera/, but you may modify this as required.

   Important • The file path on all individual UNIX-based machines must be identical.

3. Note the file path used (whether a file share, or the identical path used across all target devices) for entry into ADDM when you are enabling the optional collection patterns (see next section).

## Configuring BMC Discovery

There are three customizations needed for BMC Discovery:

- Installing any of the optional patterns needed for the adapter in your environment (see below)
- Ensuring that BMC Discovery applies these patterns to the appropriate target computers (see Rediscovering Affected Computers on page 27)
- Ensuring that the account running the adapter has access to BMC Discovery (see Account Configuration on page 28).

## Installing Optional Patterns

For information about choosing which patterns to use, see Optional Patterns on page 12. For details about enabling each of the patterns, and modifying their behavior, see Appendix A: Details of Patterns on page 32. All these patterns are contained in a single template (Flexera.FNMP.InventoryRawData.tpl), which must be installed first. Thereafter, individual patterns can be enabled, disabled, and modified.

1. Log in to the BMC Discovery interface, and select the Discovery tab.
2. Select the Knowledge Management button in ADDM version 10, or BMC Discovery version 11 or later (in earlier versions of ADDM, select the Pattern Management button).
3. Click on **Upload** (or in earlier versions, **Upload New Package**).

4. Click on **Choose File**, and in your unzipped archive of the adapter, select the `FlexNet Manager Platform\Installers\BMC Atrium Discovery and Dependency Mapping Tools\patterns \Flexera.FNMP.InventoryRawData.tpl` file.

5. If you are using ADDM version 8:
   a) Optionally modify (or accept) the default name of the package as `Flexera.FNMP.InventoryRawData`.
   b) Optionally, set the description to something you will find helpful, such as `FNMP export patterns`.

6. Click **Upload** (or in earlier versions, **Upload & Activate**).

   Ensure that the message **The Requested Changes were Successful** is displayed. The `Flexera.FNMP.InventoryRawData` pattern is now in the **Active** state. For further fine tuning, jump ahead to step 4 in the following procedure.

---

**Tip** • For releases of BMC Atrium Discovery and Dependency Mapping up to and including 10.0, if you are using data imported through the BMC Discovery adapter to manage points-based licenses for IBM and Oracle, there
is an additional optional pattern that collect further details about processors available on request from Flexera Software. Notice that for BMC Discovery release 11.0 or later, the additional pattern is deprecated. BMC Discovery 11.0 (and later) has improved processor information collection which makes this additional pattern unnecessary.

Enabling Optional Patterns

By default, after installation some patterns are enabled and others disabled (see Optional Patterns on page 12). The following procedure allows you to turn individual patterns on and off as required, as well as enabling (or disabling) the entire module.

1. In the user interface for BMC Discovery, select the Discovery tab.
2. Click Pattern Management, and from the list of patterns at the bottom of the page, ensure that the Flexera.FNMP.InventoryRawData item is enabled, and select it. (The module must be enabled before any of its member patterns can operate.)
3. From the Pattern Package properties, select the link for the Pattern Module.
4. Scroll down to the Pattern Configuration area.
   Several closed groups are displayed, one for each optional pattern and another for configuration of the FlexNet inventory agent on UNIX platforms.
5. For each group that you want to modify, select Edit Configuration to the right of the group. The group opens, and configurable controls are displayed. Select the True radio button to turn on a pattern, and the False radio button to turn off a pattern.
   More details about configuration are included in Appendix A: Details of Patterns on page 32.
6. Click Apply.
   The modified settings are displayed.

   Tip • If you later use the Edit Module button to modify the module, be sure to activate, validate, and then commit your changes.

Rediscovering Affected Computers

Where (as is common) you are adding these patterns to an operational BMC Discovery instance that has already taken inventory of computers in your estate, you must rediscover any computers that are to be targeted through these new patterns, so that BMC Discovery applies to patterns to the rediscovered computers. To achieve this, you may either:

• Create (or wait for) a scheduled scan
• Initiate a Snapshot discovery scan
• Manually execute each pattern for suitably grouped targets, as summarized in the following procedure.
For more information about these options, see the BMC Discovery documentation available at http://discovery.bmc.com/confluence/display/90/Documentation.

To manually execute the new patterns:

1. In the BMC Discovery interface, select target computers (hosts or other nodes) by adding them to a group, creating separate groups to receive distinct types of patterns (for example, one group for Windows-related patterns, and another group for UNIX-related patterns). Create your groups using either of these approaches:
   - From a view node (including host) page, select Groups from the Actions list and add the node to a group.
   - From a report or other search result, select the required target computers. Then, select Groups from the Actions list and add the target machines to a group.

2. From the Discovery tab, click Pattern Management.
3. Select the Flexera.FNMP.InventoryRawData pattern from the package list.
4. Click the Pattern Modules link.
5. Select the Pattern Module containing the pattern that you want to run.
6. Click the Pattern link in the heading table.
7. From the Actions list, select Run Pattern.
8. In the Run against Group list, select the group containing your target machines for the current pattern(s).
9. Set the Expand and Execution Logging preferences for the run.
10. Set Additional Discovery to Get all new discovery data. This forces a new discovery.

More details about this procedure are available from http://discovery.bmc.com/confluence/display/90/Manual+pattern+execution.

Account Configuration

The user name and password that the adapter needs to access the BMC Discovery API is defined in FnmpADDMSettings.xml (see Installing and Configuring the Staging Tool on page 23). Here we grant that account adequate rights.

1. In the BMC Discovery interface, select the Administration tab.
2. In the Security section of the Administration page, click the Users icon.
3. From the Users page, click Add at the bottom of the page.

   Tip • If the account has already been registered in BMC Discovery, you can select it from the list of users and review its settings.

4. Configure the adapter account, which can be a member of the readonly group. Ensure that the user name and password are exactly the same values that you configured in FnmpADDMSettings.xml.
Figure 4: Sample settings for a adapter account to access BMC Discovery

5. Save your settings.

BMC Discovery is now configured for use of the adapter.

Validation and Operation

Normal operation relies on the following sequence of events:

1. BMC Discovery gathers inventory using the enhanced patterns you have enabled (details: Installing Optional Patterns on page 25, and Rediscovering Affected Computers on page 27).

2. At the time you scheduled (Installing and Configuring the Staging Tool on page 23), the adapter reads the current content of the BMC Discovery database and stages the new data in the staging database (previous data is first removed with a single truncate statement). The resulting status is flagged within the database.

3. Following the schedule on the central compliance server, and provided that the staging status is Success, the import reader uploads this content to the inventory database.

4. The next inventory import brings the final data set into the compliance database, where it is automatically taken into account for compliance calculations. As always, the inventory records must be recognized by the
Application Recognition Library, and you must have the resulting application records linked to the appropriate license, for compliance calculations to proceed.

To validate operation of the adapter:

1. Wait until BMC Discovery collects new inventory, so that the enhanced collection patterns are exercised. For further details, see the BMC Discovery documentation.
2. Manually trigger the adapter executable.

   By specifying a different method parameter, you have a one-time override of the default you set in the settings XML file. For example:

   ```
   C:\Program Files\Flexera Software\ADDMAdapter\FnmpADDMStage.exe
   -f "C:\temp" -m staged
   ```

   This will write XML files under your `C:\temp` directory for review. As well, it writes data into the staging database.
3. Inspect the saved XML files to validate the inventory gathered.
4. Use SQL Server Management Studio to validate that the data is written to the staging database. Also review the `StagingState` property in the `ADDMStagingDatabaseConfiguration` table in the staging database. Possible values are `Running`, `Failed`, or `Success`. This value must be `Success` before the BMC Discovery data can be uploaded from the staging database to the central inventory database.
5. Wait (for example, overnight) until the next inventory import and calculations have run.
6. Use FlexNet Manager Suite to validate that new evidence has been recovered. Identify which evidence has been recognized by the ARL and which new rules are required. Link the applications to appropriate licenses.
Known Issues

The following issue has been identified:

- UNIX-based devices that have the same host name and no detected serial number in BMC Discovery are merged into a single computer record in FlexNet Manager Suite.
Appendix A: Details of Patterns

Topics:

- Overview of Patterns
- FileEvidence
- InstallAnywhereEvidence
- InstallShieldMultiplatformEvidence
- UnixHardwareData
- WindowsLastLoggedOnUser

While the BMC Discovery discovery tool is a state-of-the-art tool to support ITAM, the out-of-the-box collection of inventory does not capture all of the data elements required by FlexNet Manager Suite to perform an accurate software license calculation. The optional patterns in this appendix extend those data capture capacities.
Overview of Patterns

The BMC Discovery Adapter available for FlexNet Manager Suite includes six additional patterns that can be incorporated into BMC Discovery to capture these additional data attributes.

<table>
<thead>
<tr>
<th>Pattern name</th>
<th>FlexNet inventory agent dependency</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>FileEvidence</td>
<td>No dependency.</td>
<td>Tag files (all platforms): Enabled</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Executables (Windows only): Disabled</td>
</tr>
<tr>
<td>InstallAnywhereEvidence</td>
<td>None</td>
<td>Enabled</td>
</tr>
<tr>
<td>InstallShieldMultiplatformEvidence</td>
<td>None</td>
<td>Enabled</td>
</tr>
<tr>
<td>UnixHardwareData</td>
<td>Required</td>
<td>Disabled</td>
</tr>
<tr>
<td>WindowsLastLoggedOnUser</td>
<td>None</td>
<td>Enabled</td>
</tr>
</tbody>
</table>

The patterns are written in the BMC Discovery Pattern Language (TPL), for which documentation is available at http://discovery.bmc.com/confluence/display/90/The+Pattern+Language+TPL.

For a summary of the patterns to help decide which ones to enable or disable for your enterprise, see Optional Patterns on page 12. The following sections go into more detail about each of the patterns.

**Note** • For releases of BMC Atrium Discovery and Dependency Mapping up to and including 10.0, the optional patterns listed above do not provide enough detail about processors to allow management of points-based licenses for IBM and Oracle based on data collected through BMC Discovery. If you need this capability through BMC ADDM (up to release 10), ask your Flexera Software consultant to request additional optional patterns for you. Notice that for BMC Atrium Discovery and Dependency Mapping release 11.0 or later, the additional pattern is deprecated. BMC Discovery 11.0 (and later) has improved processor information collection which makes this additional pattern unnecessary.

### FileEvidence

Some applications cannot be recognized by installer package information alone. It is sometimes necessary to examine files that form part of the software installation, for either of two reasons:

- Some files are intended to provide identification details about an application, sometimes in human-readable formats
- Examining executable files installed with the application may help with identification, even though this is not their primary purpose.

Of the first class, identification files may take various forms. For example, many IBM applications are correctly identified by specific files that IBM installs for this purpose. Oracle and Adobe are among other publishers using
specific files to identify some applications. Thus the Application Recognition Library (ARL) requires this file information to correctly identify such applications. ISO/IEC 19770-2 SWID tags are also increasingly available, and these ID tags are another useful form of identification file. The BMC Discovery Inventory Agent by default does not capture the complete set of identity files.

Secondly, in addition to gathering those specific files that identify an application (and have no other function in the application), it is sometimes necessary to identify installed executable files that are part of the application. These may be the only way to identify an application, such as a particular edition or version of a product. A standard implementation of BMC Discovery does not track executable files.

With this pattern, the functionality of BMC Discovery is extended to gather identification (tag) files on all platforms, and executable file evidence on Windows platforms. Note that the pattern does not search network shares or NFS mounts; nor does it follow symlinks (because of the risk of self-referencing loops). It also skips any files or folders that are inaccessible. Within these constraints, it provides details of files matching the specification and found within the defined paths on the local file system.

**Important** • Enabling and configuring the tracking of executables within this pattern should be handled with skill and care, for two reasons:

- Tracking Windows executables using BMC Discovery is slow. It may be unacceptably slow to use for a wide range of directories, and you may require very targeted inventory gathering using this facility.

- Tracking executable files can produce a very large data set. Across large Windows server farms, the number of installation records can quickly run even into the millions, which may comprise a stress test for BMC Discovery implementations and concentrators, and (to a slightly lesser extent) for your FlexNet Manager Suite implementation.

**Note** • In FlexNet Manager Suite, you can use file evidence to track the usage of an application (perhaps with a view to reclaiming under-used licenses). While that functionality requires you to identify a watch-list of at least one executable file for each tracked application, file evidence alone is not sufficient for usage tracking: it also requires additional FlexNet agents on the managed device, and an upload path through inventory beacons that preserve the additional usage data. File evidence gathered through the BMC Discovery adaptor is not sufficient for usage tracking.

**Results**

The file evidence gathered on Windows servers is somewhat richer than on UNIX-based servers.

- On both platforms, the pattern first collects the target directories from the pattern configuration file (under `Flexera.FNMPInventoryRawData.FileEvidenceConfigs`).

- In the specified folders and their subfolders, the pattern retrieves:

  - All files with extensions listed under **File extensions to report as tag files** (assuming that **Report software tag files** has its default value of true). For each matching file found, BMC Discovery creates a **Detail** node linked to the host record. This happens for both Windows and UNIX-based systems.
• On Windows only, and only when the setting for **Report executable files on Windows platforms** has been changed to true, files with a `.exe` extension from the same paths. For each executable file found, by default a WMI query is used to retrieve the file’s name, version, and manufacturer. A `DiscoveredWMI` node in BMC Discovery is created for each WMI query (essentially for each file). However, because `DiscoveredWMI` nodes are ephemeral (may not survive future inventory gathering), the information is duplicated into a `Detail` node under the host server for each file discovered there.

By the appropriate means, then, a `Detail` node is created for each file evidence record, with the following properties dependent on the collection method:

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>name</td>
<td>File path and name</td>
<td></td>
</tr>
<tr>
<td>type</td>
<td>FNMP_FileEvidence</td>
<td></td>
</tr>
<tr>
<td>size</td>
<td>File size</td>
<td></td>
</tr>
<tr>
<td>key</td>
<td>A unique key for this file, combining the values of <code>name/type/host.key</code></td>
<td></td>
</tr>
<tr>
<td>version</td>
<td>The release number of the file</td>
<td>Available only on Windows servers when executables are tracked.</td>
</tr>
<tr>
<td>company</td>
<td>The publisher of the application of which this file forms a part</td>
<td>Available only on Windows servers when executables are tracked.</td>
</tr>
</tbody>
</table>

**Configuration**

In the FileEvidence pattern, you may:

• Separately enable or disable collection of:
  
  • Identity tag files
  
  • Executable files (remember to consider the potential volume of data for this option)

• Identify the file name extensions for tag files (but there is no need to identify executable file name extensions)

• Separately for Windows and UNIX-like hosts, specify the starting point(s) in the file systems for inventory scanning to begin (searches recurse through local subdirectories).

**Important** • The BMC Discovery inventory agent stops scanning at partition boundaries, even those on the local file system. This has important implications on systems, such as IBM AIX, that typically mount key paths like `~/opt` on separate partitions. You must specify a search starting point within each target partition on the file system. For example, the default values of `~/opt`, `~/var`, and `~/usr` are well suited for inventory gathering with BMC Discovery.

All configuration items are covered in the following procedure.

**To configure the FileEvidence pattern**

1. In the user interface for BMC Discovery, select the **Discovery** tab.
2. Click Pattern Management, and from the list of patterns at the bottom of the page, ensure that your current Flexera.FNMP.InventoryRawData item is enabled, and select it. (The module must be enabled before any of its member patterns can operate.)

3. From the Pattern Package properties, select the link for the Pattern Module.

4. Scroll down to the Pattern Configuration area.

5. In the FileEvidence group, click Edit Configuration.

6. Select the appropriate true/false radio button for Report software tag files. If you are turning off the collection of tag files, skip the next step.

7. Adjust the list of File extensions to report as tag files, if necessary deleting values or adding new ones that you have identified. Each extension must stand alone on its own line.

8. Select the appropriate true/false radio button for Report executable files. Review the discussion before this procedure while considering the data quantities implied by enabling this option.

If you have now turned off both options, so that both options now have False selected, you have completed the process, and may skip the next step. If either option has True selected, continue to define the paths for the inventory gathering.

The configuration changes are saved.

9. For both types of operating system, customize the ...scan these file paths for evidence list.

   • Each file path must stand alone on its own line, and must be absolute (starting from root).
   • For Windows, the path must include the drive letter with its colon delimiter.
   • These same paths are scanned for identity (tag) files and for executable files.

10. Click Apply (at the bottom of this group).

   The configuration changes are saved.

InstallAnywhereEvidence

InstallAnywhere is a package installation solution developed by Flexera Software. Packages track their installation status in an XML file, which is interrogated by this pattern.

After collection of the inventory data, a Detail node is linked to the host computer for each package installed on the computer:

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>name</td>
<td>The name of the application as identified by InstallAnywhere.</td>
</tr>
<tr>
<td>type</td>
<td>FNMP_InstallerEvidence</td>
</tr>
<tr>
<td>vendor</td>
<td>The publisher of the application</td>
</tr>
<tr>
<td>version</td>
<td>The release number of the application.</td>
</tr>
<tr>
<td>install_date</td>
<td>The date that the application was installed on this host computer.</td>
</tr>
<tr>
<td>evidence</td>
<td>IA (fixed string literal).</td>
</tr>
</tbody>
</table>
Appendix A: Details of Patterns

To configure the InstallAnywhereEvidence pattern:

1. In the user interface for BMC Discovery, select the Discovery tab.
2. Click Pattern Management, and from the list of patterns at the bottom of the page, ensure that your current Flexera.FNMP.InventoryRawData item is enabled, and select it. (The module must be enabled before any of its member patterns can operate.)

   Tip • The InstallAnywhereEvidence pattern is enabled by default when the pattern collection is initially enabled. If it has previously been disabled, you can re-enable it with the remainder of this procedure.

3. From the Pattern Package properties, select the link for the Pattern Module.
4. Scroll down to the Pattern Configuration area.
5. In the InstallAnywhereEvidence group, click Edit Configuration.
6. Select the True radio button for Report installations by InstallAnywhere.
7. Click Apply (at the bottom of this group).

InstallShieldMultiplatformEvidence

InstallShield Multiplatform is an older packaging solution from Flexera Software, in use by many software publishers. InstallShield stores software information in “vital product data” (VPD) collections, which were originally stored in flat files and subsequently in SQL scripts.

This pattern locates either format of VPD storage (which may exist in a range of locations across different platforms), extracts the data, and creates a Detail node for the software installation linked to the host computer:

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>name</td>
<td>The name of the application as identified by InstallShield.</td>
</tr>
<tr>
<td>type</td>
<td>FNMP_InstallerEvidence</td>
</tr>
<tr>
<td>vendor</td>
<td>The publisher of the application</td>
</tr>
<tr>
<td>version</td>
<td>The release number of the application.</td>
</tr>
<tr>
<td>install_date</td>
<td>The date that the application was installed on this host computer.</td>
</tr>
<tr>
<td>evidence</td>
<td>ISMP (fixed string literal).</td>
</tr>
</tbody>
</table>
### UnixHardwareData

Especially for managing the corporate Data Centre, it is critical for FlexNet Manager Suite to have accurate hardware inventory for capacity-based license metrics (Processor, Core, IBM PVU, and so on). While BMC Discovery can capture this information for a Windows server, it may not consistently capture it for servers running UNIX or Linux. For example, BMC Discovery does not currently report:

- CPUs and cores on Linux, nor cores on virtual machines
- LPARs on IBM AIX (correctly)
- Solaris resource pools.

This pattern retrieves hardware data on UNIX-based systems using the FlexNet inventory agent.

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>product_code</td>
<td>The product identification code recorded (usually) by the publisher for the particular application. This is not standardized and may be used as the publisher desires.</td>
</tr>
<tr>
<td>key</td>
<td>A unique key for this installation record, combining (with the different literal text separators shown) the values of name:version/type:evidence/host.key</td>
</tr>
</tbody>
</table>

To configure the InstallShieldMultiplatformEvidence pattern:

1. In the user interface for BMC Discovery, select the Discovery tab.
2. Click Pattern Management, and from the list of patterns at the bottom of the page, ensure that your current Flexera.FNMP.InventoryRawData item is enabled, and select it. (The module must be enabled before any of its member patterns can operate.)

   **Tip** • The InstallShieldMultiplatformEvidence pattern is enabled by default when the pattern collection is initially enabled. If it has previously been disabled, you can re-enable it with the remainder of this procedure.

3. From the Pattern Package properties, select the link for the Pattern Module.
4. Scroll down to the Pattern Configuration area.
5. In the InstallShieldMultiplatformEvidence group, click Edit Configuration.
6. Select the True radio button for Report installations by InstallShield Multiplatform.
7. Click Apply (at the bottom of this group).

---

**Appendix A: Details of Patterns**

Flexera Software “Company Confidential”  FlexNet Manager Suite Adapters Reference 2016 R1 38
**Note** • The pattern must be configured with the installed location of the agent. The agent may be installed either in the same location on the file system of each target UNIX server, or on a file share accessible to all target devices. This is included in the configuration process described below.

It executes the inventory agent, which writes the collected data to a file in the `/var/tmp/flexera/addm/` folder on the host server. BMC Discovery then reads this output, and for each installed file, creates a `Detail` node linked to the host record:

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>FNMP hardware evidence for <code>%host.name%</code></td>
</tr>
<tr>
<td>Type</td>
<td>FNMP_HardwareEvidence</td>
</tr>
<tr>
<td>Key</td>
<td>%type%/%host.key%</td>
</tr>
</tbody>
</table>

(Additional properties) Each records one of the following hardware properties:
- Disk size
- IP Address
- MAC Address
- Model
- Number of cores
- Number of disks
- Number of logical processors
- Number of processors
- OS
- Processor speed
- Processor type
- RAM (total physical memory)
- Vendor.

If the machine is found to be a virtual machine, the following additional properties are collected:
- Node capacity
- Node capacity in cores
- Node capacity in threads
- Physical capacity
- Physical shared pool capacity in cores
- Physical shared pool ID
### Appendix A: Details of Patterns

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Shared pool capacity</td>
<td></td>
</tr>
<tr>
<td>• Shared pool capacity in cores</td>
<td></td>
</tr>
<tr>
<td>• Shared pool ID</td>
<td></td>
</tr>
<tr>
<td>• VM capacity</td>
<td></td>
</tr>
<tr>
<td>• VM capacity in cores</td>
<td></td>
</tr>
<tr>
<td>• VM entitlement</td>
<td></td>
</tr>
<tr>
<td>• VM ID</td>
<td></td>
</tr>
<tr>
<td>• VM is capped</td>
<td></td>
</tr>
<tr>
<td>• VM is shared type</td>
<td></td>
</tr>
<tr>
<td>• VM name</td>
<td></td>
</tr>
<tr>
<td>• VM type</td>
<td></td>
</tr>
</tbody>
</table>

To configure the UnixHardware pattern:

1. In the user interface for BMC Discovery, select the Discovery tab.
2. Click Pattern Management, and from the list of patterns at the bottom of the page, ensure that your current Flexera.FNMP.InventoryRawData item is enabled, and select it. (The module must be enabled before any of its member patterns can operate.)
3. From the Pattern Package properties, select the link for the Pattern Module.
4. Scroll down to the Pattern Configuration area.
5. In the Flexera.FNMP.InventoryRawData.CommonFlexeraInventoryAgentConfigs group, click Edit Configuration.
6. Enter the path (only, not including the file name) to the inventory agent executable. (For details about installing the FlexNet inventory agent, see Installing the FlexNet inventory agent on page 24.)
7. Click Apply (at the bottom of this group).
8. In the UnixHardware group, click Edit Configuration.
9. Select the True radio button for Report UNIX hardware properties.
10. Click Apply (at the bottom of this group).

### WindowsLastLoggedOnUser

For a Windows-based computer, standard BMC Discovery collection does not capture any inventory related to the Windows Logon. User identification is important for FlexNet Manager Suite to accurately calculate license consumption for user-based licensed, such as a Named User license. (There is no equivalent data for UNIX-like systems available through the BMC Discovery adapter.)
This pattern queries the registry at HKLM\SOFTWARE\Microsoft\Windows\CurrentVersion\Authentication\LogonUI\LastLoggedOnUser to find the last logged-on user (for legacy Windows platforms before Vista, it queries WMI for the value of UserName from Win32_ComputerSystem). If the query is successful, a DiscoveredRegistryValue node is created for the host computer:

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The user name.</td>
</tr>
<tr>
<td>Type</td>
<td>FNMP_LastLoggedOnUser</td>
</tr>
<tr>
<td>Key</td>
<td>%type%/%host.key%</td>
</tr>
</tbody>
</table>

To configure the WindowsLastLoggedOnUser pattern:

1. In the user interface for BMC Discovery, select the Discovery tab.
2. Click Pattern Management, and from the list of patterns at the bottom of the page, ensure that your current Flexera.FNMP.InventoryRawData item is enabled, and select it. (The module must be enabled before any of its member patterns can operate.)

   Tip • The WindowsLastLoggedOnUser pattern is enabled by default when the pattern collection is initially enabled. If it has previously been disabled, you can re-enable it with the remainder of this procedure.

3. From the Pattern Package properties, select the link for the Pattern Module.
4. Scroll down to the Pattern Configuration area.
5. In the WindowsLastLoggedOnUser group, click Edit Configuration.
7. Click Apply (at the bottom of this group).
Microsoft App-V (full name Microsoft Application Virtualization) is an application virtualization and application streaming solution. It allows access to applications in three different ways:

- Users may stream applications directly from a central App-V Management Server to their client computers, executing the code locally in light virtual machines that provide a protective 'bubble' around the executing software.
- The applications may be deployed using Microsoft System Center Configuration Manager (SCCM).
- Applications may be deployed in 'stand alone' mode, such as manual delivery through file shares or on a USB stick, without the use of any server infrastructure.

Applications delivered in any of these ways require licensing, and you can manage the appropriate licenses using FlexNet Manager Suite:

- Applications streamed from the App-V Publishing Server(s) are monitored using the App-V server adapter supplied as a standard part of FlexNet Manager Suite, and (for App-V release 5.0 and later) the `AppVMgmtSvr.ps1` PowerShell script installed on the App-V Management Server. Both the App-V server adapter and the `AppVMgmtSvr.ps1` PowerShell script are documented in this chapter.
- Applications deployed using Microsoft SCCM are recorded automatically as part of the standard inventory import from SCCM.
- Applications deployed manually can be recorded manually in FlexNet Manager Suite. Manual deployment is not a recommended best practice because of the inherent difficulties in management and demonstrating compliance, and there is no automation possible through FlexNet direct inventory gathering to cover manual deployment.
**Supported versions**

The App-V server adapter supports the current version of FlexNet Manager Suite, and releases 4.6, 5.0, and 5.1 of Microsoft Application Virtualization.

Because of significant architectural change between release 4.6 and release 5.0 of App-V, there are matching significant differences in the App-V server adapter for the different versions. It is important to read this document carefully, noting the differences that apply to "release 4.6" and "release 5.0 and later".
Architecture, Components, and Prerequisites

Topics:

• Architecture and Operation for App-V 4.6
• Architecture and Operation for App-V 5 and Later

Following the changes that Microsoft made in the architecture of App-V between release 4.6 and release 5.0, the App-V server adapter is also significantly different when interfacing to the different App-V releases. There are separate chapters for each different architecture. Identify the release of Microsoft App-V in use in your enterprise, and focus on the architecture that is appropriate to that release.
Architecture and Operation for App-V 4.6

This discussion applies to use of Microsoft App-V server infrastructure, streaming applications to App-V clients on end-point devices. (Where applications are instead installed by Microsoft SCCM, use the inventory import from SCCM instead of this adapter.)

In its streaming implementation, Microsoft App-V release 4.6 has three main kinds of components:

- A database (referred to here as the App-V Management Server database), which may be on a separate server
- One or more Management Servers that access the App-V Management Server database and provide a user interface for system control
- One or more streaming servers that may directly deliver application packages.

Of these, only the App-V Management Server database is relevant to the App-V server adapter for FlexNet Manager Suite.

Prerequisites

Operation requires that you have:

- A supported version of Microsoft App-V (see App-V Server Adapter on page 42).
- An operational App-V Management Server database.
- A FlexNet inventory beacon that has network access to your App-V Management Server database, and is also able to upload gathered inventory to the central FlexNet Manager Suite server (either directly or through a hierarchy of inventory beacons).
- An inventory beacon importing Active Directory data from the same domain where the App-V server resides. (This may be the same inventory beacon that runs the App-V server adapter, but this is not a requirement.)

💡 Tip • If you have App-V applications secured by security groups from multiple Active Directory domains, ensure that the Active Directory import runs against all applicable domains in your environment. The simplest approach may well be to ensure that you import from all your Active Directory domains, since if you use foreign security principals from multiple trusted domains, it can be difficult to keep track of access to App-V packages. FlexNet Manager Suite imports only from each individually specified Active Directory domain; so you need to ensure that all applicable domains are specified. As an example of multiple domains being affected:

- Suppose you have Group-A in Domain-A that contains a child Group-B, where Group-B actually comes from Domain-B.

- In this case, granting access to an App-V package to Group-A also grants access to Group-B (because of the parent-child relationship between the groups).

- This inheritance continues to work even when there is only one-way trust from Domain-B to Domain-A.

- In such a case, it is imperative that you run an Active Directory import against both Domain-A and Domain-B. When you have many domains, the simplest path is just to run an Active Directory import from every domain.
• Operators who can identify the applications represented by the App-V packages, and link those applications to the appropriate licenses.

**Tip** • You may have multiple App-V Management Servers, and multiple streaming servers, that link to a single App-V Management Server database. This requires only one connection from the FlexNet Manager Suite App-V server adapter, because this connects only to the database. However, if you have multiple App-V Management Server databases in your estate, configure a separate connection to each of them on appropriate inventory beacons. Where helpful, you may configure multiple such connections (each separately scheduled as you choose) on one inventory beacon.

**In operation**

The following diagram shows the operational architecture for the App-V server adapter for App-V release 4.6.

![Diagram of App-V server adapter architecture](image)

The numbers here refer to the numbers shown in the diagram above:

1. The inventory beacon imports data from Active Directory, including groups (and their members), users, and computers, and the security identifiers for each item within Active Directory. (These security identifiers, or SIDs, are the same identifiers that App-V reports for usage of the applications delivered through App-V packages.)
   - These are immediately uploaded to the central application server for FlexNet Manager Suite.
   - As soon as the upload is completed, the data is imported into the compliance database.

2. On the schedule you specify on the inventory beacon, the App-V adapter:
   - Connects to the App-V Management Server database
• Imports a list of the App-V packages from the database, and the access control lists (ACLs) that determine which Active Directory groups and users have access to the applications inside the packages. The latter are identified by their security identifiers (SIDs).

• Immediately uploads the data to the central application server for FlexNet Manager Suite. (If the upload fails for some reason, there is a catch-up upload task that by default is scheduled overnight.)

• The data waits in the staging area on the central application server for the next scheduled inventory import and compliance calculation (by default, scheduled overnight).

3. When information about a new App-V package is first imported, an operator must identify the package and link it (like installer evidence) to an application record. This work must be done manually because (in release 4.6) App-V packages are opaque about the applications they contain. As well, for any meaningful calculations of consumption, the application must be linked to a suitable license. This linking effort is required only for the first import of each new package.

Once the links are established, each subsequent compliance calculation assigns consumption by the correct users and computers to the appropriate (linked) license. This consumption information is then available both in the management views and in reports.

Architecture and Operation for App-V 5 and Later

This discussion applies to use of Microsoft App-V server infrastructure, streaming applications to App-V clients on end-point devices. (Where applications are instead installed by Microsoft SCCM, use the inventory import from SCCM instead of this adapter.)

In its streaming implementation, Microsoft App-V release 5.0 (and later) has the following components, apart from the App-V clients:

• A database (referred to here as the App-V Management Server database), which may be on a separate server

• A separate reporting database (referred to here as the App-V reporting database), which may also be on a separate server (importantly, this database stores application usage information)

• One or more Management Servers that access the App-V Management Server database and provide a user interface for system control

• One or more Reporting Servers that access the App-V reporting database and provide operational reports to help manage the App-V infrastructure

• One or more streaming servers (called App-V Publishing Servers) that may directly deliver application packages.

Of these, for App-V 5.0 and later, only the App-V reporting database and an App-V Management Server are relevant to the App-V server adapter for FlexNet Manager Suite. (If you are familiar with the adapter for release 4.6 of App-V, notice that we have switched databases, and added the Management Server — the architecture is completely different.)
Prerequisites

Operation requires that you have:

- A supported version of Microsoft App-V (see App-V Server Adapter on page 42).
- An operational App-V reporting database.
- An operational AppV Management Server.
- The AppVMgmtSvr.ps1 PowerShell script installed, configured and scheduled on your AppV Management Server (see Obtaining (and Deploying) the Adapter Components on page 53 for details). This is one of the significant changes since the previous adapter.
- A FlexNet inventory beacon that has network access to your App-V reporting database, and is also able to upload gathered inventory to the central FlexNet Manager Suite server (either directly or through a hierarchy of inventory beacons).
- An inventory beacon importing Active Directory data from the same domain where the App-V server resides. (This may be the same inventory beacon that runs the App-V server adapter, but this is not a requirement.)

Tip - If you have App-V applications secured by security groups from multiple Active Directory domains, ensure that the Active Directory import runs against all applicable domains in your environment. The simplest approach may well be to ensure that you import from all your Active Directory domains, since if you use foreign security principals from multiple trusted domains, it can be difficult to keep track of access to App-V packages. FlexNet Manager Suite imports only from each individually specified Active Directory domain; so you need to ensure that all applicable domains are specified. As an example of multiple domains being affected:

- Suppose you have Group-A in Domain-A that contains a child Group-B, where Group-B actually comes from Domain-B.
- In this case, granting access to an App-V package to Group-A also grants access to Group-B (because of the parent-child relationship between the groups).
- This inheritance continues to work even when there is only one-way trust from Domain-B to Domain-A.
- In such a case, it is imperative that you run an Active Directory import against both Domain-A and Domain-B. When you have many domains, the simplest path is just to run an Active Directory import from every domain.

- Operators who can link the applications identified in the App-V packages to the appropriate licenses.

Tip - You need only one connection from the FlexNet Manager Suite App-V server adapter (on an inventory beacon) to the App-V reporting database. This single App-V reporting database may support multiple App-V Management Servers, and multiple Publishing Servers; but only a single connection to the database is required.

Limitation

For App-V release 5.0 and later, the system supports installation of the AppVMgmtSvr.ps1 PowerShell script on only one App-V Management Server. This single Management Server may support multiple Publishing Servers.
(if necessary spread worldwide for faster distribution of App-V packages to App-V clients); and the App-V clients may report to multiple Reporting Servers (independent of the source from which the App-V packages were downloaded). Different App-V Management Servers do not self-identify in the .raa inventory file, and the App-V reporting database does not identify which application usage information is associated with which App-V Management Server. For these reasons, only a single App-V Management Server (for release 5.0 and later) is supported.

If your App-V (release 5.0 or later) environment has multiple Management Servers, choose one as the data source for App-V packages and the applications they contain. For example, if you have Production, Dev, and Test servers, place the AppVMgmtSvr.ps1 PowerShell script on the Production App-V Management Server. Also ensure that the App-V server adapter (on an inventory beacon) connects to the matching Production App-V reporting database.

In operation

The following diagram shows the operational architecture for the App-V server adapter for release 5.0 and later.

The numbers here refer to the numbers shown in the diagram above:

1. The inventory beacon imports data from Active Directory, including groups (and their members), users, and computers, and the security identifiers for each item within Active Directory. (These security identifiers, or SIDs, are the same identifiers that App-V reports for usage of the applications delivered through App-V packages.)
   - These are immediately uploaded to the central application server for FlexNet Manager Suite.
   - As soon as the upload is completed, the data is imported into the compliance database.

2. On the schedule you specify on the App-V Management Server, the AppVMgmtSvr.ps1 PowerShell script:
   - Uses the API to gather a list of the available App-V packages
• Imports from the database, and the access control lists (ACLs) that determine which Active Directory groups and users have access to the applications inside the packages. The latter are identified by their security identifiers (SIDs)

• Uploads the collected data in a remote application access (.raa) file to its configured inventory beacon, which in turn uploads the file to the central application server for FlexNet Manager Suite.

• The data waits in the staging area on the central application server for the next scheduled inventory import and compliance calculation (by default, scheduled overnight).

3. On the schedule you specify on the inventory beacon, the App-V adapter:

• Connects to the App-V reporting database

• Imports App-V package usage by users and computers. These are all identified by their security identifiers (SIDs).

• Immediately uploads the data to the central application server for FlexNet Manager Suite. (If the upload fails for some reason, there is a catch-up upload task that by default is scheduled overnight.)

• The .raa file collected by the PowerShell script is uploaded and immediately resolved into staging tables in the database.

Tip • If you manually copy an .raa file to your application server, you can import it with the following command:

```bash
> mgsimport -t remoteApplication
```

• The data waits in the staging area on the central application server for the next scheduled inventory import and compliance calculation (by default, scheduled overnight).

4. When the compliance calculation is run, FlexNet Manager Suite uses the uploaded SIDs to correlate the various data elements:

• App-V packages are shown as installer evidence (based on the MSI information uploaded by the AppVMgmtSvr.ps1 PowerShell script).

• If an appropriate application record exists (either in the Application Recognition Library or as a locally-created record) with a suitable installer evidence rule, the installed evidence (package) is automatically matched with the application.

• All users with access to an App-V package are shown as having an installation of the related application on every computer for which the user is either the assigned or calculated user.

• All computers with access to an App-V package are shown as having an installation of the related application.

• If the application is linked to a license, consumption is shown for the correct users and computers on that license (or, if it is linked to multiple licenses, on the highest priority license still having unconsumed entitlements). This consumption information is then available both in the management views and in
reports. (If this is the first import to reveal an application in an App-V package, an operator needs to link the application record to an appropriate license.)
Set Up and Operations

Topics:

- Obtaining (and Deploying) the Adapter Components
- Configuring the Adapter
- Import Evidence and Recognize Applications

This chapter covers the configuration of the adapter, and the work needed to enable application recognition from the imported inventory.

Keep clearly in mind the distinctions required for App-V release 4.6, and release 5.0 and later. For example, Obtaining (and Deploying) the Adapter Components on page 53 documents processes needed only for release 5.0 and later; and Configuring the Adapter on page 60 requires a distinct database connection in each of the cases.
Obtaining (and Deploying) the Adapter Components

Release 4.6

For App-V release 4.6, the App-V server adapter is a standard part of the FlexNet Manager Suite implementation, available on installed inventory beacons for both for cloud and on premises implementations. No action is required to install the adapter.

Release 5.0 and later

For App-V release 5.0 and later, full integration requires two working parts:

- The core of the App-V server adapter is a standard part of the FlexNet Manager Suite implementation, available on installed inventory beacons for both for cloud and on premises implementations. No action is required to install the core App-V server adapter on an inventory beacon.

- You also need the AppVMgmtSvr.ps1 PowerShell script for installation on your App-V Management Server. This is available within the Adapter Tools for FlexNet Manager Suite 2016 R1.zip archive. The Adapter Tools archive includes content for many adapters, and is updated on the Flexera Software website from time to time.

Start this procedure using a web browser on a computer that has good network accessibility from all the machines needing installations for your adapter.

1. Do either of the following:

   - Download the Adapter Tools for FlexNet Manager Suite 2016 R1.zip archive from the Flexera Software Product and License Center:
     a) Using the credentials supplied by Flexera Software with your order confirmation (or as renewed since), log into https://flexerasoftware.flexnetoperations.com.
     b) On the first page, select FlexNet Manager Platform, and on the resulting second page, select the product again.
     c) In the list of versions, click the product name for the version you are using (typically the most recent version).
     d) In the list of components to download, select the Tier 1 Adapter Tools.zip archive, and save this to a convenient location (such as C:\Temp on a central, accessible server).

   - Download the Adapter Tools for FlexNet Manager Suite 2016 R1.zip archive from the Flexera Software Customer Community knowledge base:
Tip • Access requires your Customer Community user name and password. If you do not have one, use the link on the login page to request one.

b) Take note of the password identified within that article, at the end of the Synopsis.

c) Click the link Adapter Tools for FlexNet Manager Suite.  
In a new browser tab, when you provide the required password, the download of Adapter Tools for FlexNet Manager Suite 2016 R1.zip commences from the Flexera Software account at box.com.

d) In your browser dialog, choose to save the file, and if the browser allows it, direct the saved file to a convenient working location (such as C:\Temp on a central, accessible server).
If your browser saves the file to a default location (such as your Downloads folder), move or copy it to the appropriate working location when the download is finished.

2. Right-click the zip archive, and choose Extract All....

3. In the extracted archive, navigate to Adapter Tools\App-V Management Server Agent \AppVManagementServer5.

Tip • As an alternative to downloading the archive again, if you still have access to the 'CD image' you downloaded to install FlexNet Manager Suite itself on your application server(s), you can also find these files in the unzipped installation archive under FlexNet Manager Suite\Installers\App-V Management Server Agent\AppVManagementServer5.

4. Use your preferred method to deploy the AppVMgmtSvr.ps1 PowerShell script to your App-V Management Server.  
You may install the script in your preferred folder.

5. Use your preferred task scheduling technology to schedule data collection by the PowerShell script.
Typically you want the .raa file uploaded to the central FlexNet Manager Suite operations databases before the system import and license calculations take place. By default, this occurs daily at 2am central server time.  
As a two-hour upload buffer should be more than adequate, this suggests (within a single time zone) a data collection trigger at around midnight.

These example steps are for Windows Server 2012. Adjust as necessary for your server operating system, or your chosen scheduling tool.

a) In Windows Explorer, navigate to Control Panel > System and Security > Administrative Tools, and double-click Task Scheduler.
The Task Scheduler window appears.

b) In the navigation tree on the left, select Task Scheduler Library, and then in the Actions list on the right, click New Folder....
A dialog appears for entering the folder name.
A suggested value is FlexNet Manager Suite.

c) Click OK, and select the new folder in the navigation tree.

d) Select Action > Create Task....
   The Create Task dialog appears.

e) Enter an appropriate Name, such as FlexNet Manager Agent for App-V 5.x, and add any Description to help future maintenance of this task.
   Your description may be something like Collects App-V data from the Management Server and uploads to an inventory beacon.

f) Click Change User or Group....
   The Select User, Service Account, or Group dialog appears.

g) Enter the account name that is to run the scheduled task, and click OK.
   An appropriate account:
   • Can run a Windows scheduled task on the App-V Management Server
   • Can execute the PowerShell script
   • Is an App-V Management Server administrator
   • May conveniently be a domain account that can upload the results (using HTTP PUT) to the inventory beacon, although a separate account and password can be configured in the command line (required only where that inventory beacon is using Basic Authentication — if the inventory beacon uses anonymous authentication, ignore this requirement).

h) Further down in the Security options group, select Run whether user is logged in or not.

i) Switch to the Triggers tab, and click New....
   The New Trigger dialog appears.

j) Ensure that the default setting Begin the task On a schedule is selected, set the parameters for the schedule, and from the Advanced settings group, be sure that Enabled is selected.
   The suggested schedule is daily at or before midnight local time, but be sure that this suits the upload procedures for your enterprise.
k) Switch to the **Action** tab, and click **New**....
The **New Action** dialog appears.

l) Ensure that the default **Action**, Start a program, is selected, and browse to your local copy of AppVMgmtSvr.ps1.

m) In the **Add arguments (optional)** field, specify all the command-line arguments you need for the agent.
All command line arguments are documented in **Command Line for PowerShell Script** on page 57. For common implementations, you need to define only the URL to the inventory beacon.
This example uploads the .raa file to the flexnetbeacon inventory beacon, using the credentials of the account running the scheduled task.

```
.AppVMgmtSvr.ps1 -beaconUrl http://flexnetbeacon
```

**Tip** • You need to specify only the basis server in the URL, Internally, the FlexNet Beacon service briefly saves the uploaded file to %CommonAppData%\Flexera Software\Incoming\RemoteApplications before uploading the file to its parent. (If security within your enterprise prevents the PowerShell script uploading the .raa file to a inventory beacon, you can arrange an alternative method to save the .raa file to this folder on a convenient inventory beacon, and it is automatically uploaded and processed from this point.)

n) Click **OK**.

o) Optionally, make any preferred adjustments to the **Conditions** or **Settings** tabs (normally the defaults are acceptable).

p) Click **OK** to close the **Create Task** dialog.
The new task appears in the list of scheduled tasks for this server.

q) Right-click the new task, and click **Run** in the context menu.
This checks that the scheduled task completes successfully.

r) Validate operations in the following ways:

- Review the log file (by default, AppVMgmtSvr.log in the same folder as the PowerShell script) for any errors or warning messages.

- Review the content of the output file (by default, FNMS_AppV.raa in the same folder as the PowerShell script). This file contains the results of the most recent execution of the PowerShell script, and is replaced at each invocation of the script. For more details of the file format, see **File Format for .raa** on page 59.

- If uploaded to the inventory beacon, check for the presence of the FNMS_AppV.raa output file in %CommonAppData%\Flexera Software\Incoming\RemoteApplications on the inventory beacon. Remember that you have only a brief time window to check this before it is uploaded to the central application server and removed (by default, around 10 minutes).
The AppVMgmtSvr.ps1 PowerShell script is now configured on your App-V release 5.0 or later Management Server. You can now configure the adapter itself that runs on the inventory beacon (see Configuring the Adapter on page 60).

**Command Line for PowerShell Script**

The AppVMgmtSvr.ps1 PowerShell script is required only when importing inventory from Microsoft App-V release 5.0 or later. (It is not required if you are using App-V release 4.6.)

For applicable releases, AppVMgmtSvr.ps1 is installed on the App-V Management Server, where, on a schedule that you determine, it collects details of the available App-V packages, and the users and computers that have access to the packages. (Separately, usage information is collected by the App-V server adapter, with its separate configuration described in Configuring the Adapter on page 60.)

The following options are supported, both for running AppVMgmtSvr.ps1 manually and for executing it from a scheduled task or other scheduling tool. None of the options is mandatory, although some are required for normal operation.

**Syntax**

AppVMgmtSvr.ps1 [options...]

**Options**

- **-beaconUrl** validURL  
- **-logFilePath** log_file  
- **-outputFilePath** output_file  
- **-password** password  
- **-upload** $true | $false  
- **-username** account

**where**

- **-beaconUrl** validURL  
  
  The URL to the appropriate inventory beacon to which the script should upload the generated .raa file. Include the protocol (HTTP or HTTPS), and if your inventory beacon uses a non-default port, include the port number in the standard way.

  **Note** • Include only the basic URL of the server. No internal paths are needed, as these details are added automatically by AppVMgmtSvr.ps1.

  There is no default value for beaconUrl, so that in production use (when -upload $true), a value must be supplied. It can be omitted for local testing on the server when uploading is not required. If -upload $true and beaconUrl is not set, obviously the upload must fail.

  Example values:

  http://flexnetbeacon.example.com
**Set Up and Operations**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>-logFilePath</code></td>
<td>A file path (either absolute, or relative to the folder in which the script is executing) and file name for the log file generated by <code>AppVMgmtSvr.ps1</code>. Enclose the path in double quotation marks. A file with consistent name and path over time is replaced at each execution, containing only the results of the last execution, thus preventing unmanaged storage requirements. When this option is not specified, the default value is <code>AppVMgmtSvr.log</code>, saved in the folder where the script is executing.</td>
</tr>
<tr>
<td><code>-outputFilePath</code></td>
<td>A file path (either absolute, or relative to the folder in which the script is executing) and file name for the output remote application access (.raa) file generated by <code>AppVMgmtSvr.ps1</code>. Enclose the path in double quotation marks. If the same name and path is used, the file is overwritten at each run of the script. When the option is not specified, the default value is <code>FNMS_AppV.raa</code>, saved in the folder where the script is executing.</td>
</tr>
<tr>
<td><code>-password</code></td>
<td>The password (in plain text) for the account specified in <code>-username</code>. Omitted when that option is not required. If specified, enclose the value in double quotation marks. When required and not specified, the script uses details of the account running the process.</td>
</tr>
<tr>
<td>`-upload $true</td>
<td>$false`</td>
</tr>
<tr>
<td><code>-username &quot;account&quot;</code></td>
<td>The account name used to upload the generated .raa file to the inventory beacon identified in <code>beaconUrl</code>. This is not required for inventory beacons using anonymous authentication. It may be specified for inventory beacons using Windows Basic Authentication. If specified, enclose the value in double quotation marks. When it is specified, the matching password must be provided in the <code>-password</code> option. When required and not specified, the script uses details of the account running the process.</td>
</tr>
</tbody>
</table>

**Examples**

(Examples here may be line-wrapped for convenient presentation; but should be entered on a single command line.)

Collect the inventory from the App-V Management Server, saving the file locally for inspection:

```
\.\AppVMgmtSvr.ps1 -upload $false
```

Similarly, collect the inventory, saving the output and logs to temporary locations to avoid overwriting the normal output:

```
\.\AppVMgmtSvr.ps1 -outputFilePath "C:\temp\FNMS_AppV.raa"
 -logFilePath "C:\temp\AppVMgmtSvr.log"
 -upload $false
```
Collect the inventory, and upload it to the specified inventory beacon, using the username and password for the account currently running the script:

```
\AppVMgmtSvr.ps1 -beaconUrl http://flexnetbeacon.example.com
```

Upload the collected inventory to the specified inventory beacon, using the `testdomain\administrator` account:

```
\AppVMgmtSvr.ps1 -beaconUrl http://flexnetbeacon.example.com
  -username "testdomain\administrator"
  -password "somepassword"
```

**File Format for .raa**

The `AppVMgmtSvr.ps1` PowerShell script interrogates the App-V Management Server, and saves the resulting data in a remote application access file (filename extension `.raa`), by default called `FNMS_AppV.raa`. This is an XML file that encapsulates data about each application's App-V package, and the MSI installer information known to App-V.

Here is an excerpt from an `FNMS_AppV.raa` file (here line-wrapped for presentation):

```
<remoteApplications accessModeID="2">
  <app farmName="" appID="9b0b9c0d-9634-4838-b0ba-8c256ef4710d" appName="Blender" appFileVersion="" appFilePublisher="" appFileDesc="" userSid="" serverName="" serverDomainName="" isStreamingProfile="1" />
  <msiData farmName="" appID="9b0b9c0d-9634-4838-b0ba-8c256ef4710d" msiDisplayName="Blender" msiPublisher="Blender" msiVersion="1.0" msiProductCode="{DFFFE0C6-3E9A-44E9-9EC1-B5C92DCEE4AF}" />
  <app farmName="" appID="5d80bef6-de4a-44f6-b4f8-9aa6a57880e" appName="FileZilla_3.2.4.1_win32-setup" appFileVersion="" appFilePublisher="" appFileDesc="" userSid="S-1-5-21-1336908958-3350896562-3141117955-1690" serverName="" serverDomainName="" isStreamingProfile="1" />
  <msiData farmName="" appID="5d80bef6-de4a-44f6-b4f8-9aa6a57880e" msiDisplayName="FileZilla Client 3.2.4.1" msiPublisher="" msiVersion="3.2.4.1" msiProductCode="filezilla client" />
  <app farmName="" appID="02787044-d434-4e7d-8770-cda46c988de8" appName="AdobeReader9" appFileVersion="" appFilePublisher="" appFileDesc="" userSid="S-1-5-21-1336908958-3350896562-3141117955-1690" serverName="" />
</remoteApplications>
```
Some points of interest to note:

- The complete set of MSI attributes needed for FlexNet Manager Suite makes use of Asset Intelligence on the App-V release 5.0+ system, which saves a series of AssetIntelligenceProperties in the manifest file. From these properties, AppVMgmtSvr.ps1 extracts the four msi... properties shown for the applications above.

- Not all applications deployed through App-V use MSI, as some applications use third-party installers. App-V packages using third-party installers cannot include the Asset Intelligence properties available through MSI. For such cases, the AppVMgmtSvr.ps1 PowerShell script interrogates the App-V application registry to get complete installer evidence, populating the same attributes in the .raa file. (Thus the presence of AssetIntelligenceProperties in the manifest file does not necessarily mean that Asset Intelligence was available; but does mean that equivalent data has been obtained.)

- The msiDisplayName becomes the Name property of the installer evidence record, the msiPublisher maps to Publisher, msiVersion maps to Version. As with all installer evidence, the resulting record is matched against installer evidence "rules" (previously-recorded installer evidence records, most often generalized with judicious use of wild card % characters), and when matched, adds an installation count to the application linked to the rule. This means that in listings of installer evidence, the visible entry remains the generalized rule that matched our individual piece of installer evidence. However, the individual installer evidence record is visible by drilling down into the properties of the inventory device on which the inventory evidence was found.

- For a worked example of how the installer evidence for the FileZilla application in the extract above is matched against an installer evidence rule, see Investigating Issues on page 69.

### Configuring the Adapter

The (core) App-V server adapter is set up on an inventory beacon.

Only two tasks are required for configuring this built-in adapter:

- Specifying the connection to the appropriate database. There are distinct databases in the two versions:
  - For App-V release 4.6, the App-V server adapter connects to the Microsoft App-V Management Server database
  - For App-V release 5.0 and later, the App-V server adapter connects to the Microsoft App-V reporting database.
- Scheduling the imports.

Both tasks are summarized here. Further details are available in the inventory beacon help.
1. On the appropriate inventory beacon, start the FlexNet Beacon interface.
   An appropriate inventory beacon has network access to the appropriate database as described above; and it can upload to the central FlexNet Manager Suite server, either directly or through a hierarchy of inventory beacons.

   *Tip* • Remember that logging into an inventory beacon requires an account with administrator privileges.

2. Select the *Inventory Systems* page in the inventory beacon interface.

3. At the bottom of the page, click *New*....
   The *Create SQL Source Connection* dialog opens.

4. Complete the values required in this dialog:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection name</td>
<td>A descriptive name for this connection that you will recognize later in lists.</td>
</tr>
<tr>
<td>Source Type</td>
<td>Select <em>App-V Standalone</em>. (Use this same value whether you are connecting to App-V release 4.6, or release 5.0 or later.)</td>
</tr>
</tbody>
</table>

   *Tip* • ‘Standalone’ means that you are using the adapter to connect directly to the appropriate App-V database, rather than collecting inventory through another source such as Microsoft SCCM.

   | Server | Type the server name or IP address. If the database instance you need is not the default one on the server you identify, add the instance name, separated with a backslash character. |

<table>
<thead>
<tr>
<th>Authentication</th>
<th>Select one of:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Authentication — Select this option to use standard Windows authentication to access the database server. The credentials of the account (on the inventory beacon) running the scheduled task for importing inventory are used to access the SQL Server database. This account must be added to a security group that has access to the database.</td>
<td></td>
</tr>
<tr>
<td>Windows (specific account) — Specify an account on the inventory beacon that can make a connection to the SQL database.</td>
<td></td>
</tr>
<tr>
<td>SQL Authentication — If you select this option, you must then specify an account and password already known to SQL Server on the target database. This account is used to access the database, regardless of the local account running the scheduled task on the beacon server.</td>
<td></td>
</tr>
</tbody>
</table>

   | Username | The account name used for SQL authentication, or Windows (specific account). (Not required for Windows Authentication.) |

   | Password   | The password for the account name required for SQL authentication, or Windows (specific account). (Not required for Windows Authentication.) |
### Option Description

**Database**
Enter the name of the database, or use the pull-down list to select from database names automatically detected on your specified server.

**Connection is in test mode (do not import results)**
Ensure that this check box is clear for production use. (For more details, see *Managing Microsoft SQL Server Database Connections* in the online help for FlexNet Manager Suite, in the section covering the inventory beacon.)

**Tip** • *When using App-V release 4.6, you cannot complete configuration for operation of this adapter (specifically, you cannot map the App-V packages to real applications) until you have run an import in production mode, with this check box clear.*

**Overlapping Inventory Filter**
If you use more than one inventory source, it is possible to get overlapping inventory (records about the same endpoint device in multiple inventory tools). In the compliance browser (in FlexNet Manager Suite), you may nominate one inventory source as primary. The choices here give more fine-grained control, even when this connection is defined as your primary inventory source:

- **Ignore the device’s inventory from this data source**: When you have inventory from another source for the same device, the record from this source will be completely ignored. This setting is valuable, for instance, when a device has migrated from one inventory source to another (perhaps by moving offices), but has not yet been obsoleted from this first source.

- **Ignore this device’s inventory if older than nn days**: If you select this option, overlapping inventory collected by this source more than the set number of days before the import is ignored. Fresher overlapping data is still imported and considered for data merging.

- **Import the inventory from this source for possible merging**: Choose this option (the default) to declare that overlapping inventory collected from this connection is never considered stale.

5. **Click Test Connection.**
   - If the inventory beacon can successfully connect to the nominated database using the details supplied, a *Database connection succeeded* message displays. Click **OK** to close the message. Click **Save** to complete the addition. The connection is added to (or updated in) the list.
   - If the inventory beacon cannot connect, a *Database connection failed* message is displayed, with information about why that connection could not be made. Click **OK** to close the message. Edit the connection details and retest the connection.

You cannot save the connection details if the connection test fails. If you cannot get the connection test to succeed, click **Cancel** to cancel the addition of these connection details.

6. **If you do not already have a schedule specified that can be used to run the adapter for this connection, create one now (see *Creating a Data Gathering Schedule* in the online help).**
7. With the connection for this adapter selected in the Inventory systems page, click Schedule....
   The Select Schedule dialog opens.
8. From the drop-down list, select the schedule you wish to apply.
   
   Tip • As you select each schedule from the list, the area below displays a summary of the schedule settings and the expected Next run time for this schedule.

9. Click OK to apply the selected schedule.
10. Click Save to store these details.
   
   The list of connections is updated, and the Next run column for your selected connection shows the projected run time from the schedule you just attached.

11. With the connection for this adapter still selected in the Inventory systems page, click Execute now.
   
   The adapter collects information from the appropriate database (App-V Management Server database for App-V release 4.6, and App-V reporting database for App-V release 5.0 and later), packages it, and uploads it to the central FlexNet Manager Suite (or, if it uploads to a parent inventory beacon, the file is briefly saved in %CommonAppData%\Flexera Software\Incoming\RemoteApplications on the parent inventory beacon). Allow time for this process to complete before continuing with the next setup procedure.

---

Import Evidence and Recognize Applications

Because your App-V package naming may be unique to your enterprise, you may need to identify the applications they contain.

If you have many App-V packages, setting up application recognition may be a significant effort on the first import from your App-V server adapter. Once the initial work is done, it is a simpler task to maintain recognition as new App-V packages are put into production.

This procedure continues from the work just completed at the inventory beacon where the adapter runs. Move now to the web interface for FlexNet Manager Suite.

1. Ensure that the upload of data from the App-V server adapter is complete:
   
   a) In the Management view, open the System menu ( in the top right corner) and select Data Inputs.
      The Data Inputs page appears.
   b) Select the Inventory Data tab, and select the Show details check box near to top.
   c) Find the App-V server adapter listed for the appropriate inventory beacon, and check its Last import date, Duration, Validation issues, and Status.
      When these are appropriate (in particular, Status is Successful on the appropriate Last import date), continue this procedure. Until then, you need either to remediate any upload problems, or simply wait until the upload is completed.
Tip • This page does not dynamically update results, but shows the status when the page was opened. Therefore, if you are waiting for an upload to finish, refresh the page (F5) from time to time to see updated information.

For App-V 5.0 and later, the upload of the .raa file saves the contents into staging tables in the compliance database, awaiting the arrival of usage information. For both App-V 4.6 and 5.0 (and later), the upload of the datafile from the App-V server adapter (on an inventory beacon) queues a job with the batch scheduler. When this job can next be processed, the adapter data (which, for App-V 5.0 and later, is combined in this process with the installer evidence from the .raa file) is imported into the compliance database. Thereafter, either of two results applies:

- Recognized installer evidence is linked to the application, and shows an installation count for each device on which the evidence was found (and can be further examined on the properties for each of those devices).

  Tip • The next step, showing consumption against an appropriate license, requires both that the application is linked to the license, and that a reconcile has been run, either automatically on schedule or manually.

- The installer evidence that was successfully imported but not matched to an application record needs your attention to map it to the correct application. (This is more common with the adapter for release 4.6.) To do that, continue with this process.

2. Identify newly-imported evidence (the App-V packages) that requires a link to application records:

   a) Navigate to License Compliance > Discovered Evidence (in the Evidence column). The Discovered Evidence page appears. Ensure that the default Installer evidence tab is selected.

   b) Near the top of the tab, click Add filter, and from the drop-down list select Type. A second drop-down list appears, listing the possible values of the evidence type.

   c) Select App-V.

   d) Click Add filter again, and from the pull-down drop-down list select Assigned, then choose the value No. With both filters defined, click the blue check mark (tick) to apply this filter. The list is redrawn to show only evidence of type App-V (the list of App-V packages discovered through the adapter) that have not been matched (manually or automatically) to an application.

   Tip • You may have no results when these filters are applied. This is a healthy state, meaning that all your App-V evidence is successfully matched to applications. When you have no records here, and want further validation of success, you can drill down into the properties of devices that have a record of installation for the appropriate application.

3. Use your special knowledge of the App-V packages to link each piece of unassigned evidence to an application record. You may do this either by:

   • Clicking the Name of the evidence, which opens the property sheet for this evidence where you can work on the Applications tab
• Following these guidelines to edit locally, still on the Discovered Evidence page:

a) Click anywhere else in a row (other than on the Name) to select that App-V package from the list. The action buttons above the list become active.

b) Click Assign.
A blue editor Assign evidence to an application appears above the tabs.

c) Click in the search field, optionally enter a few characters from the application name, and click Search. The editing area expands to include a list of application results matching your search. These applications include any previously created in your enterprise, together with all matching applications from the Application Recognition Library regularly updated by Flexera Software.

d) Select your chosen application from the list, and (above the list) click Add. The search field is updated to show the name of the application you selected.

Tip • If you cannot find the correct application in the search results, you may create a new application record by clicking Create an application, and completing the details in the application properties (the App-V package is automatically listed in the Evidence tab of the application properties).

e) Click Assign.

• The blue editing area closes.

• The App-V package is linked to the application you chose (the App-V package now functions like installer evidence to show consumption against any license linked to the application).

• In the list of evidence, the Assigned column is updated to Yes, showing that this package has been linked (or assigned) to an application. (If you currently have a filter on the Assigned column to show only rows with a No value, the evidence you just assigned must disappear from the list.)

Tip • This links the evidence to the application as an exact match across publisher, name, and version records. To protect against future upgrades of the App-V package, you may wish to generalize the version number with a % wild-card. For example, if the original version was 1.0, manually editing the Version property of the installer evidence to 1.% means the link to the application remains valid through all the minor upgrades of this package.

4. If the selected application is not yet linked to a license, you can:

a) Double-click the App-V package in the evidence list (or, while it is selected, click Open). The evidence property sheet opens.

b) Select the Applications tab.

c) In the list of applications, click the name of the one you have just assigned to the App-V package (or double-click elsewhere in the row; or select the row and click Open). The application property sheet opens.

d) Select the Licenses tab in the application properties.
e) Optionally enter a few characters of a license name (where you know it); click **Search**.
The search area expands to show the list of available licenses (matching any characters you entered).

f) Select the appropriate license from those offered, and click **Add license**.
Where a suitable license does not already exist, you may instead create one (for example, navigate to **License Compliance** > **Create a license** (in the **Licenses** column).

---

*Tip* • Don’t forget to link some purchase records to the license to provide your entitlement count.
3

Issues and Limitations

Topics:

- Limitations
- Investigating Issues
- Known Issues

Diagnosis is covered in this chapter, along with limitations and known issues.
## Limitations

The following limitations apply to the current releases of the App-V server adapter:

- In the unlikely event that App-V packages have been shared to non-persistent XenDesktop VDI devices (instead of users), and FlexNet Manager Suite is linked to a XenDesktop broker, no license consumption occurs for those non-persistent devices (because non-persistent VDI devices are not modeled within FlexNet Manager Suite when XenDesktop broker information is available).

- License consumption calculations depend on the integration of data both from Active Directory, and from the appropriate App-V database (App-V Management Server database for release 4.6, or reporting database for release 5.0 and later) and the `AppVMgmtSvr.ps1` PowerShell script. As linking of this data occurs when the App-V server adapter data is imported, current users, computers, and groups must be imported from Active Directory first, before the latest App-V server adapter import occurs. From FlexNet Manager Suite 2014 R2, this ordering is automatic, since Active Directory data is imported to the central database as soon as it is uploaded from an inventory beacon.

  **Tip** • If you have App-V applications secured by security groups from multiple Active Directory domains, ensure that the Active Directory import runs against all applicable domains in your environment. The simplest approach may well be to ensure that you import from all your Active Directory domains, since if you use foreign security principals from multiple trusted domains, it can be difficult to keep track of access to App-V packages. FlexNet Manager Suite imports only from each individually specified Active Directory domain; so you need to ensure that all applicable domains are specified. As an example of multiple domains being affected:

  - Suppose you have Group-A in Domain-A that contains a child Group-B, where Group-B actually comes from Domain-B.

  - In this case, granting access to an App-V package to Group-A also grants access to Group-B (because of the parent-child relationship between the groups).

  - This inheritance continues to work even when there is only one-way trust from Domain-B to Domain-A.

  - In such a case, it is imperative that you run an Active Directory import against both Domain-A and Domain-B. When you have many domains, the simplest path is just to run an Active Directory import from every domain.

- The quality of installer evidence recovered from App-V release 4.6 is not high. You should expect to do remedial work both to generalize the evidence found (for example, using the `%` wildcard to generalize version numbering), and to link the evidence to appropriate applications.

- For App-V release 5.0 and later, the system supports installation of the `AppVMgmtSvr.ps1` PowerShell script on only one App-V Management Server. This single Management Server may support multiple Publishing Servers (if necessary spread worldwide for faster distribution of App-V packages to App-V clients); and the App-V clients may report to multiple Reporting Servers (independent of the source from which the App-V packages were downloaded). Different App-V Management Servers do not self-identify in the `.raa` inventory file, and the App-V reporting database does not identify which application usage information is associated with which App-V Management Server. For these reasons, only a single App-V Management Server (for release 5.0 and later) is supported.
Investigating Issues

Proof that the App-V server adapter is operational, and the data upload is also successful, can be seen in either or both of two ways:

- Installation records for the appropriate applications against expected inventory devices (possibly including Remote devices for which no hardware inventory is available)
- The presence of any newly-discovered inventory of type App-V in the Discovered Inventory list, typically with an Assigned value of No.

If neither of these is the case, the issues could be with:

- Imports from the App-V server adapter on an inventory beacon (for both App-V release 4.6, and App-V release 5.0 or later)
- Imports of the .raa file from your App-V Management Server (only for App-V release 5.0 or later)
- Missing links between the installer evidence (representing App-V packages) and the applications in the packages
- Missing consumption on an appropriate license.

Each of these is covered in turn below.

No data imports from adapter on inventory beacon

Check the following to identify the problem with imports from the App-V server adapter:

1. Are you sure that there should be new records? Have new packages been brought into production since the last time inventory was collected and fully processed?

2. Check the Status of the latest upload (Data Inputs > Inventory Data tab > select Show details). Also validate that the Last import date is as expected, so that the upload occurred after new App-V packages were brought into production.

3. If uploads are not happening, move to the inventory beacon where the adapter runs, and check the status of the App-V connection. Use the Test connection button to ensure it can connect to the appropriate database (App-V Management Server database for App-V release 4.6, and the App-V reporting database for release 5.0 and later). Details about setting the connection are in Configuring the Adapter on page 60.

4. On the same inventory beacon, test its connection to the central application server for FlexNet Manager Suite, using the Parent connection page and the Test connection button there. (If this inventory beacon is part of a hierarchy, check the connections all the way up the hierarchy to prove that uploads can reach the central server.)

5. Check for stalled uploads by looking for an App-V inventory file in the %CommonAppData%\Flexera Software\Beacon\IntermediateData directory on the inventory beacon (or, in a hierarchy, in the chain of inventory beacons). (Notice that the folder for files from the App-V server adapter is separate from the folder for .raa files from the PowerShell scripts used with release 5.0 and later.) App-V data files are named in part for the connection you established (see Configuring the Adapter on page 60). Once an inventory file of this type is successfully uploaded, it is removed from this intermediate data location on the inventory.
6. Has a reconciliation calculation occurred since the upload? Until this occurs (normally overnight), new App-V inventory cannot be displayed in the web interface for FlexNet Manager Suite. Check the date and time on the System Health page (< System Health >) in the License reconciliation card. The last import and reconciliation must be after the latest upload from the inventory beacon.

7. If you are using App-V release 5.0 or later, a failure to upload and save .raa files may also prevent presentation of results, even when the application usage information is successfully imported from the App-V server adapter. Issues with .raa files are covered in the next section.

No data imports from the PowerShell script for App-V release 5.0 and later

If uploads of .raa files do not appear to be working:

1. Ensure that a new upload is required: that is, that the AppVMgmtSvr.ps1 script has executed successfully since the last inventory import and license consumption calculation (the most recent file is always saved on the App-V Management Server for checking, and is only replaced the next time that the script executes):
   - Check your scheduling for the script's execution, in particular that the command line options are correct (see Obtaining (and Deploying) the Adapter Components on page 53).
   - Check the log file for the last run (you may have renamed or relocated the log file, as described in Command Line for PowerShell Script on page 57). In particular, ensure that there were no problems with the file upload to the inventory beacon.

2. Move to that inventory beacon, and check for stalled uploads by looking for an .raa file in %CommonAppData\%\Flexera Software\Incoming\RemoteApplications (this file path is different from the one used for files uploaded by the App-V server adapter). If you have a hierarchy of inventory beacons, check each in turn.

3. If file uploads are happening successfully, has there been a reconcile since the last .raa file was uploaded? Check the date and time on the System Health page (< System Health >) in the License reconciliation card. The last import and reconciliation must be after the latest upload from the inventory beacon. If not, you may (as an administrator) manually trigger a reconcile (see the FlexNet Manager Suite Help > What Is an Inventory Beacon? > What Is an Inventory Beacon?).

Missing application recognition

For App-V release 4.6, data imported from the App-V server adapter includes only the App-V package name and the Active Directory groups (or individuals) that may access the package, according to the Access Control Lists (ACL). Specifically, this imported information cannot recognize what application is hidden within the App-V package. Application recognition requires a separate step. Even for App-V release 5.0 and later, where much better installer evidence allows automatic matching of the evidence rules for the appropriate application, there may be cases where the installer evidence needs manual attention. This will be the case when:

- There is no matching application available within FlexNet Manager Suite, either in application records that you have created locally, or in the Application Recognition Library.
There is an appropriate application, but the values returned from App-V do not match with the existing inventory rules for the application record.

In cases where installer evidence from App-V is unmatched, you can check as follows:

1. First be sure that data uploads and imports are happening, as validated in the previous sections.

2. Navigate to License Compliance > Evidence column > Discovered Evidence > Installer evidence tab, filter for Type=App-V, and check the Assigned column. If it displays No, you need to link this package to an application, as described in Import Evidence and Recognize Applications on page 63.) For App-V release 4.6, newly imported evidence is always unassigned, and requires you to manually associate the evidence (or App-V package) with an application.

3. For App-V release 5.0 (and later), when installer evidence appears in the above listing, it may be worth checking why the data from the App-V installer evidence did not match existing evidence rules for the appropriate application (assuming the application is already present locally or in the Application Recognition Library). To do this, navigate to the Evidence tab of the application's properties, where all existing evidence "rules" are listed (making sure that Installer is the selected subtab). Compare the data displayed there with content in your .raa file (see sample .raa file in File Format for .raa on page 59). Here is a worked example of successful matching using the FileZilla 3 application:

<table>
<thead>
<tr>
<th>App-V element's attribute</th>
<th>Application's installer evidence property</th>
</tr>
</thead>
<tbody>
<tr>
<td>msiDisplayName=&quot;FileZilla Client 3.2.4.1&quot;</td>
<td>Name FileZilla Client 3.2.%</td>
</tr>
<tr>
<td>msiPublisher=&quot;&quot;</td>
<td>Publisher (blank)</td>
</tr>
<tr>
<td>msiVersion=&quot;3.2.4.1&quot;</td>
<td>Version 3.2.%</td>
</tr>
<tr>
<td>accessModeID=&quot;2&quot; (produces the evidence type App-V)</td>
<td>Type Any</td>
</tr>
</tbody>
</table>

Thus the .raa entry produces installer evidence that is immediately matched by the existing installer evidence rule for the application, and produces an installation count against that application. But looking ahead (in imagination) to the day when the .raa entry covers a version of 4.2.3.1, the App-V package data in the .raa file would no longer match this evidence rule. At that time, if a new rule was yet to be published in the Application Recognition Library, the installer evidence created from the .raa file would appear in the Discovered Evidence listing, and you could link it to the application, preferably generalizing it (similarly to the example above) to create a rule that would match several minor releases.

**Missing consumption**

Showing consumption of license entitlements for App-V packages (and the applications they contain) requires:

- The adapter gathers data from the App-V server and uploads and imports it into FlexNet Manager Suite (see first section above for more details).

- For App-V release 5.0 or later, the .raa file is uploaded from your App-V Management Server

- The application is recognized, either automatically, or because you have linked the App-V package to an application record (see previous section)
• The application is linked to a license (and in turn the license should be linked to purchase records to show your legal entitlements) — here, this is left as an exercise for the reader.

• Active Directory imports are current, allowing mapping of the groups and users from the ACLs in the App-V Management Server database to user records in FlexNet Manager Suite.

These notes address the last stage, enabling Active Directory to map from the ACL lists to user records. This process is automatic, provided that all the necessary data is available.

1. On the appropriate inventory beacon, open the Active Directory page (from the Connections group), and validate that a connection is both established and scheduled. (For details, see Importing from Active Directory in the online help.) Review the Last run time to see when data was last collected, uploaded, and imported. You may also choose Execute Now if imports have been disrupted.

2. Once sufficient time has passed for Active Directory data collection, upload, and import (normally, 30 minutes should be more than adequate), review the list of All Users to establish that the expected user names are all available (navigate to Enterprise > Users group > All Users).

Tip • If you have App-V applications secured by security groups from multiple Active Directory domains, ensure that the Active Directory import runs against all applicable domains in your environment. The simplest approach may well be to ensure that you import from all your Active Directory domains, since if you use foreign security principals from multiple trusted domains, it can be difficult to keep track of access to App-V packages. FlexNet Manager Suite imports only from each individually specified Active Directory domain; so you need to ensure that all applicable domains are specified. As an example of multiple domains being affected:

• Suppose you have Group-A in Domain-A that contains a child Group-B, where Group-B actually comes from Domain-B.

• In this case, granting access to an App-V package to Group-A also grants access to Group-B (because of the parent-child relationship between the groups).

• This inheritance continues to work even when there is only one-way trust from Domain-B to Domain-A.

• In such a case, it is imperative that you run an Active Directory import against both Domain-A and Domain-B. When you have many domains, the simplest path is just to run an Active Directory import from every domain.

Note • You cannot review Active Directory group memberships within FlexNet Manager Suite. Only the resulting list of users is available (along with computers, sites, and subnets).

Known Issues

The following issues relate primarily to the stability of data available for collection from the App-V server.
Renaming packages

App-V allows you to rename packages (without necessarily changing their contents). When a package is renamed, the App-V application record no longer links to usage records within the appropriate App-V database. This means that the App-V server adapter (and, for App-V release 5.0 and later, the AppVMgmtSvr.psl PowerShell script) cannot import meaningful data for license consumption calculations. As well, the installer evidence generated from the App-V import now has a different name, which may not match evidence rules for the appropriate application. If that is the case, the consumption calculations for any license linked to an application that was linked to the previous installer evidence from App-V drops to zero (from this import connection).

For this reason, it is strongly recommended that you do not change the name of existing App-V packages in the App-V Management Server interface. Where renaming is unavoidable, remember that you may need to link the new package (represented as installer evidence in FlexNet Manager Suite) to the application to restore consumption calculations (especially for App-V release 4.6).

Updating package versions

Typical "rules" for applying installer evidence to identify applications use the publisher, the application, and the version recorded in the installer evidence. If you use a version number for your App-V packages (such as 1.0), and link exactly this App-V ‘installer’ evidence to the application record in FlexNet Manager Suite, then updating the version number of the package on your App-V Server (say, to 1.1) may break the link to the application, and the linked license loses its consumption as a result.

You can avoid this problem (at least for minor version changes) by using wild-cards in the linking of evidence to applications. To do this, after you have linked the App-V evidence to the application:

1. Navigate to the Installer Evidence Properties page.
2. Select the General tab.
3. Edit the Version property, using a wild-card percentage sign (%) to generalize the match across multiple versions. For example:
   - The original (say 9.2) is an exact match for only one version number.
   - A value of 9.% matches all the minor releases of version 9.
   - A value of % matches all versions of the App-V package with the same name and publisher.
This chapter covers the relationships between the data fields in the source App-V data and the final locations of the data inside the FlexNet Manager Suite database.
## App-V Release 4.6 Data Transfers

This table lists the data extracted from App-V release 4.6, and where it is stored the compliance database in FlexNet Manager Suite.

Imported data is stored in temporary staging tables for data manipulation, and then moved into their final destination tables as noted below. These columns in the compliance database are available for use in custom reports, and the like.

<table>
<thead>
<tr>
<th>App-V (Table)/Column</th>
<th>FNMS (Table)/Column</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>(REPORTING_CLIENT_INFORMATION)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>host_name</td>
<td>(ComplianceComputer)</td>
<td>If the computer name already exists in the ComplianceComputer table, this device is identified as the consuming device.</td>
</tr>
<tr>
<td></td>
<td>ComputerName</td>
<td>If it does not already exist, the device is added to the ComplianceComputer table with a ComplianceComputerTypeID of 4, which (through the ComplianceComputerType table) indicates a remote device from which inventory cannot be collected. All such created records display their connection name (as the Inventory Agent), are marked as incomplete records, and are given a fictitious serial number of 1.</td>
</tr>
<tr>
<td></td>
<td>ComplianceDomainID</td>
<td>The domain name is extracted from the host record on the App-V server. If the domain does not already exist in the compliance database, it is added to the ComplianceDomain table, and as required the ComplianceDomainID may be updated in the ComplianceComputer table.</td>
</tr>
<tr>
<td></td>
<td>ComplianceUserID</td>
<td>The last logged on user for this computer.</td>
</tr>
<tr>
<td>(APPLICATION_USAGE)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>username</td>
<td>ComplianceComputer</td>
<td>The name of the App-V package (which may bear no resemblance to the application inside) is used to identify the evidence record.</td>
</tr>
<tr>
<td></td>
<td>ComplianceUserID</td>
<td></td>
</tr>
<tr>
<td>(VW_APPLICATIONS)</td>
<td>InstallerEvidence</td>
<td>Note • It is possible for an App-V package to contain more than one application. This makes it impossible to link the App-V evidence to a single application record.</td>
</tr>
<tr>
<td>app_name</td>
<td>DisplayName</td>
<td></td>
</tr>
<tr>
<td>App-V (Table)/Column</td>
<td>FNMS (Table)/Column</td>
<td>Notes</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------</td>
<td>-------</td>
</tr>
<tr>
<td>(VW_APPLICATIONS) version</td>
<td>(InstallerEvidence) Version</td>
<td>The version of the App-V package. Again, this bears no necessary relationship to the version of the application inside the package, and is at the whim of the person preparing the package (for example, it may represent the number of times the application package was modified).</td>
</tr>
<tr>
<td>String literal App-V</td>
<td>(InstallerEvidence) Publisher</td>
<td>All App-V evidence is given the publisher name of App-V.</td>
</tr>
</tbody>
</table>

### App-V Release 5.0 (and Later) Data Transfers

This data is imported from Microsoft App-V release 5.0 and later. It is imported by the combination of the PowerShell script installed on your App-v Management Server, and the App-V server adapter on an inventory beacon that can access the App-V reporting database.

Several staging tables in the compliance database store information uploaded from the App-V reporting database and the .raa files. These include:

- ImportedComputer
- ImportedInstalledInstallerEvidenceUsage
- ImportedInstallerEvidence
- ImportedRemoteApplication
- ImportedRemoteApplicationAccess
- ImportedRemoteApplicationServer
- ImportedRemoteApplicationInstallerData

Data is held in these tables until the import from the App-V server adapter is complete, and then the resolvers are triggered to combine the data from:

- The most recent Active Directory import(s) across all relevant domains
- The most recent imports of the .raa file from all App-V Management Server
- The App-V reporting database.

For this reason, it is important that the import from the App-V reporting database happens last.

The following table lists the elements and their attributes from the .raa file, and their final table and column in the compliance database within FlexNet Manager Suite.
### Data mapping

<table>
<thead>
<tr>
<th>XML (Element) / Attribute</th>
<th>FNMS (Table) / Column</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>(app) appID</td>
<td>n.a.</td>
<td>Used as a key as required across the temporary tables listed above.</td>
</tr>
<tr>
<td>(app) userSid</td>
<td>n.a.</td>
<td>The group SID (from Active Directory) identifying the users and computers with access to the package. This drives the linking of inventory device and user records to the application.</td>
</tr>
<tr>
<td>(msiData) msiDisplayName</td>
<td>(InstallerEvidence) DisplayName</td>
<td>Visible as the Name in Installer Evidence properties.</td>
</tr>
<tr>
<td>(msiData) msiPublisher</td>
<td>(InstallerEvidence) Publisher</td>
<td>Visible as the Publisher in Installer Evidence properties.</td>
</tr>
<tr>
<td>(msiData) msiVersion</td>
<td>(InstallerEvidence) Version</td>
<td>Visible as the Version in Installer Evidence properties.</td>
</tr>
</tbody>
</table>

The following are the views used for source data from the App-V reporting database. It is not possible to give a simple mapping of this source data to columns in particular database tables within FlexNet Manager Suite, because the data is normalized and otherwise processed at each stage. For example, the `username` column collected from `view_ApplicationUsage` in the App-V reporting database is already subject to considerable validation and processing before it is stored in the `lastloggedonuser` column in the staging tables (staging tables are listed above). Thereafter, the user name is correlated with other inventory sources, resulting in further processing before it is used to determine a link between the application and the user. For that reason, this table shows only the source content in the App-V reporting database.

<table>
<thead>
<tr>
<th>App-V View</th>
<th>Columns</th>
</tr>
</thead>
<tbody>
<tr>
<td>dbo.view_ApplicationUsage</td>
<td>• app_name</td>
</tr>
<tr>
<td></td>
<td>• app_version</td>
</tr>
<tr>
<td></td>
<td>• end_time</td>
</tr>
<tr>
<td></td>
<td>• host_id</td>
</tr>
<tr>
<td></td>
<td>• start_time</td>
</tr>
<tr>
<td></td>
<td>• username</td>
</tr>
<tr>
<td></td>
<td>• version_guid</td>
</tr>
<tr>
<td>dbo.view_ClientInformation</td>
<td>• host_id</td>
</tr>
<tr>
<td>App-V View</td>
<td>Columns</td>
</tr>
<tr>
<td>----------------------------</td>
<td>------------------------------</td>
</tr>
<tr>
<td>dbo.view_PackageInformation</td>
<td>• host_id</td>
</tr>
<tr>
<td></td>
<td>• package_id</td>
</tr>
<tr>
<td></td>
<td>• version_guid</td>
</tr>
<tr>
<td></td>
<td>• host_name</td>
</tr>
</tbody>
</table>
The BMC Atrium adapter is a mechanism for two-way information synchronization between an on-premises implementation of FlexNet Manager Suite, and BMC Software's Atrium configuration management database (CMDB) and Remedy IT Services Management product. Data flows in two directions, which in this document are described from the viewpoint of FlexNet Manager Suite as export and import:

- The adapter exports computer system and recognized product information from FlexNet Manager Suite to the CMDB. (Details of fields exported are available in Appendix 1: Export of Computers on page 116 and Appendix 2: Export of Applications/Products on page 120.)

- The adapter also imports Asset role, status and owner information from the CMDB and Remedy into FlexNet Manager Suite. (Details of the imported data are available in Appendix 3: Import of Assets on page 124.)

**Note** • This adapter is only available for on-premises implementations of FlexNet Manager Suite. Specifically, it cannot be used with the cloud implementation.

This documentation covers the following tested products:

- FlexNet Manager Suite version 2016 R1
- BMC Atrium CMDB version 8.1 (together with Atrium Integrator version 8.1)
- BMC Remedy ITSM Applications version 7.6.04 SP 4.
Architecture, Operation, and Prerequisites

Topics:

- Architecture and Operations
- Prerequisites
- Obtaining the Adapter Components

This chapter provides a framework for your understanding of later, more detailed information.


Architecture and Operations

To facilitate the two-way exchange of data between FlexNet Manager Suite and BMC Atrium, components already supplied with both systems are used, and additional elements are supplied with the downloaded adapter.

The following diagram combines the positioning of these elements on different servers, with the data flows for both export and import (as defined in BMC Atrium and Remedy Integration on page 79). There are two determining factors in this structural arrangement:

- The schedule for triggering both exports and imports is configured within Atrium, and the Atrium Integrator needs to invoke the data export utility and the FlexNet Business Importer. For this reason, all three components (Atrium Integrator, export utility, and Business Importer) are located on the same server.

- For performance, it is preferable that the intermediate database be on the same database server as your compliance database for FlexNet Manager Suite. (Where you choose a different location, ensure there is a high-speed network connection between the two servers, and a trust relationship for the accounts used during operations.)

The combination of these two determinants produces the following physical architecture. Net data flows are shown here, with each process also shown separately below.

![Architecture Diagram](image)

Once the adapter components are installed and all systems are configured (as described in the chapter Installing the Adapter on page 86), operation is fully automatic, triggered by schedules you set during configuration. The two directions of data exchange function independently, and are summarized below.

**Export of Computers and Products**

In summary, the process for exporting computer and product information from FlexNet Manager Suite to BMC Atrium (shown below in blue arrows) is as follows:
1. The schedule for export fires in Atrium, and the Atrium Integrator calls the data export tool (installed as part of the adapter).

2. The data export tool reads content from the compliance database for FlexNet Manager Suite, and writes the data into the intermediate database. (It also creates entries in the log file, and sends alert emails if there any errors.)

3. On success, the Atrium Integrator reads the data from the intermediate database, maps it using the defined data transforms to the fields required in Atrium

4. The Atrium Integrator writes the results into the CMDB.

**Import of Assets**

In summary, the process for importing assets (and their ownership) from BMC Atrium into FlexNet Manager Suite (shown below in green arrows) is as follows:
1. The schedule for import fires in Atrium.

2. The Atrium Integrator reads data from both the Remedy database and the CMDB, and writes the results into the Intermediate database. (It also sends alert emails if there are any errors.)

3. On success, the Atrium Integrator calls the FlexNet Business Importer.

4. The Business Importer reads the data from the intermediate database, transforms it as required, and writes the results into the compliance database of FlexNet Manager Suite.

## Prerequisites

The prerequisites for the BMC Atrium adapter include the following:

- On the server where the data utility is to be installed, .NET Framework 4.5 is required. (To validate, open Windows Programs and Features, and search for .NET.)

- FlexNet Business Importer must be installed on the same server where the Atrium Integrator is installed. This is installed as a part of the FlexNet Business Adapter Studio. Collecting the installer files is covered in Obtaining the Adapter Components on page 84, and completing the installation and configuration is detailed in Install the Business Importer and Link with Remedy on page 95.

- The adapter requires an intermediate database to be installed, conceptually between the compliance database for FlexNet Manager Suite and the CMDB for BMC Remedy. In practice, this intermediate database may reside on the same database server as the compliance database; or any other convenient server running at least Microsoft SQL Server 2008 that is accessible from both your BMC Atrium server and your FlexNet Manager Suite database server. Scripts to set up the database are included with the adapter, and the process is covered in Preparing the Databases on page 88.

- FlexNet Manager Suite version 2016 R1
• A FlexNet Manager Platform BMC Atrium CMDB Option license. To verify that you have this license term, navigate to the system menu (葑 in the top right corner) > FlexNet Manager Suite License, and look for this item in the list of Licensed products. If not present, you can request the license term through the Contact us to renew or upgrade email link on the same page.

• BMC Atrium CMDB version 8.1 (together with Atrium Integrator version 8.1)

• BMC Remedy ITSM Applications version 7.6.04 SP 4.

Obtaining the Adapter Components

Here's where to collect the adapter, and the main elements it contains.

It is most convenient to complete this procedure on the computer where you will install the adapter (see Architecture and Operations on page 81).

1. Use your browser to access the Flexera Software Product and License Center.
   a) Using the account details emailed to you with your order confirmation from Flexera Software, login to https://flexerasoftware.flexnetoperations.com/.
   b) From the list of products, select FlexNet Manager Platform, and again in the following page to differentiate elements of the Suite, if applicable.
   c) Finally, click through the link for FlexNet Manager Suite 2016 R1 to access the downloads.

2. Use your account supplied with your original order confirmation to log into the Flexera Software Product and Licensing Center.
   The URL for logging in is https://flexerasoftware.flexnetoperations.com.

3. Navigate to the appropriate page of the Product and Licensing Center:
   a) From the Product List, select FlexNet Manager Platform.
   b) In the next Product Information page, also select FlexNet Manager Platform.
   c) In the following page, also entitled Product Information, select the Release Archive tab.

4. In the row for the appropriate release, click the FlexNet Manager Platform link.
   You may need to accept an online End User License Agreement to proceed.

5. Select the Adapter Tools archive (Adapter Tools.zip), and save to a convenient location (such as C:\temp) on the server where Atrium Integrator Spoon is installed.

6. Similarly, download the Business Adapter Studio version Installer and save on the same server.
   Installation of the Business Adapter Studio is covered in Install the Business Importer and Link with Remedy on page 95.

7. Unzip the Adapter Tools.zip archive, navigate through Tier 1 Adapter Tools > BMC Atrium Discovery and Dependency Mapping Tools, and copy the contents into C:\Program Files \Flexera\.
Important • This path is referenced in various steps in the Atrium jobs and transformations (see file list below). If you do not use the same path, you must edit the Atrium Integrator Spoon jobs and transformations manually to point the shell scripts to different location.

The archive includes the following key components:

- An SQL script to create the intermediate staging database (..\SQL\ADDM_staging.sql)
- The definition of patterns that the adapter uses to extract inventory data from ADDM (..\patterns \Flexera.FNMP.InventoryRawData.tpl).
- The adapter's main executable (..\FnmpADDMStage\FnmpADDMStage.exe), and its operational settings file (..\FnmpADDMStage\FnmpADDMSettings.xml) which contains:
  - The connection configuration for accessing the Web API of the ADDM server
  - The connection string for the adapter to connect to the staging database in SQL Server
  - Settings for the staging data path where XML files are staged before import to the staging database, and may be left for inspection; and a parameter that defines the staging method, which may be:
    - stage — Query ADDM and stage the results into XML files in the defined path. Do not import the results into the SQL Server staging database.
    - staged — Query ADDM and stage the results into XML files, and then import the staged XML files into the SQL Server staging database.
    - prestaged — Do not query ADDM. Import XML files which have been previously staged (that is, saved in the specified data path) into the SQL Server staging database.
    - stream — No staging to disk. Query ADDM and stream the results directly into the SQL Server staging database.
  - The SQL statements executed against the ADDM database to extract inventory data, and the mappings of that data to the columns in the staging database.
Installing the Adapter

Integrating two sophisticated systems like these involves a number of procedures, documented in the topics shown:

1. Installing the new, intermediate DB used for data manipulation and transfer (see Preparing the Databases on page 88).
2. Modify the compliance database in FlexNet Manager Suite with a custom property for additional values (also in Preparing the Databases on page 88).
3. Installing and configuring the export utility that brings data out of FlexNet Manager Suite and into the intermediate database (still in Preparing the Databases on page 88).
4. Declaring a dataset within Atrium for data exchange, and authorizing an account to use that dataset (see Reserving an Atrium Dataset on page 90).
5. Importing the supplied Atrium jobs and data transforms into your Atrium system (see Importing Atrium Jobs and Transforms on page 91).
6. Configuring the supplied Atrium jobs with appropriate settings for your environment (see Configure Atrium Jobs on page 91).
7. For the import of asset data from Atrium to FlexNet Manager Suite, installing the FlexNet Business Adapter Studio (which brings with it the Business Importer), and integrating the Business Importer with BMC Remedy Mid-Tier (see Install the Business Importer and Link with Remedy on page 95).
8. Initially populating the CMBD with configuration items from FlexNet Manager Suite, and then adjusting settings to allow for reuse for future imports (see Tuning Creation of Configuration Items on page 102).
9. Schedule regular operations of the adapter (see Scheduling the Adapter on page 103).

This chapter also includes details about Verifying Data Export to BMC Atrium on page 105.
If you are transferring large datasets, you should also prepare an environment variable as described in Preparing for Large Datasets on page 109. (Other configuration options, including relocating or renaming the log file, are also documented in the chapter Additional Customization of the Adapter on page 108.)
Preparing the Databases

You have a clear understanding of your physical architecture for the installation (see *Architecture and Operations* on page 81), and have downloaded and unzipped the archive containing the adapter (see *Obtaining the Adapter Components* on page 84).

1. Determine where the intermediate database used by the adapter will reside, and log into that database server using an account that has DB Owner privileges.
   
   For details, refer back to *Architecture and Operations* on page 81.

   _Tip_ • If the archive cannot be accessed from this database server, first copy the script (or both scripts for a common DB server) from this folder to a location accessible from SQL Server Studio. If you use copies of the scripts, modify the paths described below to suit.

2. On this server, in Microsoft SQL Server Studio, create the intermediate database (suggested name AtriumIntermediateDB).

3. Open a query window that is connected to your new database, and execute 
   `CreateIntermediateDatabase.sql` (located in the unzipped archive, by default in `C:\Program Files\Flexera\BMCAtriumAdapter\scripts`).
   
   This SQL procedure creates the required tables and pre-populates some fixed values.

4. If the intermediate database is on another server separate from your compliance database for FlexNet Manager Suite, switch over and log into the FlexNet Manager Suite database server, again using an account that has DB Owner privileges.
   
   You need access to the second SQL script here, so if necessary, copy the second script to this server before continuing.

5. In Microsoft SQL Server Studio, navigate to and execute `C:\Program Files\Flexera\BMCAtriumAdapter\scripts\FNMPDatabaseChanges.sql`
   
   This SQL script adds a custom property to the Details tab of computer properties in FlexNet Manager Suite where the machine's Role can be imported from BMC Atrium.

6. On the server where the data extraction executable will run (likely, the Atrium server), open a command prompt, and navigate to `C:\Program Files\Flexera\BMCAtriumAdapter\FNMPExports\Utility`
   
   This executable requires .NET Framework 4.5 installed, a high-speed network access to the database(s), and an account trusted to access both the compliance database and the intermediate database. It must be callable by the Atrium Integrator. If need be, first copy the entire contents of the folder shown above (including subdirectories) to a convenient location on the appropriate machine.

   _Tip_ • To validate that the host is correctly configured with .NET Framework 4.5 or later, execute
   
   `FNMPDataExportUtility.exe /help`
   
   A list of command-line options is displayed. If not, investigate the version of .NET installed.
7. Execute the following (on a single line):

```
FNMPDataExportUtility.exe \
    /Source "FNMP-DBConnectionString" \
    /Target "IntermediateDBConnectionString" \
    /Encrypt
```

where:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>FNMP-DBConnectionString</td>
<td>The connection string (enclosed in double quotation marks) for the export utility to connection with the compliance database for FlexNet Manager Suite. The Data Source value must be the fully-qualified domain name of the database server. Where the compliance database is not in the default instance on this server, add the instance name (separated by a slash). An example connection string when the default name for the compliance database is FNMSCompliance, is (all on one line): Data Source=DBServer.example.com/myInstance; Initial Catalog=FNMSCompliance;Integrated Security=SSPI; Connection Timeout=60;Min Pool Size=2;Max Pool Size=20;</td>
</tr>
<tr>
<td>IntermediateDBConnectionString</td>
<td>The connection string (enclosed in double quotation marks) for the export utility to connection with the intermediate database you recently created. An example connection string when this is on the same server and instance as the compliance database, and the default name for the intermediate database is IntermediateDB, is (all on one line): Data Source=DBServer.example.com/myInstance; Initial Catalog=IntermediateDB;Integrated Security=SSPI; Connection Timeout=60;Min Pool Size=2;Max Pool Size=20;</td>
</tr>
<tr>
<td>/Encrypt</td>
<td>This option encrypts the connection strings when they are saved into the configuration file for the export utility. (The configuration file lives in the same folder as the executable, and is called FNMPDataExportUtility.exe.config)</td>
</tr>
</tbody>
</table>

8. Configure where the export utility sends email notifications about any export errors.

   a) From the same folder, open FNMPDataExportUtility.exe.config in a flat text (or XML) editor.

   b) Locate the following section and replace the values shown:

   ```xml
   <appender name="SmtpAppender" type="log4net.Appender.SmtpAppender">
     <to value="toaddress@somedomain.com"></to>
     <from value="fromaddress@somedomain.com"></from>
     <subject value="Atrium Integration Adapter Error"></subject>
   <smtpHost value="smtp.somedomain.com"></smtpHost>
   ```

   where:
Reserving an Atrium Dataset

You must specify a dataset for information exchange, and ensure you have an account with write access to that dataset.

This procedure sets up a data area within Atrium reserved for data exchange with the FlexNet Manager Suite adapter. Your Atrium Administrator may assist with an account that had permissions to access this dataset. You will reference this dataset later in the installation of the adapter.

1. In the BMC Remedy User application, open the CMDB console.
2. Select Reconciliation Manager > Create > Dataset.
   A Dataset Information form appears.
3. Complete the following parameters:

<table>
<thead>
<tr>
<th>Dataset name</th>
<th>A friendly name for the dataset that you will recognize later in other listings.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dataset ID</td>
<td>The system identifier for the dataset.</td>
</tr>
<tr>
<td>Accessibility</td>
<td>Use the drop-down list to set this to Writable.</td>
</tr>
<tr>
<td>DatasetType</td>
<td>Use the drop-down list to set this to Regular.</td>
</tr>
</tbody>
</table>

4. Click Save. The new dataset is created.
5. Consult with your Atrium Administrator about an account with write access to the created dataset. This account must be used on the Atrium side to run the adapter.

For more information about creating the dataset, see
http://discovery.bmc.com/confluence/display/81/Configuring+the+BMC+Atrium+Adapter.

<table>
<thead>
<tr>
<th>Value</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>toaddress</td>
<td>Valid email address for the person who is to receive alerts when errors occur during export.</td>
</tr>
<tr>
<td>fromaddress</td>
<td>Valid email address for an account known on the specified SMTP host that is identified as the sender of the email when an error occurs.</td>
</tr>
<tr>
<td>smtp.somedomain.com</td>
<td>The fully qualified domain name of the SMTP email server.</td>
</tr>
</tbody>
</table>

a) While here, you may want to customize the location of the log file for the export utility:

```xml
<log4net>
    <appender name="RollingFileAppender" type="log4net.Appender.RollingFileAppender">
        <file value="C:\Log.txt" />
    </appender>
</log4net>
```

a) Save the edited file, and exit the editor.
Importing Atrium Jobs and Transforms

You need to get the supplied files into the Atrium repository, configured for your local connections.

For this procedure, you must be logged into your Atrium server with administrator privileges. This server needs access to the unzipped archive for the adapter (in this procedure, shown as on the same server).

1. Open the Atrium Integrator Spoon tool.
2. Select File > Open URL..., navigate to and open C:\Program Files\Flexera\BMCAtriumAdapter\FNMPExports\ExportComputersTransform.ktr.
3. Modify the connection strings for each of:
   - Atrium_CMDB
   - AR Server
   - IntermediateDB.
4. Click File > Save.

Repeat this procedure for each of the following files in the order listed:

1. C:\Program Files\Flexera\BMCAtriumAdapter\FNMPExports\ExportProductsTransform.ktr
2. C:\Program Files\Flexera\BMCAtriumAdapter\FNMPExports\ExportComputerProductRelationshipsTransform.ktr
3. C:\Program Files\Flexera\BMCAtriumAdapter\FNMPExports\ExportUpdateIntermediateDBTransform.ktr
4. C:\Program Files\Flexera\BMCAtriumAdapter\FNMPImports\Asset.ktr
5. C:\Program Files\Flexera\BMCAtriumAdapter\FNMPImports\ImportUpdateIntermediateDBTransform.ktr
6. C:\Program Files\Flexera\BMCAtriumAdapter\FNMPExports\FNMPExports.kjb
7. C:\Program Files\Flexera\BMCAtriumAdapter\FNMPExports\Execute FNMP Export Tool.kjb
8. C:\Program Files\Flexera\BMCAtriumAdapter\BMCAtriumAdapter.kjb

Configure Atrium Jobs

In Atrium, jobs must be linked to transforms.

You have completed the import of both tasks and jobs into the Atrium repository (as in Importing Atrium Jobs and Transforms on page 91). Now configure the jobs, still logged into Atrium Spoon.

1. Select File > Open..., and select FNMPExports.kjb from the repository.
   A map of the transformations required for the job is displayed.
2. Right-click ExportComputersTransform, and from the context menu select Edit job entry. The Job entry details for this transformation dialog appears. The transform name as recorded in the job entry appears in the first field, Name of job entry.

3. Select the Specify by name and directory option.

4. To provide a value in the associated field, browse the repository and select the transform name matching the first field. For example, when processing the job entry for ExportComputersTransform, select the transform of the same name from the repository.

5. Click OK.

6. Repeat steps 2-5 for each of the remaining job entries in this chart:
   - ExportProductsTransform.ktr
   - ExportComputerProductRelationshipsTransform.ktr
   - ExportUpdateIntermediateDBTransform.ktr.

7. Select File > Save.

8. Select File > Open..., and select BMCAtriumAdapter.kjb from the repository. A map of the job is displayed.
9. Repeat steps 2-5 for the transform in this chart:
   - Asset.ktr.

10. Double-click the FNMPExports job.
    The **Executing a job** dialog appears. The **Job entry name** appears as the first field.

11. Select the **Repository: specify by name** option.

12. To provide a value in the associated field, browse the repository and select the job name matching the first field.

13. Click **OK**.

14. Repeat steps 10-13 for the remaining job in this chart:
   - Execute FNMP Export Tool.kjb.
15. Select File > Save.

16. Either press Ctrl-J; or right-click the BMCatriumAdapter diagram background, and from the context menu select Job settings.

   The Job properties dialog opens.

   ![Job properties dialog](image)

   **Table: Parameters**

<table>
<thead>
<tr>
<th>#</th>
<th>Parameter</th>
<th>Default value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>COMPANYNAME</td>
<td>TEST</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>COMPUTERQUERYID</td>
<td>Computers</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>COMPUTERTABLENAME</td>
<td>ComputerSystem</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>DATASETID</td>
<td>BMC.TESTJ1</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>PRODUCTDSQUERYID</td>
<td>ProductIds</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>PRODUCTQUERYID</td>
<td>Products</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>PRODUCTTABLENAME</td>
<td>Product</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>TENANTID</td>
<td>2</td>
<td></td>
</tr>
</tbody>
</table>

17. Edit the following values:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>COMPANYNAME</td>
<td>Enter your company name as it is recorded in the CMDB. (A match is required.)</td>
</tr>
<tr>
<td>DATASETID</td>
<td>Enter the ID for the dataset that you created for the adapter (see Reserving an Atrium Dataset on page 90).</td>
</tr>
</tbody>
</table>

18. Select File > Save.

19. To configure email alerts for errors occurring on the Atrium side of the adapter:

   a) In the BMCAtriumAdapter job, right-click on the Mail step in the center.

   b) From the option menu, select Edit job entry.

      The Job mail details dialog appears.
a) In the **Addresses** tab, insert the following:

- **Destination address** - the person who is to receive the email alert for each error.
- **Sender name** - the value to appear on the emails as the sender.
- **Sender address** - The email address from which the email will appear to come. This must be a valid email account known to the mail server (specified next).

b) Switch to the **Server** tab, and complete the **SMTP Server** details.

c) Click **OK**.

20. Select **File > Save**.

**Install the Business Importer and Link with Remedy**

The Business Importer performs parts of the integration work, writing data from Remedy into the FlexNet Manager Suite database.

The Business Importer is installed as part of the Business Adapter Studio, a stand-alone environment you can use to build business adapters. These 'adapt' the format of data from other business systems in your computer estate for import into FlexNet Manager Suite, and are exercised by the Business Importer. You downloaded the installer for the Business Adapter Studio in *Obtaining the Adapter Components* on page 84. To enable the business import process, you also configure the reconciliation process to link with the Business Importer. Since the Atrium Integrator must trigger the Business Importer, the normal architecture is to install the Business Adapter Studio on the Atrium server.

1. On the Atrium server, navigate to the downloaded archive, and extract the **Business Adapter Studio** folder.
2. **Execute** `Business Adapter Studio\setup.exe`.
   The installation wizard for Business Adapter Studio opens.

3. Complete the installation wizard using the default values it provides.

4. Login to BMC Remedy Mid-Tier using an account name and password provided by your BMC Administrator.
   The **IT Home** page appears.

5. Click the **Applications** tab on the left boundary.
   The Applications menu expands.

6. Select **Atrium Core**, and in the sub-menu select **Atrium Core Console**.
The **BMC Atrium Core Console** window opens.

7. Click the **Application Launcher** tab on the left edge, then select **Applications** from the menu, and in the sub-menu select **Reconciliation**. The **Reconciliation** tab opens.
8. Click the new job icon in the toolbar.  
The Job Editor page appears.
9. In the **Name** field, provide a name for this job that you will recognize later.
   
   Suggested value: FNMP Asset Reconciliation.

10. In the **Activities** group, click **New**.
    
    The **Activities** group changes to the **Edit Activity** area.
11. Complete the details for the first (Identify) activity:
   a) In the Name field, provide a name you will recognize later.
      Suggested value: Identify.
   a) Ensure that the Continue on Error check box is clear.
      Recall that the system is configured to send emails on any errors in exporting the assets to FlexNet Manager Suite.
   b) Set the Sequence number to control ordering of activities in the job.
      Recommendation: Number in hundreds to allow for later changes. Suggested value: 500.
   a) In the Dataset Configuration area, click the first icon to add a new dataset, and select the one you created for this exchange.
      The suggested value was BMC.FNMS.
   b) Click Done to save details of this activity.
      The Activities group reappears, showing this first activity in the list.
12. Once again, in the Activities group, click New, and complete the details for a merge activity:
a) Add a **Name** for the activity.
   Suggested value: Merge.

a) Ensure that the **Continue on Error** check box is clear.

b) Set the **Sequence** number to a value higher than the identification step.
   Suggested value: 600.

c) From the list of **Source Datasets**, select only the one identified in the previous activity.
   The suggested value was BMC.FNMS.

d) From the list under **Target Dataset**, select the BMC Asset dataset.

e) In the **Precedence** group, click the + icon to add a new **Precedence Association Set**.
   Suggested value: BMC.FNMS, BMC Asset.

f) Click **Done** to save details of this activity.
   The **Activities** group reappears, showing your two activities.
13. In the **Schedule** group, click **New**.

   Set the values to suit your business processes, with a suggested frequency being once every 2-4 weeks.

14. At the bottom of the **Job Editor**, click **Save** to store your job details in the repository.

## Tuning Creation of Configuration Items

Atrium requires an initial run to populate the database, and then customization for regular scheduled operations.

In the first run of the adapter, all the products and computers exported from FlexNet Manager Suite are inserted as configuration items in the CMDB. Thereafter, matching records should be updated, and only new items inserted. We therefore run the first pass with the default settings, and then modify the settings to schedule the regular data exchange.

1. **In BMC Atrium Integrator** console, from the list of **Jobs** on the left, choose the **BMCAtriumAdapter** job.
2. In the toolbar, click the third icon (with the play button) to run the selected job once.
Installing the Adapter

As there may be a large backlog of data to handle, and Spoon processes a line at a time, the first import can be quite time-consuming. Wait for the first import to complete successfully before continuing with this procedure.

3. In Atrium Integrator, update the way Atrium receives the export of computers as follows:
   a) Open the ExportComputersTransform transformation from the repository.
   b) Double-click the CMDBoutput step to expose its properties.
   c) Clear (turn off) the Always Insert CIs check box.
   d) Select (turn on) the Only insert new CIs check box.
   e) Click OK to close the CMDBoutput step, and click Save to store the changes to the transform.

4. Update the processing of the export of products:
   a) Open the ExportProductsTransform transformation from the repository.
   b) Double-click the CMDBoutput step to expose its properties.
   c) Clear (turn off) the Always Insert CIs check box.
   d) Click OK to close the CMDBoutput step, and click Save to store the changes to the transform.

Scheduling the Adapter

The adapter to exchange data between FlexNet Manager Suite and BMC Atrium is driven by a schedule set up in Atrium.

Continue this process in the Atrium Integrator console.

1. If you are not already in the Atrium Integrator console:
   a) Login to BMC Remedy Mid-Tier using user name and password provided by BMC Administrator.
b) Click the **Applications** tab on the left edge.
   The **Applications** menu expands.

   c) Select **Atrium Integrator**, and then click **Atrium Integrator Console**.

2. In the **Jobs** list on the left, select your **BMC Atrium Adapter** job.

3. In the tool bar, select the icon to manage the job schedule ( ⌚️).

4. Select **Active**.

5. Select the **Create new schedule** option.
   The **Schedules - “BMC Atrium Adapter”** page appears.

First Select the Job on left menu then click the tool bar button on top to set the schedule.
6. Complete the details for the regular operation of the adapter (this schedule controls data flow both ways, for import and export):
   a) Give the schedule a meaningful name in the top right corner (Enter Schedule Name).
   b) Use the Start Time spinners to dial up the time of day to start operation of the adapter.

   Tip • This is local time on the BMC Remedy AR System server.

   c) In the Recurrence Type area, specify how frequently you want the job to run.
      Recommendation: The process is quite time-consuming. In a stable environment, consider a monthly data exchange (Interval Based).
   d) Depending on your choice, complete the Recurrence Details.
   e) Click Save.

The integration between FlexNet Manager Suite and BMC Atrium is now operational.
However, before the next scheduled run, you should consider any further customization that may be necessary, especially in relation to large data sets.

Verifying Data Export to BMC Atrium

This process confirms that data has been exported from FlexNet Manager Suite and successfully imported by Atrium.
This procedure uses the Atrium Core application (not Atrium Integrator).
1. If you are not already in the Atrium Core console:
a) Login to BMC Remedy Mid-Tier using user name and password provided by BMC Administrator.

b) Click the **Applications** tab on the left edge.
   The **Applications** menu expands.

c) Select **Atrium Core**, and then click **Atrium Core Console**.

A new window opens with the **Application Launcher** tab on the left edge.

2. Click the **Application Launcher** tab, and in the fly-out menu, click **Applications**.

3. In the sub-menu, click **Explorer**.
   The **Explorer** tab opens, with multiple accordion folds. Ensure that the **Find** fold is open.
4. In the Find area, use the drop-down list on the left below the tool icons to select the BMC.FNMS dataset.

5. Optionally choose an object type to search for, or expand the Quick search of all CIs.

6. Optionally, add data (or partial values) to the Name and Short Description fields (and controls for matching) to narrow the search for particular configuration items, or leave the fields blank for a full listing of all results.

7. Click Search.
   A list of results (shown inset) is displayed. Validate that the data is as expected.
3

Additional Customization of the Adapter

Topics:

• Preparing for Large Datasets
• Updating Connection Details
• Updating Email Details
• Turning Off Email Alerts for Export Errors
• Changing the Log File

The following notes help with minor changes to configuration, especially for future changes to configuration. The one case that may be critical to your initial implementation is the first topic, covering preparations for large datasets.
Preparing for Large Datasets

Large numbers of data records require a customized environment variable.

If your integration between FlexNet Manager Suite and BMC Atrium will exchange large numbers of records (for example, 100,000 computer records or more), you need to configure an environment variable on the Atrium server.

1. Ensuring that you are logged onto the Atrium server with Administrator privileges, open the Windows start menu, and right-click **Computer**.
2. From the context menu, select **Properties**. The Control Panel page of system properties appears.
3. In the navigation bar, select **Advanced system settings**. The **System Properties** dialog appears. Confirm that the **Advanced** tab is selected.
4. Click **Environment Variables...**. The **Environment Variables** dialog appears.
5. In the **System Variables** (lower) group, click **New...**. The **New System Variable** dialog appears.
6. Insert the **Variable name**: 
   `_JAVA_OPTIONS`
7. Insert the **Variable value**:
   `-Xms512m -Xmx15360m`

   This configures the Java heap size above 15GB.
8. Click OK three times to close the various dialogs, and you can close the Control Panel window.

Updating Connection Details

When system passwords change, you need to update the adapter's configuration file.

Connection details are stored, encrypted, in the adapter's configuration file (by default located at `C:\Program Files\Flexera\BMCAtriumAdapter\FNMPExports\Utility\FNMPDataExportUtility.exe.config` on the Atrium server). The encryption process happens the first time the adapter runs after the configuration file is edited. Once the process has run, the connection strings are unreadable and not editable, something similar to the following:

```
<connectionStrings configProtectionProvider="DataProtectionConfigurationProvider">
  <EncryptedData>
    <CipherData>
      <CipherValue>AQAAANCMndBBPcERjHoAwE/C1+sBAAAAnhcgMGAyK6uY9NtqOg/WbQAAAACAAAAAABQkZgAAABAAAAAACgA
AAAAAACECywz5AXZw9XZtEPlAAAggAAPJYo+gS9Fy2cMNTYq08DhAqZdRA9nB91
DN42AlxjeCsUs9+KNyVUI1FSP4vUjta4evf31Oy5odyHsIrJRCCKQGd1wh4I5EY
pkJ/k/QnaaLeCbbtXxslXKZlAHC6a5y16AojEXT2F5N0jE1JX66
XbUXQDA4Nh8f1z6X1f/CDbx8qCuMhyn1cTLYuGe+5AQPyDgyc3rAUZ2FoqZ/7bucK0w71oZ
dBEh8H0vC1z2qZsW3ty9F10K/0XqK0FQ8crq95bn7W4E1v3VU8nte1E9gIa5WYb/P9Ah
h3MX5iQ6F6TQ60qN9EJrslvdqgr6nyg5FAPx2yFVBH2yVbVhV0MURbEBBW+S6/sydg8nY1
DrcMzKlX1Z0Cq4y2YH5wT3+bFEN30xh6XKFH7Tpc8e5y9Tq1Bhwc4KW6AFf2hcdewAp
J4Zk6Ar4ixE66qW0Xomkz2p0KNF1mhrJfqlIL1uQx9FU00u2bJ9Y+dU1rceu0v2hQXOCh9
</CipherValue>
</CipherData>
</EncryptedData>
</connectionStrings>
```
Follow this procedure to replace the connection strings and/or passwords.

1. Open the adapter's configuration file in a flat text (or XML) editor.
   
   **Default location:** C:\Program Files\Flexera\BMCAtriumAdapter\ FNMPExports\Utility\FNMPDataExportUtility.exe.config

2. Locate the `connectionStrings` element (similar to that shown above), select it all, and delete it.

3. Copy the following example, paste into the same place in the configuration file, and replace the placeholder values (including their containing brackets) as described below (you may also remove the white space from the connection strings):

   ```xml
   <connectionStrings>
   <clear />  
   <add name="FNMPDBConnection" connectionString="Data Source=[FNMPDBServerName]; Initial Catalog=FNMSCompliance; User ID=[accountName1]; Password=[somePassword]; Integrated Security=false; Connection Timeout=60;"/>
   <add name="IntermediateDBConn" connectionString="Data Source=[IntermediateDBServerName]; Initial Catalog=IntermediateDB; User ID=[accountName2]; Password=[anotherPassword]; Integrated Security=false; Connection Timeout=60;"/>
   </connectionStrings>
   
   where:
   
<table>
<thead>
<tr>
<th>Placeholder</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>[FNMPDBServerName]</td>
<td>The database server (and optionally, the database instance name) containing the FlexNet Manager Suite compliance database. You may use:</td>
</tr>
<tr>
<td></td>
<td>• A dot (.) when the database is installed on the same server where the adapter executable runs</td>
</tr>
<tr>
<td></td>
<td>• The flat name of the server</td>
</tr>
<tr>
<td></td>
<td>• The IP address of the server</td>
</tr>
<tr>
<td></td>
<td>• Where the database instance is not the default instance on that server, any of the above with a slash (/) separator, and the database instance name.</td>
</tr>
<tr>
<td>FNMSCompliance</td>
<td>This is the recommended database name for the compliance database. If you used a different name, substitute the name you used.</td>
</tr>
<tr>
<td>[accountName1]</td>
<td>The user name that the executable uses to connect to the compliance database.</td>
</tr>
<tr>
<td>[somePassword]</td>
<td>The (newly current) password for the above account.</td>
</tr>
</tbody>
</table>
4. Save the edited configuration file.
The file is saved in plain text. The next time the adapter runs, this section of the configuration file is automatically encrypted. If you are unhappy about leaving the file unencrypted until then, trigger an additional run of the adapter by adding a one-time schedule (see Scheduling the Adapter on page 103).

### Updating Email Details

The adapter sends emails as a heads-up when an error occurs.

With data flows in both directions between FlexNet Manager Suite and BMC Atrium, errors may occur in either export or import. The emails for the two directions are defined separately:

- For export from FlexNet Manager Suite, the data export utility generates the emails, with settings in its configuration file. If the details of your email server are changed, you need to update the adapter's configuration file. It also defines who receives the alerts, and the address from which alerts originate. You can modify any of those detail with this procedure.

- Similarly, for imports from BMC, the email is generated by Atrium based on settings in that system. Those settings are also summarized in this procedure, since it is likely that a change in your infrastructure or personnel affects both kinds of email alerts equally.

We start with emails for exports from FlexNet Manager Suite; and then continue with those for imports to the same system (that is, data is exported from BMC Atrium).

1. Open the adapter's configuration file in a flat text (or XML) editor.

   Default location: C:\Program Files\Flexera\BMCAtriumAdapter\ FNMPExports\Utility\FNMPDataExportUtility.exe.config

2. Locate the `<appender>` element for the `SmtpAppender` node in the file and update the settings marked here with placeholders:

   ```xml
   <appender name="SmtpAppender" type="log4net.Appender.SmtpAppender">
   <to value="toaddress@somedomain.com"></to>
   <from value="fromaddress@somedomain.com"></from>
   <subject value="Atrium Integration Adapter Error"></subject>
   <smtpHost value="smtp.somedomain.com"></smtpHost>
   ```

   where:
## Additional Customization of the Adapter

### Value | Notes
---|---
`toaddress` @somedomain.com | Valid email address for the person who is to receive alerts when errors occur during export.
`fromaddress` @somedomain.com | Valid email address for an account known on the specified SMTP host that is identified as the sender of the email when an error occurs.
`smtp.somedomain.com` | The fully qualified domain name of the SMTP email server.

3. Save the edited file.
4. Open the Atrium Integrator Spoon tool.
5. Select **File > Open...**, and select `BMCAtriumAdapter.kjb` from the repository. A map of the job is displayed.

6. To configure email alerts for errors occurring on the Atrium side of the adapter:
   a) In the `BMCAtriumAdapter` job, right-click on the **Mail** step in the center.
   b) From the option menu, select **Edit job entry**.
      The **Job mail details** dialog appears.
a) In the **Addresses** tab, insert the following:

- **Destination address** - the person who is to receive the email alert for each error.
- **Sender name** - the value to appear on the emails as the sender.
- **Sender address** - The email address from which the email will appear to come. This must be a valid email account known to the mail server (specified next).

b) Switch to the **Server** tab, and complete the **SMTP Server** details.

c) Click **OK**.

The revised email settings for data transfer in both directions take effect for the next run of the adapter.

### Turning Off Email Alerts for Export Errors

You can disable email alerts for problems arising during export from FlexNet Manager Suite.

This procedure provides a quick way to temporarily disable emails sent by the data utility during data export from FlexNet Manager Suite for transfer to BMC Atrium. This procedure turns the emails off without removing the settings details.

**Tip** • For emails generated by BMC Atrium about data preparation for import to FlexNet Manager Suite, there is no single "off switch". To stop those emails, re-do the settings to remove the email details (as described in *Updating Email Details* on page 111).

1. Open the adapter's configuration file in a flat text (or XML) editor.

   **Default location:** `C:\Program Files\Flexera\BMCAtriumAdapter\ FNMPExports\Utility\ FNMPDataExportUtility.exe.config`
2. Locate the following section (towards the end of the configuration file):

```
<root>
  <level value="ALL" />
  <appender-ref ref="RollingFileAppender" />
  <appender-ref ref="SmtpAppender" />
</root>
```

3. Comment out the `appender-ref` element for the `SmtpAppender`:

XML comments are surrounded by `<!-- -->`:

```
<root>
  <level value="ALL" />
  <appender-ref ref="RollingFileAppender" />
  <!-- appender-ref ref="SmtpAppender" / -->
</root>
```

4. Save the amended file.

Email alerts for export errors are suspended until you reverse this process, re-editing the file to remove the comment tags and restored the original value.

## Changing the Log File

You can rename or relocate the log file generated by the adapter for exports from FlexNet Manager Suite.

By default, five copies of the log file, each capped at 10MB, rotate in the nominated folder (total disk space requirement is therefore about 50MB for logging). You can customize the location and base name of the log file as follows:

1. Open the adapter's configuration file in a flat text (or XML) editor.

   **Default location:** `C:\Program Files\Flexera\BMCAtriumAdapter\ FNMPExports\Utility\ FNMPDataExportUtility.exe.config`

2. Locate the following section in the file:

   ```xml
   <appender name="RollingFileAppender" type="log4net.Appender.RollingFileAppender">
     <file value="C:\Program Files\Flexera\BMC Atrium Adapter\Log.txt" />
   </appender>
   ...
   </appender>
   ```

3. Edit the `value` attribute with the new path and file name.

   ```xml
   <appender name="RollingFileAppender" type="log4net.Appender.RollingFileAppender">
     <file value="C:\Program Files\Flexera\BMC Atrium Adapter\Log.txt" />
   </appender>
   ...
   </appender>
   ```

4. Save the modified file.

   *Tip* • Keep in mind that the file name will be expanded with dating information to differentiate the various logs.
The following topics provide data mapping between attributes recorded in the FlexNet Manager Suite database and those recorded in the BMC Atrium CMDB. In addition, some values are generated as part of the export and import processes, and are included in the following listings.

Two separate data objects are exported from FlexNet Manager Suite: Computers, and Products. A much smaller dataset is imported from Atrium into FlexNet Manager Suite, updating information about assets to show their role and owner.
Appendix 1: Export of Computers

For optimal performance, exports are differential (that is, only data changed since the last export is included). The following table shows:

- Columns from the `ComplianceComputers` table (and related tables) in FlexNet Manager Suite that are exported
- The equivalent column name in the `ComputerSystemChanges` table of the intermediate database (in case you wish to inspect the dataset there)
- The matching column in the `BMC_ComputerSystem` table in the Atrium CMDB.

Note •

1. Some values are not read from the source database, but inserted as fixed values. These are shown in double quotation marks, and explained in the associated comments.

2. Some values exported from FlexNet Manager Suite to the intermediate database are not transferred to BMC Atrium. Instead, they are used to manage the exported data, removing records not relevant to the CMDB and so on.

<table>
<thead>
<tr>
<th>Compliance Computer</th>
<th>ComputerSystem Changes</th>
<th>BMC_ComputerSystem</th>
<th>Comments</th>
</tr>
</thead>
</table>
| Not applicable.     | GeneratedTokenID       | TokenID             | `TokenID` takes different formats for different types of computers. In the following examples, the placeholder `X` represents any hexadecimal digit (0-9, A-F).  
- For physical hosts and computers, the `TokenID` is `hostname:DNSdomainName`.  
  - For VMware, `VI-UUID:XXXX-XX-XX-XX-XXXXXX`  
  - For Hyper-V, `HYPERV-ID:XXXX-XX-XX-XX-XXXXXX`  
  Note • With Hyper-V, the `UUID` is only available on the physical machine, so `TokenID` |


### Compliance Computer Changes

<table>
<thead>
<tr>
<th>Compliance Computer ID</th>
<th>ComputerID</th>
<th>CITag</th>
<th><strong>Comments</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>is only set for virtual machines that have been successfully linked to their hosting physical machines.</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• For Xen (including Oracle VM), XEN- ID:XXXX-XX-XX-XX-XXXXXX</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• For KVM (including RedHat Enterprise Virtualization), KVM- ID:XXXX-XX-XX-XX-XXXXXX</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**TokenID is generated dynamically, checking the value in ComputerType. For virtual machines, the value in ComputerToVirtualMachine_VMTypID is used to determine the prefix, and the UUID is attached from ComputerToVirtualMachine_UUID.**

<table>
<thead>
<tr>
<th>Compliance Domain QualifiedName</th>
<th>Domain</th>
<th>Domain</th>
<th><strong>Comments</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>The fully qualified domain name for the domain where this computer exists. Extracted from ComplianceDomain.QualifiedName using ComplianceComputers. ComplianceDomainID as a foreign key. Used when there is no value for FlatDomain received from FlexNet Manager Suite.</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Compliance Domain FlatName</th>
<th>FlatDomain</th>
<th>Domain</th>
<th><strong>Comments</strong></th>
</tr>
</thead>
</table>
| The unqualified name of the domain containing the computer. Extracted from ComplianceDomain.FlatName using ComplianceComputers. ComplianceDomainID as a foreign key. Where this value is present, it is stored in BMC_ComputerSystem.Domain; if
<table>
<thead>
<tr>
<th>Compliance Computer</th>
<th>ComputerSystem Changes</th>
<th>BMC_ComputerSystem</th>
<th>Comments</th>
</tr>
</thead>
</table>
| [Compliance ComputerStatus] DefaultValue | ComputerStatus | (Not stored.) | The current status of this computer within the inventory records. Values include:
- New (this is the first appearance of this computer in inventory)
- Ignored (an operator has marked this computer to be ignored)
- Registered (this inventory record is linked to an asset record)
- Awaiting Inventory (a dummy computer record, allowing its associated asset record to exist, which will be removed when an operator links the asset record to a real inventory item)
- Discarded. These values are extracted from ComplianceComputerStatus. DefaultValue based on the foreign key ComplianceComputers. ComplianceComputerStatusID.  

Tip • The DefaultValue is the US English representation of the values, not localized.

The status is used to make sure that computers that are Awaiting Inventory, Discarded, or Ignored are not transferred to BMC Atrium. |

<table>
<thead>
<tr>
<th>Not applicable.</th>
<th>&quot;Workstation&quot;</th>
<th>CapabilityList Primary Capability</th>
<th>Fixed literal string inserted in the BMC database.</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Compliance ComputerType] DefaultValue</td>
<td>ComputerType</td>
<td>isVirtual</td>
<td>The boolean isVirtual is set true whenever the ComputerType in the intermediate database is either VMHost or Virtual Machine. Possible values are extracted from</td>
</tr>
<tr>
<td>Compliance Computer</td>
<td>ComputerSystem Changes</td>
<td>BMC_ComputerSystem</td>
<td>Comments</td>
</tr>
<tr>
<td>---------------------</td>
<td>------------------------</td>
<td>--------------------</td>
<td>----------</td>
</tr>
<tr>
<td>InventoryDate</td>
<td>InventoryDate</td>
<td>(Not stored.)</td>
<td>The date inventory was last collected from this computer.</td>
</tr>
<tr>
<td>Manufacturer</td>
<td>Manufacturer</td>
<td>ManufacturerName</td>
<td>Values from FlexNet Manager Suite are provided to avoid data normalization by the CMDB that may modify names.</td>
</tr>
<tr>
<td>SerialNo</td>
<td>SerialNo</td>
<td>SerialNumber</td>
<td>The serial number of the computer.</td>
</tr>
<tr>
<td>[VirtualMachine]</td>
<td>ComputerToVirtualMachine_ComplianceComputerID</td>
<td>(Not stored.)</td>
<td>Populated only for virtual machines. A foreign key that links records in the VirtualMachine table to the matching records in the ComputerCompliance table. Used here in the calculation of TokenID.</td>
</tr>
<tr>
<td>[VirtualMachine]</td>
<td>ComputerToVirtualMachine_UUID</td>
<td>(Not stored.)</td>
<td>Populated only for virtual machines. The UUID (Universally Unique Identifier) of the virtual machine. Used to match virtual machine properties to their associated ComplianceComputer. Used here in the calculation of TokenID for virtual machines.</td>
</tr>
</tbody>
</table>
| [VirtualMachine]    | ComputerToVirtualMachine_VMTypeID | (Not stored.) | Populated only for virtual machines. A foreign key to the VMType table, which identifies the kind of virtual machine, including:  
- VMware  
- Hyper-V  
- LPAR  
- WPAR  
- nPar  
- vPar  
- SRP  
- Zone  
- Unknown. |
## Appendix 2: Export of Applications/Products

The term 'product' is used in two slightly different ways in FlexNet Manager Suite and BMC Atrium.

- In FlexNet Manager Suite, the base unit of software is called an "application", which is specific to a particular release (version) and edition. A 'product' is the same software unit, but across multiple versions (and perhaps editions as well). In our terms, then, FlexNet Manager Suite exports application records. To confuse things further, the underlying database table is called `SoftwareTitle`.

- In Atrium, a "product" is the base unit of software, and related to an individual installation. The CMDB also offers a catalog of the products available for installation. In BMC terminology, Atrium imports product records, from which the Product Catalog may also be updated.

The following table shows:

<table>
<thead>
<tr>
<th>Compliance Computer</th>
<th>ComputerSystem Changes</th>
<th>BMC_ComputerSystem</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Used here in the calculation of TokenID.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Not applicable.</td>
<td>UpdatedDate</td>
<td>(Not stored.)</td>
<td>Used when identifying changed data for differential exports to BMC Atrium.</td>
</tr>
<tr>
<td>Compliance Computer TypeID</td>
<td>Compliance Computer TypeID</td>
<td>(Not stored.)</td>
<td>This value is used to filter out remote devices (those from which inventory cannot be collected) and VDI templates, which are not relevant to the CMDB.</td>
</tr>
<tr>
<td>Not applicable.</td>
<td>ViewID</td>
<td>(Not stored.)</td>
<td>Deprecated and not in use.</td>
</tr>
<tr>
<td>Not applicable.</td>
<td>TenantID</td>
<td>(Ignored.)</td>
<td>Always contains a zero value (a string of 16 zeroes) for an on-premises implementation.</td>
</tr>
<tr>
<td>Not applicable.</td>
<td>&quot;BMC_COMPUTERSYSTEM&quot;</td>
<td>ClassID</td>
<td>Fixed literal string inserted in these records to identify the data class in the data set.</td>
</tr>
<tr>
<td>Not applicable.</td>
<td>&quot;CompanyName&quot;</td>
<td>Company</td>
<td>A fixed value that must match the company identifier embedded in the Atrium CMDB.</td>
</tr>
<tr>
<td>Not applicable.</td>
<td>&quot;DataSetID&quot;</td>
<td>DataSetID</td>
<td>Value attached to the dataset considered. Must match the value embedded in the Atrium CMDB.</td>
</tr>
</tbody>
</table>
**Note •**

1. Some values are not read from the source database, but inserted as fixed values. These are shown in double quotation marks, and explained in the associated comments.

2. Some values exported from FlexNet Manager Suite to the intermediate database are not transferred to BMC Atrium. Instead, they are used to manage the exported data, removing records not relevant to the CMDB and so on.

<table>
<thead>
<tr>
<th>SoftwareTitle</th>
<th>ProductChanges</th>
<th>BMC_Product</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Not applicable.</td>
<td>GeneratedTokenID</td>
<td>ParentCITag</td>
<td>The token ID generated for the computer system on which this product is installed is assigned to the ParentCITag column in BMC. For details about the generated TokenID, see Appendix 1: Export of Computers on page 116.</td>
</tr>
<tr>
<td>SoftwareTitleID</td>
<td>ApplicationID</td>
<td>(Not stored.)</td>
<td>Used internally in data management.</td>
</tr>
<tr>
<td>FullName</td>
<td>ApplicationName</td>
<td>ShortDescription</td>
<td>By default, the full name of the application is the concatenation of the product, version, and edition fields (for example, “Microsoft Office Professional 2010”). However, an operator may overwrite this with any preferred value.</td>
</tr>
</tbody>
</table>
| (Generated ID) | FlexeraID | TokenID | FlexeraID is a unique identifier for application records used for unambiguous identification across various Flexera Software solutions. The format is either:

- For applications published in the FlexNet ARL, arl://MGS-APP-00000000000 (where the 11-digit number varies by application)

- For applications defined locally, app://serverGUID/LOCAL- |
<table>
<thead>
<tr>
<th>SoftwareTitle</th>
<th>ProductChanges</th>
<th>BMC_Product</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>APP-SoftwareTitleID (where serverGUID depends on the identity of the central application server, and SoftwareTitleID is the value of SoftwareTitleID assigned to this application). The result is presented as the TokenID in the BMC_Product table, and as SignatureID in the Product Catalog.</td>
</tr>
<tr>
<td>[SoftwareTitle Publisher] PublisherName</td>
<td>Publisher</td>
<td>ManufacturerName</td>
<td>Identifies the company that produces the application/product (for example, “Microsoft”). Extracted from SoftwareTitlePublisher. PublisherName via SoftwareTitleProduct. SoftwareTitlePublisherID, using SoftwareTitle. SoftwareTitleProductID as a foreign key.</td>
</tr>
<tr>
<td>[Compliance Computer] ComputerName</td>
<td>ApplicationToInstallation_ComputerName</td>
<td>SystemName</td>
<td>Name of the computing device reported in inventory (such as “vincent-ltp”). Extracted from ComplianceComputer. ComputerName using the foreign key InstalledSoftware. ComplianceComputerID. The view InstalledSoftware is itself linked to the application by the foreign key SoftwareTitleID.</td>
</tr>
<tr>
<td>ComputerID</td>
<td>InstallationToComputer_ComputerID</td>
<td>(Not stored.)</td>
<td>The computer identifier, extracted in much the same way as described for ComputerName. Used internally for data management.</td>
</tr>
<tr>
<td>[Compliance Connection] LastImportDate</td>
<td>InstallationToComputer_InventoryDate</td>
<td>(Not stored.)</td>
<td>The date of the most recent inventory collection that recorded the installation of this application on the current computer. When no other value is available, this defaults to the date of data export from FlexNet Manager Suite. Used internally for data management.</td>
</tr>
<tr>
<td>CategoryID</td>
<td>InstallationToApplication_Category</td>
<td>Category</td>
<td>First level of application categorization.</td>
</tr>
<tr>
<td>SoftwareTitle</td>
<td>ProductChanges</td>
<td>BMC_Product</td>
<td>Comments</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------</td>
<td>-------------</td>
<td>----------</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>The full path of categorization is extracted from the GroupEx table using SoftwareTitle. CategoryID as the foreign key. The full path is then broken up on its / separators, and the first level is passed to Category in the BMC_Product table.</td>
</tr>
<tr>
<td>CategoryID</td>
<td>InstallationTo Application_Category</td>
<td>Type</td>
<td>Second level of application categorization. (See Category for details.)</td>
</tr>
<tr>
<td>CategoryID</td>
<td>InstallationTo Application_Category</td>
<td>Item</td>
<td>Third level of application categorization. (See Category for details.)</td>
</tr>
<tr>
<td>Not applicable.</td>
<td>ViewID</td>
<td>(Not stored.)</td>
<td>Deprecated and not in use.</td>
</tr>
<tr>
<td>Not applicable.</td>
<td>TenantID</td>
<td>(Ignored.)</td>
<td>Always contains a zero value (a string of 16 zeroes) for an on-premises implementation.</td>
</tr>
<tr>
<td>Not applicable.</td>
<td>EvidenceVersion</td>
<td></td>
<td>Deprecated and not in use.</td>
</tr>
<tr>
<td>Not applicable.</td>
<td>“BMC_PRODUCT”</td>
<td>ClassID</td>
<td>A string literal that identifies the class in the BMC dataset.</td>
</tr>
<tr>
<td>Not applicable.</td>
<td>“CompanyName”</td>
<td>Company</td>
<td>A fixed value that must match the company identifier embedded in the Atrium CMDB.</td>
</tr>
<tr>
<td>Not applicable.</td>
<td>“DataSetID”</td>
<td>DataSetID</td>
<td>Value attached to the dataset considered. Must match the value embedded in the Atrium CMDB.</td>
</tr>
<tr>
<td>Not applicable.</td>
<td>FullName:VersionName</td>
<td>Name</td>
<td>Full name separated by a colon from the market version of the software product (for example, “Microsoft Office Professional:2010”).</td>
</tr>
<tr>
<td>Not applicable.</td>
<td>“ProductName:Version”</td>
<td>NameFormat</td>
<td>A string literal describing the format of the Name attribute.</td>
</tr>
<tr>
<td>Not applicable.</td>
<td>FullName on ComputerName</td>
<td>Description</td>
<td>Composite of the software name and device name (such as “Microsoft Office Professional 2010 on vincent-ltp”).</td>
</tr>
<tr>
<td>Not applicable.</td>
<td>“Deployed”</td>
<td>Status</td>
<td>A fixed value, since the records are extracted from the installed software listings.</td>
</tr>
<tr>
<td>Not applicable.</td>
<td>Calculated value</td>
<td>MarkAsDeleted</td>
<td>Boolean (0 = no, 1 = yes). Whether or not this product has been deleted from the computer system under consideration. Note that</td>
</tr>
</tbody>
</table>
## Appendix 3: Import of Assets

The following table shows:

- Columns from the `BMC_ComputerSystem` view (and `AST:ComputerSystem` form) in Atrium CMDB that are exported
- The equivalent column name in the `Assets` table of the intermediate database (in case you wish to inspect the dataset there)
- The matching columns in the FlexNet Manager Suite database where this information is imported.

<table>
<thead>
<tr>
<th>BMC_ComputerSystem</th>
<th>Assets</th>
<th>ComplianceComputer</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reconciliation Identity</td>
<td>Reconciliation Identity</td>
<td>Not stored.</td>
<td>Used internally to link the <code>BMC_ComputerSystem</code> view and <code>AST:ComputerSystem</code> form.</td>
</tr>
<tr>
<td>Domain</td>
<td>DOMAIN</td>
<td>[ComplianceDomain]</td>
<td>The domain extracted from BMC Atrium is processed to provide a dot-separated qualified name in the form <code>flexerasoftware.com</code>. The same value is processed again to provide a flat domain name (such as <code>flexerasoftware</code>). Where these values match existing entries in the <code>ComplianceDomain</code> table, no further action is taken with them (other than to return the <code>ComplianceDomainID</code> key); but where they are not already known, they are added to this table for use in FlexNet Manager Suite. As well, the <code>ComplianceDomainID</code> value returned from this update is then written into the <code>ComplianceComputer</code> record, which may update the domain for the current computer.</td>
</tr>
<tr>
<td>HostName</td>
<td>HostName</td>
<td>ComputerName</td>
<td>The name of this computer. Based on a matching <code>ComplianceComputerID</code>, this value may be over-written with the value imported from Atrium.</td>
</tr>
<tr>
<td><strong>BMC_ComputerSystem</strong></td>
<td><strong>Assets</strong></td>
<td><strong>ComplianceComputer</strong></td>
<td><strong>Comments</strong></td>
</tr>
<tr>
<td>------------------------</td>
<td>------------</td>
<td>------------------------</td>
<td>--------------</td>
</tr>
<tr>
<td>CITag</td>
<td>CITag</td>
<td>Compliance ComputerID</td>
<td>The identity for the computer record. Where this matches an existing record, its other columns may be updated. Otherwise, a new record is created for ComplianceComputer in FlexNet Manager Suite.</td>
</tr>
<tr>
<td>InstanceId</td>
<td>Not stored.</td>
<td>Deprecated and not in use.</td>
<td></td>
</tr>
<tr>
<td>ImportLog table</td>
<td>LastImportDate</td>
<td>Not stored.</td>
<td>Calculated from data in the ImportLog table.</td>
</tr>
<tr>
<td>[AST: ComputerSystem]</td>
<td>System Role</td>
<td>Custom property Role in the Details tab (User group) of the inventoried computer properties.</td>
<td></td>
</tr>
</tbody>
</table>
|                       |            | Both systems record roles for servers, but the FlexNet Manager Suite role has various licensing implications, and so is not updated by imports from Atrium. Instead, a read-only custom field is added to FlexNet Manager Suite to accept the asset role for each BMC_ComputerSystem. The role is displayed in the Details tab of the computer properties. Values include:  
|                       |            | • Lab  
|                       |            | • Development  
|                       |            | • SIT  
|                       |            | • UAT  
|                       |            | • Training  
|                       |            | • Performance  
|                       |            | • Contingency  
<p>|                       |            | • Production. |
| Reconciliation Identity |            | AssignedTo | The ID associated with ComplianceUser.UserName, written here to link the ComplianceComputer to the user record. |
| [AST: ComputerSystem]  | AssignedTo | AssignedUserID | The full name of the user assigned to this computer. FlexNet Manager Suite defaults to a concatenation of |
| Assigned To            |            |            | |</p>
<table>
<thead>
<tr>
<th>BMC_ComputerSystem</th>
<th>Assets</th>
<th>ComplianceComputer</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>title, first name, middle name, last name and suffix, so any of these parts may be present, based on the record in BMC Atrium. Where this matches an existing user record, no further action is taken with it; otherwise a new user record is created. In either case, the ID for this user is returned, and written into the AssignedUserID column. <strong>Tip</strong> • Beware of small changes in record data from Atrium causing near-duplicate records to represent the same person. Also note that when new records are created, you may wish to update additional details about this person in FlexNet Manager Suite.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>A translation of the BMC Atrium status values into the nearest equivalent status value supported in FlexNet Manager Suite. This is then mapped by the Business Importer into the correct ID for the status value before being written into the ComplianceComputer record.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>[AST: ComputerSystem] AssetLifecycle Status</td>
<td>AssetLifecycle Status</td>
<td>Compliance Computer StatusID</td>
<td></td>
</tr>
<tr>
<td>[AST: ComputerSystem] DNS Host Name</td>
<td>DNS Host Name</td>
<td>Not stored.</td>
<td>Host name from the BMC_ComputerSystem is used in preference to this one.</td>
</tr>
<tr>
<td>[AST: ComputerSystem] Domain</td>
<td>Domain_1</td>
<td>Not stored.</td>
<td>Domain from the BMC_ComputerSystem is used in preference to this one.</td>
</tr>
<tr>
<td>[AST: ComputerSystem] Instance Id</td>
<td>Instance Id</td>
<td>Not stored.</td>
<td>Used internally.</td>
</tr>
<tr>
<td>[AST: ComputerSystem] Data Set Id</td>
<td>Data Set Id</td>
<td>Not stored.</td>
<td>Used internally.</td>
</tr>
</tbody>
</table>
Part IV

Using the HPE Universal Discovery Adapter

Topics:

• Selecting a Configuration
• Installation and Configuration
• Operation and Validation

You can use the HPE Universal Discovery (HPE-UD) adapter tool to collect and import inventory data from HPE Universal Discovery System to FlexNet Manager Suite. The HPE-UD adapter fetches all hardware, software, and virtualization information from the HPE-UD system and stores it in the compliance database maintained by FlexNet Manager Suite. The HPE-UD adapter support is available only with FlexNet Manager Suite version 2015 and later.

Note: The HPE-UD adaptor tool works only with version 10.10 and 10.11 of the HPE Universal Discovery System. These versions do not support Solaris 11 zones, for which reason the HPE-UD adapter cannot import these zones. Since host serial number and zone name are used for rationalizing duplicate inventory records across different inventory sources, this may mean that a device imported through the HPE-UD adapter cannot be merged with another record of the same device imported through another inventory source that supports zones information.
Selecting a Configuration

Topics:

- Architecture and Working of the HPE Universal Discovery Adapter
- The Adapter Executable

This chapter gives an overview of the architecture, working, and configuration of the HPE-UD adapter. Choose the appropriate configuration for your enterprise before you implement the adapter.
Architecture and Working of the HPE Universal Discovery Adapter

The HPE-UD adapter architecture has the following main components:

- **HPE-UD Server**: This server has the HPUD uCMDB database and HPE discovery tools installed on it. The HPUD uCMDB database stores the HPE-UD inventory details.

- **Staging Server**: This server contains the Flexera HPuCMDBStage.exe tool and a staging database. The HPuCMDBStage.exe tool retrieves topology maps by executing TQL queries on HPUD uCMDB. The retrieved topology maps are stored in a staging database (uCMDB_Staging) present on the staging server. The query execution is performed using the web service interface of HPUD uCMDB.

- **FlexNet Manager Suite**: The Compliance Reader component residing on this server fetches data from the staging database and loads it into the FlexNet Manager Suite database when you run an inventory import.

The following diagram shows the architecture and working of the HPE-UD adapter:

![Architecture Diagram](image)

**Figure 5: Architecture and working of the HPE-UD adapter**

1. The HPuCMDBStage.exe tool extracts the inventory information through the web API of HPUD uCMDB. This tool executes Topology Query Language (TQL) queries on the HPUD uCMDB database and retrieves responses in the form of topology maps. With the default configuration, this tool stores the retrieved topology maps directly into the staging database without storing them in XML files. However, you can configure this tool to write the retrieved topology maps to XML files and then write data from those XML files to the staging database.

   **Note**: One topology map is generated for each TQL query executed on HPUD uCMDB.

2. The Compliance Reader component of FlexNet Manager Suite collects data from the staging database. When you run an inventory import on the FlexNet Manager Suite server, the data extracted from the staging database is written to the compliance database on the application server.

The Adapter Executable

HPE Universal Discovery (HPE-UD) adapter uses the ucmdb-api to obtain the version of the uCMDB instance. It uses the UcmdbService web service API to retrieve the topology maps by executing TQL queries on the uCMDB.
instance. You can retrieve the WSDL definition of the `UcmdbService` web service API from `http://<uCMDB Server>/axis2/services/UcmdbService?wsdl`. The configuration of the staging tool includes the TQL queries that will be executed on the HPUD `uCMDB` database. You don't have to import the TQL queries into the HPUD `uCMDB` database and there is no need to deploy and maintain the TQL queries on every HPE-UD instance of your enterprise.

**Note** • The URL to retrieve the WSDL definition of the `UcmdbService` web service API may use 'https' instead of 'http'. It may also include a port number. Please check with your HPE-UD system administrator for more details on the web service URL.

The tool to query the web API has the following two parts:

- **HPuCMDBStage.exe** — A console program capable of querying the `UcmdbService` API of HPE-UD and writing the results into an SQL Server database, and optionally to XML files on the local file system. This program supports command line arguments, available using `HPuCMDBStage.exe -h`. Here is the list of available command line options.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-h</td>
<td>This help</td>
</tr>
<tr>
<td>-x &lt;settings file&gt;</td>
<td>Settings file</td>
</tr>
<tr>
<td>-s &lt;address or URL&gt;</td>
<td>uCMDB server address or URL</td>
</tr>
<tr>
<td>-u &lt;user name&gt;</td>
<td>uCMDB export user name</td>
</tr>
<tr>
<td>-p &lt;password&gt;</td>
<td>uCMDB export user password</td>
</tr>
<tr>
<td>-c &lt;connection string&gt;</td>
<td>SQL Server staging database connection string</td>
</tr>
<tr>
<td>-m &lt;staging method&gt;</td>
<td>Set staging method (stage/staged/prestaged/stream)</td>
</tr>
<tr>
<td>-f &lt;staging file path&gt;</td>
<td>Set the staging file path</td>
</tr>
</tbody>
</table>

- **FNMPuCMDBSettings.xml** — The self-documenting configuration file for `HPuCMDBStage.exe` which contains TQL queries executed against HPE-UD, and can include connection settings for HPE-UD and SQL Server.

In operation, the executable, `HPuCMDBStage.exe`, extracts the inventory data from HPE-UD and saves it for further processing. The value of the `method` parameter determines how the data is saved. The `method` parameter can have the following values:

- **Stage** — This option enables you to save inventory data from HPE-UD to a series of XML files on the staging server (HPE-UD to XML). The XML files are not imported into the staging database, but you can review the extracted inventory data. This option also enables you to collect inventory data from the HPE-UD servers that are not directly connected to the staging server. You can manually copy and upload the inventory XML files to the staging server. Also see the **Prestaged** method below.

- **Staged** — This option enables you to write the data extracted from the HPE-UD servers to XML files and then copy the information to the staging database (HPE-UD to XML/SQL) where it can be imported into FlexNet Manager Suite for use in compliance calculations.

- **Prestaged** — This option takes information stored in XML files (from the Stage and Staged method) and loads it into a staging SQL database (XML to SQL). Inventory is not gathered from HPE-UD in this mode.

- **Stream** — This option enables you to extract the inventory information from HPE-UD and load it into the staging database directly, without storing it in XML files on the staging server (HPE-UD to SQL). You can import these files into FlexNet Manager Suite for use in compliance calculations.

You can set the default values for the `method` parameter and all other parameters in the `FNMPuCMDBSettings.xml` file. The adapter tool uses the default parameter values when you use it without other
command-line options. The settings file is self-documented and the matching command-line options are available using `HPuCMDBStage.exe -h`.

**Files Created by the Staging Tool**

The following files are created when the staging tool performs a read/write operation on the local disk of the staging server. You can view the contents of the following files to review HPE-UD configuration item details that have been extracted.

<table>
<thead>
<tr>
<th>Filename</th>
<th>Content</th>
</tr>
</thead>
<tbody>
<tr>
<td>Computer.xml</td>
<td>Details of computers and their properties.</td>
</tr>
<tr>
<td>Virtualization.xml</td>
<td>Virtualization and partitioning details.</td>
</tr>
<tr>
<td>InstalledSoftware.xml</td>
<td>Installed software evidence linked to each computer.</td>
</tr>
</tbody>
</table>
2

Installation and Configuration

Topics:

• Download Adapter Tools Archive
• Selecting a Staging Server
• Creating the Staging Database Tables
• Configuring HPE Universal Discovery System
• Installing and Configuring the Staging Tool

For on premises implementations, the adapter XML files are included as a part of the FlexNet Manager Suite installation. You need to download the staging tool, the configuration file, and the staging schema for this tool from https://flexerasoftware.flexnetoperations.com, or from the Flexera Software Customer Community.

You need credentials supplied by Flexera Software to access this download. Details of the download are included in Download Adapter Tools Archive on page 133.

• The HPE-UD adapter suits FlexNet Manager Suite releases 2015 and later for on premises delivery.

• The build number for this adapter is 10.3.0.12006 (or higher). You can identify this number by right-clicking the HPuCMDBStage.exe file in Windows Explorer, selecting Properties, and looking at the Details tab.

Save the zipped archive to a suitable temporary location, and unzip it.

Full details of setting up the HPE-UD adapter are included in this chapter. The following chapter (see HPE-UD Adapter Operation on page 139) covers testing the completed installation and validating the results.
Download Adapter Tools Archive

The Adapter Tools archive includes content for many adapters, and is updated on the Flexera Software website from time to time.

Start this procedure using a web browser on a computer that has good network accessibility from all the machines needing installations for your adapter.

1. Do either of the following:
   - Download the Adapter Tools for FlexNet Manager Suite 2016 R1.zip archive from the Flexera Software Product and License Center:
     a) Using the credentials supplied by Flexera Software with your order confirmation (or as renewed since), log into https://flexerasoftware.flexnetoperations.com.
     b) On the first page, select FlexNet Manager Platform, and on the resulting second page, select the product again.
     c) In the list of versions, click the product name for the version you are using (typically the most recent version).
     d) In the list of components to download, select the Tier 1 Adapter Tools.zip archive, and save this to a convenient location (such as C:\Temp on a central, accessible server).
   - Download the Adapter Tools for FlexNet Manager Suite 2016 R1.zip archive from the Flexera Software Customer Community knowledge base:
     Tip • Access requires your Customer Community user name and password. If you do not have one, use the link on the login page to request one.
     b) Take note of the password identified within that article, at the end of the Synopsis.
     c) Click the link Adapter Tools for FlexNet Manager Suite.
        In a new browser tab, when you provide the required password, the download of Adapter Tools for FlexNet Manager Suite 2016 R1.zip commences from the Flexera Software account at box.com.
        d) In your browser dialog, choose to save the file, and if the browser allows it, direct the saved file to a convenient working location (such as C:\Temp on a central, accessible server).
           If your browser saves the file to a default location (such as your Downloads folder), move or copy it to the appropriate working location when the download is finished.

2. Right-click the zip archive, and choose Extract All....

The folders are now available for the range of adapters in the Adapter Tools archive.
Selecting a Staging Server

Multiple configuration options are there to configure the staging server. You can install the staging server on any of the following types of computers:

- A dedicated stand-alone server or a virtual machine.
- Any other suitable machine in your enterprise, such as a print server.
- An inventory beacon.
- The central application server where FlexNet Manager Suite is installed.

The following are the requirements for a staging server:

- Microsoft Windows 2008 or later.
- Access to an instance of Microsoft SQL Server 2008 or later to host the staging database. You can implement the staging database on the staging server or on a separate database server.
- Microsoft .NET 4.0 run time environment installed.
- Efficient network access to each HPE-UD server in your enterprise, using the HTTP or HTTPS protocols.

Creating the Staging Database Tables

Once your selected staging server is able to access the Microsoft SQL Server instance, you can use the provided script to create the staging database and set up the appropriate database tables. You can achieve this through SQL Server Management Studio or from the command line as described in the following procedure:

1. Download and install the Adapter Tools archive. For more information, see Download Adapter Tools Archive on page 133.
2. Navigate through the unzipped archive to Adapter Tools > HP Universal Discovery Tools > SQL.
3. If necessary, copy the script uCMDB_staging.sql from the SQL\ folder of your unzipped adapter archive to a temporary folder on your staging server.
4. Open a command prompt on the staging server.
5. In the command prompt window, execute the following command, as amended:

   `sqlcmd -S ServerName\InstanceName -i TemporaryPath\uCMDB_staging.sql`

   where:

   - The database uCMDB_staging is created with all necessary tables, indices, and so on.
   - `ServerName` is the name of the server hosting the SQL Server 2008 or later. You can install the database on the staging server or on any remote server. You can use the name of the staging server or its IP address, or a "." (dot) if you are running the staging script on the same server as the database instance.
   - `InstanceName` is the name of the database instance to use for the database staging tables. You can omit this parameter if the default instance name is being used.
Installation and Configuration

- **TemporaryPath** is the location where you saved the SQL procedure.

Example:

```
sqlcmd -S 192.100.0.20\Development -i C:\temp\uCMDB_staging.sql
```

The staging database is now ready for operation.

## Configuring HPE Universal Discovery System

You must configure the HPE-UD adapter settings to include a user which can perform the Run Legacy API and the Run Query by Definition actions on the HPE-UD system. The following are the steps to create and configure a user in HPE-UD:

1. In the HPE-UD interface, click **Security, Roles Manager**.
2. Create a new role for FlexNet Manager import.
3. Select the role that you just created and click **General Actions** and assign the Run Query By Definition and the Run Legacy API actions to this role.
4. In the HPE-UD interface, click **Security, Users and Groups**.
5. Create a new user for FlexNet Manager import.
6. Click the **Roles** tab and assign the role that you created in Step 2 to this user.
7. Click the **Permissions Overview** tab and review the assigned permissions for this role.
8. Click **Data Flow Management, Universal Discovery, Zone-Based Discovery** and expand the **Mapping Options** section in **Preferences**.
9. Check the **Raw OS Installed Software** and set the **Include** option to `name=.*`. This enables HPE-UD adapter to capture all raw installation evidence.

You have created and configured an HPE-UD user for use in the HPE-UD staging tool. You must add this user to the **FNMPuCMDBSettings.xml** file.

## Installing and Configuring the Staging Tool

This procedure includes many separate sub-processes to complete the setup of the HPE-UD adapter. The following are the steps to install and configure the HPE-UD adapter:

1. Ensure that the account under which the adapter executable will run has read/write/execute permissions on this **uCMDB_staging** database. Authentication may be through Windows authentication or SQL Server authentication. Using Windows authentication, the default account is the username running the **HPuCMDBStage.exe** adapter. The username and password for SQL Server authentication are specified in the database connection string, which you may supply in **FNMPuCMDBSettings.xml**, or override with the `-c` option on the command line.
2. To extract information from the HPE-UD system, the **HPuCMDBStage.exe** tool must have the required permissions to query the HPE-UD system. You must create a user in the HPE-UD system and assign it with permission to perform the Run Legacy API and the Run Query by Definition actions. You must specify this
user in the FNMPuCMDBSettings.xml file. For more information on configuring the HPE-UD system, see Configuring HPE Universal Discovery System on page 135.

3. Navigate to the fixed location on the inventory beacon where the inventory reader must find configuration files to control its uploads. Verify the existence of the following path: C:\ProgramData\Flexera Software \Compliance\ImportProcedures\Inventory\Reader\HP Universal Discovery.

4. Create a folder to contain the adapter executable and its configuration file. Location is not critical; a suggested path is under C:\Program Files\Flexera Software (for version 2015 and later, or for a stand-alone server that is not an inventory beacon or application server). In your chosen location, create a folder such as HPUDAdapter.

5. From the HPuCMDBStage\ folder within your unzipped archive, copy both HPuCMDBStage.exe and FNMPuCMDBSettings.xml to your newly created folder (such as C:\Program Files\Flexera Software\HPUDAdapter).

6. Open your copy of FNMPuCMDBSettings.xml in a text editor of choice, and review the self-documenting comments within that file. Modify the following values as required. Ensure that you specify the IP address of your HPE-UD server. You can use the command line options to configure HPuCMDBStage.exe. Use the ‘-h’ option to get the list of available options.

   • Update values in the first element describing the downstream connection to the HPE-UD server, including the IP address, port, the account name and password for access. Keep a record of the account name and password for registering with HPE-UD. The default values are:

   ```xml
   <server protocol="http" address="10.200.20.138" port="8080" username="exportuser" password="Pa$$w0rd" timeout="3600"/>
   ```

   **Tip** • If you do not wish to record the password in the plain text configuration file, you can use a script to retrieve the password from an encrypted store, and supply it as a command-line option when starting the HPuCMDBStage.exe tool. Here is an example:

   ```bash
   HPuCMDBStage.exe -p <password>
   ```

   • Update the second element for the connection to the staging database. The default values are:

   ```xml
   <database connection-string="Server=.;Database=uCMDB_Staging;Trusted_Connection=yes;"/>
   ```

   • Update the third element to configure whether, and where, the executable should save XML files of the inventory collected from HPE-UD. The default value stores any XML files below the location of the executable: <staging path="StagingData" method="stream"/> You may wish to redirect the path setting for easier access for human inspection.

   • Make sure that the user details in the <Server> section match with the user configured in the HPE-UD system.

   • Save the settings file.

7. Validate the HPE-UD adapter operation. For more information about validating the adapter, see Validating the HPE-UD Adapter on page 139.

8. Assuming that you do not wish to trigger the adapter manually every time it needs to run, start Windows Task Scheduler, and create a basic task to run the adapter.
Important • It is suggested that you schedule the adapter to run at times which cannot overlap with the inventory reader uploading the results to the application server. Check the schedule for the compliance reader on the central application server, and avoid this time slot.

By default, the inventory import (starting with the reader) is triggered around 2 am. Therefore you might consider scheduling this task for some time such as 10 pm daily. The command line for the scheduled task (assuming that you have saved your preferred settings) is simply to invoke the executable. Any parameters not specified on the command line are taken from the settings file in the same folder as the executable. Here is an example:

HPuCMDBStage.exe -x <settings file>

This completes the configuration of the adapter executable.
3

Operation and Validation

Topics:

- HPE-UD Adapter Operation
- Validating the HPE-UD Adapter

This section describes the normal operation of HPE-UD adapter and also lists the steps to validate its operation. This section has the following tasks:

- HPE-UD Operation: See *HPE-UD Adapter Operation* on page 139
- Validating the HPE-UD Adapter: See *Validating the HPE-UD Adapter* on page 139
HPE-UD Adapter Operation

Normal operation of the HPE-UD adapter relies on the following sequence of events:

1. According to the scheduled instructions, the adapter reads the current content of the HPE-UD database and stages the new data in the staging database after removing the previously stored data. A flag stored in the staging database indicates the status of the data extraction. The resulting status is flagged within the database. For more information on installing and configuring the staging tool, see Installing and Configuring the Staging Tool on page 135.

2. Following the schedule on the central application server, and provided that the staging status is Success, the import reader uploads this content to the inventory database.

3. The next compliance import brings the final data set into the compliance database, where it is automatically taken into account for compliance calculations. As always, for compliance calculations to proceed, the inventory records must be recognized by the Application Recognition Library, and you must have the resulting application records linked to the appropriate license.

Validating the HPE-UD Adapter

To validate the adapter operation:

1. Manually trigger the adapter executable. You can specify a value for the method parameter if you need to override the default settings set in the settings XML file. For example:

'C:\Program Files\Flexera Software\HPUD\HPuCMDBStage.exe' -f 'C:\temp' -m staged

This will write XML files under your C:\temp directory for review. It will also write data into the staging database.

2. Inspect the saved XML files to validate the inventory gathered.

3. Use SQL Server Management Studio to validate that the data is written to the staging database. Also review the StagingState property in the uCMDBStagingDatabaseConfiguration table in the staging database. Possible values are Running, Failed, or Success. This value must be Success before the HPE-UD data can be uploaded from the staging database to the central inventory database.

4. Wait until the next inventory import and calculations have run. You might have to wait overnight for this.

5. Use FlexNet Manager Suite to validate that new evidence has been recovered. Identify which evidence has been recognized by the ARL and which new rules are required. Link the applications to appropriate licenses.
Oracle Enterprise Manager monitors and manages other Oracle software installed on customer sites. Therefore it is a useful aid in gathering inventory from Oracle systems.

The Oracle Enterprise Manager (OEM) adapter, from Flexera Software, connects to Oracle Enterprise Manager, and extracts a file of connection information for the Oracle systems it monitors. This file is in a standard format (TNSNames.ora) used by Oracle. (In fact, if you already have files of the same name generated by Oracle, you can simply copy these to the appropriate folder on an inventory beacon. This may be a viable alternative to using this adapter.)

When the file is saved to a special location on an inventory beacon (and the inventory rules for this inventory beacon allow processing of TNSNames.ora files), the connection information in it can be used by FlexNet Manager for Oracle, a separately-licensed product within FlexNet Manager Suite, to collect software inventory information. This document covers the set up and configuration to use the adapter as part of an Oracle inventory solution.

**Terminology**

Throughout, the Flexera Software adapter is referred to as the **OEM adapter**. The database for Oracle Enterprise Manager (to which the OEM adapter connects) is referred to as the **OEM repository**.
As well as providing a functional overview of the straight-forward OEM adapter itself, this chapter provides additional background about the other aspects of your system that collaborate to provide Oracle introspection and inventory reporting. As well, this chapter covers the prerequisites, content, and delivery of the OEM adapter.
How the Adapter Assists in Inventory Gathering

The OEM adapter provides an alternative or additional method of discovering Oracle database servers in your computing estate. Discovery (by one means or another) is a prerequisite for collecting software inventory from the Oracle servers.

The OEM adapter is installed on a convenient computer that has network access to Oracle Enterprise Manager and its OEM repository. Typically, this computer may be a FlexNet Beacon. Multiple instances of the OEM adapter may be installed (on one or more computers), each of which can connect with one instance of Oracle Enterprise Manager.

Numbers in the diagram (where "OEMA" identifies the OEM adapter) correspond to the process description below:

1. The Windows scheduled task triggers the OEM adapter, which contacts its instance of Oracle Enterprise Manager, and collects the connection data from the OEM repository.
2. The OEM adapter formats the data into a TNSNames.ora file, and saves it to a special location on the inventory beacon.

You may configure the name of the saved file, and, if multiple instances of the OEM adapter save files to the same inventory beacon, you must modify the file names so that the files do not overwrite each other.
Understanding the Oracle Enterprise Manager Adapter

Note • This completes the function of the OEM adapter. The remainder of the process is standard operating procedure for FlexNet Manager Suite with the FlexNet Manager for Oracle product installed. If you already have an operational system, several of these steps may already be completed.

3. You set up a special account with read-only permissions on your Oracle database for all the tables and views needed for Oracle introspection. One helpful practice is to use the same purpose-driven set of credentials on all servers. A utility is available to help created the account(s) required with the correct permissions.

4. The same credentials must be recorded in the Password Store on each of the relevant inventory beacons.

5. In the web interface for FlexNet Manager Suite, you define a subnet (or several subnets) that contain the Oracle database servers of interest; and you assign to these subnet(s) the inventory beacon(s) where the TNSNames.ora files are being saved. (Assignments are distributed automatically to inventory beacon(s), along with rules.)

6. Continuing n the web interface, you create a rule with an action including Oracle inventory collection, with the option to use TNS name file selected. The rule also has a target which matches the subnet(s) you are interested in. This rule is automatically distributed to inventory beacon(s).

7. On the inventory beacon(s) of interest:
   a) The rule and assignment are received.
   b) The inventory beacon assesses these, concludes that it is authorized to act, and looks for a any *.ora file(s) in the special path on the inventory beacon.
   c) For any Oracle server which is both within the authorized subnet and listed in the .ora file, the inventory beacon checks for credentials in its Password Store, and tests them (from the most closely matching to the most general) until either one gets a response (success), or there are no further applicable credentials (failure).
   d) When successfully logged in, the FlexNet inventory agent running on the inventory beacon, uses the credentials to read the data necessary for Oracle introspection. It writes the data as an Oracle inventory file into its staging folder.
   e) Within a minute of completion, the regular upload process starts moving this inventory file to the central application server (or, in a multi-server installation, the inventory server).

8. After the next inventory import and resulting consumption calculations, the Oracle inventory is available in the web interface for FlexNet Manager Suite; and the Oracle servers originally identified in the TNSNames.ora file are visible in the All Discovered Devices listing, displaying Yes in the Oracle column.

Prerequisites for the OEM Adapter

The OEM adapter must be installed on a computer with network access to Oracle Enterprise Manager, and requires read access to certain tables and data views there (the required permissions are listed in Grant Permissions to Account on page 151).

The OEM adapter requires that, on the computer where it will execute, the Oracle client version 12.1 is installed. Only the 32-bit version is supported: even for a Windows 64-bit computer, use 32-bit ODAC 12c Release 1 (12.1.0.1.0).
To take advantage of the information gathered by the OEM adapter, there are also the following requirements on the remainder of the system. Once the OEM adapter saves a `TNSNames.ora` file, the subsequent gathering of Oracle inventory requires that:

- The FlexNet inventory agent can access each Oracle system. This can be achieved either by installing the FlexNet inventory agent on the target Oracle server(s), or by remote execution (zero touch inventory gathering).
- You have FlexNet Manager for Oracle, a separately licensed product within FlexNet Manager Suite.

**Tip**

You can check whether your implementation has this product licensed in the web interface for FlexNet Manager Suite:

1. Navigate to the system menu ( aç in the top right corner) > **FlexNet Manager Suite License**.
2. Check the list of **Subscribed and purchased products** on the right, looking for a card for FlexNet Manager for Oracle. If the card is present, you have this product licensed.

## Components

The OEM adapter is supplied as an installer, called `OEMAdapter.exe`, which installs the following:

- OEM adapter executable and dependencies
- OEM adapter configuration file
- OEM adapter scheduled task, which can be created during installation if desired.

## Download Adapter Tools Archive

The Adapter Tools archive includes content for many adapters, and is updated on the Flexera Software website from time to time.

Start this procedure using a web browser on a computer that has good network accessibility from all the machines needing installations for your adapter.

1. Do either of the following:
   - **Download the Adapter Tools for FlexNet Manager Suite 2016 R1.zip archive from the Flexera Software Product and License Center:**
     - a) Using the credentials supplied by Flexera Software with your order confirmation (or as renewed since), log into [https://flexerasoftware.flexnetoperations.com](https://flexerasoftware.flexnetoperations.com).
     - b) On the first page, select **FlexNet Manager Platform**, and on the resulting second page, select the product again.
c) In the list of versions, click the product name for the version you are using (typically the most recent version).

d) In the list of components to download, select the Tier 1 Adapter Tools.zip archive, and save this to a convenient location (such as C:\Temp on a central, accessible server).

• Download the Adapter Tools for FlexNet Manager Suite 2016 R1.zip archive from the Flexera Software Customer Community knowledge base:


  Tip • Access requires your Customer Community user name and password. If you do not have one, use the link on the login page to request one.

  b) Take note of the password identified within that article, at the end of the Synopsis.

  c) Click the link Adapter Tools for FlexNet Manager Suite.

  In a new browser tab, when you provide the required password, the download of Adapter Tools for FlexNet Manager Suite 2016 R1.zip commences from the Flexera Software account at box.com.

  d) In your browser dialog, choose to save the file, and if the browser allows it, direct the saved file to a convenient working location (such as C:\Temp on a central, accessible server).

  If your browser saves the file to a default location (such as your Downloads folder), move or copy it to the appropriate working location when the download is finished.

2. Right-click the zip archive, and choose Extract All....

   The folders are now available for the range of adapters in the Adapter Tools archive.
Installing the OEM adapter

Other Setup Activities

This chapter covers the fairly simple process of installing the OEM adapter. However, once installed, the OEM adapter is only a small part of gathering Oracle database inventory. Therefore the remainder of this chapter assumes a fairly new implementation of FlexNet Manager Suite, and introduces the other kinds of set up necessary for a working system of Oracle introspection. Some of the latter may already be in place within your enterprise.
Installing the OEM adapter

The OEM adapter is normally installed on an inventory beacon that has high-speed network access to the Oracle server to which the adapter must connect. It is possible to install multiple instances of the OEM adapter on the same computer, each configured to access a different OEM repository. Each instance of the OEM adapter can access exactly one OEM repository.

1. From the unzipped Adapter Tools archive, navigate into the Oracle Enterprise Manager Adapter folder.
   For details about downloading the archive, see Download Adapter Tools Archive on page 133.

2. In Windows Explorer, execute the OEMAdapter.exe installer from that folder.
   If this is the first installation of the OEM adapter on this computer, the welcome page appears, and you can click Next. If another instance of the OEM adapter is already installed on this computer, the following screen appears.

   ![Oracle Enterprise Manager Adapter - InstallShield Wizard](image)

3. If this page appears, choose either of the following:
   a) For an additional installation, click Install a new instance, and click Next. Follow the remaining instructions below.
   b) To change one of the instances previously installed, select the instance from the list on this page, click Maintain or upgrade an existing instance, and click Next.

   The Customer Information page appears.
4. Identify the license owner, and the enterprise name, in the **User Name** and **Organization** fields respectively.

5. Provide credentials for the Windows scheduled task that triggers operation of the OEM adapter.

   **Tip** • *This account need not be the same as the one to access the OEM repository (identified in a later page).*

   Leave the fields blank to run the scheduled task as the local `SYSTEM` account on this computer.

   **Note** • *To change timing or frequency of the scheduled task, use the Microsoft Windows facilities as usual. They are not configurable through the installer.*

6. Click **Next >**.

   The **Destination Folder** page appears.

7. Optionally, click **Change...** to modify the supplied installation location.
**Note** • If you are installing multiple instances of the OEM adapter on this computer, you must modify the path so that each is installed in a separate folder. The InstallShield wizard offers the default folder 0 for the first instance. Increment this value to give a unique folder for each instance.

---

**Important** • By default the OEM adapter saves the .ora file in the directory where it is executing (that is, the one you specify here). This is useful as a holding bay where the files may be manually inspected for initial testing/verification; but no automated processing of the .ora files occurs from this location. For automated operation after initial testing, you must reconfigure the file path and name as described in Configure Data Staging on page 163.

8. When satisfied with the location, click **Next >**. The **Database Connection Information** page appears.

9. If necessary, confer with your Oracle DBA to complete details about the Oracle database from which this instance of the OEM adapter collects inventory:

   a) In the **Host** field, identify the server where Oracle Enterprise Manager is installed.

   b) The **Port** is used by the OEM adapter to access Oracle Enterprise Manager.

   c) **Service Name** identifies the Oracle service (for this database instance) that was defined when Oracle was installed.

   d) **UserID** is the account name (with its related **Password**) accepted by Oracle Enterprise Manager for login by the OEM adapter.

      **Suggestion**: FNMS-OEMadapter.

   When satisfied, click **Next >**, and the **Email Configuration** page appears.
10. To receive email alerts when the OEM adapter encounters any errors:
   a) Enter your email address as the To Mail value.
   b) In From Mail, enter the email address from which the error alerts should come.
   c) In the SMTP field, enter the fully qualified domain name (or IP address) of the email server.

   Tip • Ensure that the To Mail and From Mail addresses are both recognized by this email server.

   a) Click Next >.

   The Ready to Install the Program page appears.

11. When satisfied, click Install.

   The installer writes the OEM adapter executable (OEMAdapter.exe) into your chosen folder, and records your other settings in a configuration file (OEMAdapter.exe.config) saved in the same folder. It also creates a scheduled task to run the OEM adapter. To allow for multiple instances of the OEM adapter on the same computer, the scheduled tasks are named based on the numbering of the installed instances. The default scheduled task for the initial installation on a computer looks like this:
You may update the scheduled task(s) as usual through the Microsoft interface.

Before using the OEM adapter in production, you must also do all of the following:

- Confirm that the account used to access Oracle Enterprise Manager (suggested name `FNMS-OEMadapter`) has adequate permissions to read from the OEM repository (see **Grant Permissions to Account** on page 151)
- Modify the location where the `.ora` file is saved for production use (see **Configure Data Staging** on page 163)
- Ensure that the appropriate subnets containing target Oracle servers are identified and assigned to the inventory beacon where the `TSNNames.ora` file is saved (see **Assign Beacon to Subnet** on page 156)
- Configure the collection of Oracle inventory in the web interface for FlexNet Manager Suite (see **Configure Collection of Oracle Inventory** on page 157)
- Set up accounts on each Oracle server with adequate permissions to gather inventory, with target machines being based on the contents of the `.ora` file created by the OEM adapter (see **Inventory-Gathering Accounts on Oracle Servers** on page 153)
- Register the same account(s) in the Password Store for each relevant inventory beacon (see **Save Inventory Account in Password Store** on page 156).

## Grant Permissions to Account

Allow adequate access to the OEM repository.

The account used to access Oracle (suggested name `FNMS-OEMadapter`) must have adequate permissions to read from tables the OEM repository. If you are setting up multiple instances of the OEM adapter, repeat the process for each instance (you may be using a common account name for all of them to access each distinct OEM repository, or providing each with a unique account name). This task is normally completed by an Oracle DBA.

There are two possible ways to provide appropriate permissions:
1. Either: Make the account (suggested name FNMS-OEMadapter) a member of the EM_ALLVIEWER role; or
2. Give the account read permissions on the following:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target views</td>
<td>• MGMT_Targets</td>
</tr>
<tr>
<td></td>
<td>• MGMT_TARGETS_LOAD_TIMES</td>
</tr>
<tr>
<td></td>
<td>• MGMT_TARGET_TYPES</td>
</tr>
<tr>
<td>Target properties views</td>
<td>• MGMT_Targets</td>
</tr>
<tr>
<td></td>
<td>• MGMT_TARGET_PROPERTIES</td>
</tr>
</tbody>
</table>

3. When permissions have been set up, test as follows:
   a) Log in using the account name (suggestion: FNMS-OEMadapter) and password registered during the installation process.
   b) Execute the following query against the OEM repository:

   ```sql
   SELECT * from mgmt$Target
   ```

   Note the number of rows returned.
   c) Log out, and log in using a DBroot account (or other account known to have full permissions); and repeat the same query.

   The same number of rows should be returned by the root account with full permissions, and by the account for the OEM adapter with more limited and specific permissions.

4. Repeat the process and testing for any further instances of the OEM adapter accessing other distinct instances of OEM repository.

Other Setup Activities

The OEM adapter is relatively straight-forward, and, as triggered by the Windows scheduled task set up during installation, regularly collects data from Oracle Enterprise Manager and saves the data as a TNSNames.ora file in a special location on the inventory beacon.

However, by itself, when the goal is to gather inventory from Oracle database servers, the TNSNames.ora file is just the first step. Many other 'cogs in the machine' need to do their part for the .ora file to be beneficial:

- You need a defined set of sites and subnets, most easily obtained by Active Directory import through an inventory beacon.
- The subnet(s) containing your Oracle servers of interest must be assigned to the inventory beacon that collects the TNSNames.ora file, and which subsequently collects the Oracle inventory (see Assign Beacon to Subnet on page 156).
- An inventory rule must be defined that associates the target subnet with an action including inventory collection using the TNSNames.ora file, and schedules its execution (see Configure Collection of Oracle Inventory on page 157).
• Quite separately from the account that queries the OEM repository to create the TNSNames.ora file, one or more separate accounts must be defined that connect to the Oracle database servers and collect the inventory data. There are two parts to configuring these accounts:

• The accounts must be created and given adequate permissions on each Oracle database server (there is a utility available to assist with this, as described in Inventory-Gathering Accounts on Oracle Servers on page 153)

• The same accounts must be registered in the Password Store on the inventory beacon (see Save Inventory Account in Password Store on page 156).

Strictly speaking, none of these are part of the OEM adapter; but all are integral to the process of Oracle introspection, and therefore are at least summarized in the following sections.

Inventory-Gathering Accounts on Oracle Servers

The inventory beacon collects inventory from Oracle servers using accounts that must be registered at both ends. This process sets up the inventory-gathering accounts on the Oracle servers.

1. Using your credentials supplied as part of order confirmation/fulfillment, log in to the Flexera Software knowledge base available through the Support pages of the Flexera Software website, and access the following knowledge article:


2. Scroll to the bottom of the article, and click the link CreateOracleAuditUserQ200934.sql. This downloads a SQL script that an Oracle DBA can review. (Ignore the text content which is for earlier products.)

3. In a flat text editor, modify lines 8 and 9 of the script, replacing the default user name and password with credentials of your choosing; and save the modified script.

   To minimize configuration and maintenance effort, the same credentials can be implemented on each Oracle database server. Keep a note of these credentials, as you must also record them in the Password Store on the inventory beacon.

4. An Oracle DBA can run the script on each target Oracle database server.

   This (re)creates the user name on each run, and grants read access to a numbers of tables and views (shown below) that are required for Oracle database introspection.

The downloaded SQL script gives the account read-only access to the following tables and views:

• applsys.fnd_app_servers
• applsys.fnd_nodes
• applsys.fnd_product_installations
• applsys.fnd_application_tl
• applsys.fnd_user
• applsys.fnd_responsibility
• apps.fnd_user_resp_groups
• SYS.DBA_USERS
• SYS.V_$PARAMETER
• SYS.V_$INSTANCE
• SYS.V_$DATABASE
• SYS.V_$OPTION
• SYS.DBA_FEATURE_USAGE_STATISTICS
• SYS.DBA_ENCRYPTED_COLUMNS
• SYS.DBA_TABLESPACES
• ODM.ODM_MINING_MODEL
• ODM.ODM_RECORD
• DMSYS.DM$OBJECT
• DMSYS.DM$MODEL
• DMSYS.DM$P_MODEL
• DVSYS.DBA_DV_REALM
• LBACSYS.LBAC$POLT
• OLAPSYS.DBA$OLAP_CUBES
• SYS.DBA_AWS
• SYS.DBA_SEGMENTS
• SYS.DBA_CUBES
• SYS.GV_$INSTANCE
• SYS.GV_$PARAMETER
• MDSYS.ALL_SDO_GEOM_METADATA
• SYS.V_$SESSION
• SYMSMAN.MGMT_LICENSE_DEFINITIONS
• SYMSMAN.MGMT_ADMIN_LICENSES
• SYMSMAN.MGMT_LICENSES
• SYS.DUAL
• SYMSMAN.MGMT_LICENSE_CONFIRMATION
• SYMSMAN.MGMT_TARGETS
• SYMSMAN.MGMT_$TARGET
- SYSMAN.MGMT_VERSIONS
- SYSMAN.MGMT_INV_COMPONENT
- SYSMAN.MGMT_FU_REGISTRATIONS
- SYSMAN.MGMT_FU_STATISTICS
- SYSMAN.MGMT_FU_LICENSE_MAP
- SYS.DBA_REGISTRY
- SYS.V_$LICENSE
- SYS.DBA_TABLES
- CONTENT.ODM_DOCUMENT
- SYS.V_$VERSION
- SYS.USER_ROLE_PRIVS
- SYS.USER_SYS_PRIVS
- SYS.ROLE_SYS_PRIVS
- MDSYS.SDO_GEOM_METADATA_TABLE
- SYS.DBA_INDEXES
- SYS.DBA_LOBS
- SYS.DBA_OBJECTS
- SYS.DBA_RECYCLEBIN
- SYS.DBA_MINING_MODELS
- SYS.REGISTRY$HISTORY
- SYS.DBA_TAB_PARTITIONS
- SYS.DBA_TAB_SUBPARTITIONS
- SYS.DBA_LOB_PARTITIONS
- SYS.DBA_LOB_SUBPARTITIONS
- SYS.V_$ARCHIVE_DEST_STATUS
- SYS.DBA_SQL_PROFILES
- SYS.DBA_ADVISOR_TASKS
- SYS.DBA_SQLSET
- SYS.DBA_SQLSET_REFERENCES
- SYS.DBA_FLASHBACK_ARCHIVE
- SYS.DBA_FLASHBACK_ARCHIVE_TS
• SYS.DBA_FLASHBACK_ARCHIVE_TABLES
• SYS.V_$BLOCK_CHANGE_TRACKING
• SYS.V_$CONTAINERS

Save Inventory Account in Password Store

The accounts that collect Oracle inventory must exist in the Password Store.

This process must be completed on the inventory beacon.

1. Log into the inventory beacon, using an account that has administrator privileges.
2. Start the FlexNet Beacon software from the Windows Start menu.
3. In the navigation bar on the left, select the Password management page, and click Launch Password Store. The separate interface for the Password Store opens.
4. In the Current Password Store group, click New. The controls in the Editor group are activated.
5. Provide a Logical Name to identify this set of credentials. Logical naming allows you to have one account name, but with different passwords on different servers. For more, see the online help.
6. For Account Type, choose Account on Oracle database.
7. Complete the User (account name) and Password.
8. Click View/Edit filter.... The Password Store: Password Filter dialog is displayed.
9. Use the Oracle service names filter to create a comma-separated list of the Oracle services for which this account/password pair should be used. The services names are visible in your .ora file. Filtering the account/password pair to apply only to specified Oracle services provides maximum efficiency for login and introspection.
10. Click Apply to close the dialog, and continue to save the entry in the Password Store. Repeat the process as required until all your Oracle machines are covered by one or more entries in the Password Store. Thereafter you may exit the FlexNet Beacon interface.

Assign Beacon to Subnet

Before rules can take effect, inventory beacons must know their subnets.

It is a requirement for an operational system that your subnets are assigned to appropriate inventory beacons. This summary covers only making adjustment for the collection of Oracle inventory.

1. In the web interface for FlexNet Manager Suite, navigate to Discovery & Inventory > Subnets (in the Network group). This page is populated with the sites and subnets in your enterprise after you have completed an import from Active Directory (for details, consult FlexNet Manager Suite Help > Inventory Beacons > Active Directory Page > Importing from Active Directory).
2. Expand the appropriate site(s), using the + expander icon, until you can see the subnet that includes your Oracle database servers.

Tip • If the subnet does not yet appear in the listing, you can add its details manually. In the row for the appropriate site, click the + sign on the right-hand end, and enter the subnet IP address in the new row that appears.

3. If the Beacon name column shows Unspecified, click the editing (pencil) icon at the right-hand end of this row.
   The row becomes editable. Beware of accidentally over-writing the IP address, which initially has focus.

4. In the Beacon name column, use the drop-down list to choose the appropriate inventory beacon from the list of those registered so far; and click the blue disk icon on the right to save your change.

Your chosen inventory beacon is now authorized to work in the subnet that contains your Oracle database servers. Now continue and create a rule that dictates what should happen within that subnet.

Configure Collection of Oracle Inventory

Rules must be established that allow Oracle inventory collection, including the use of .ora files.

Inventory rules are created on the Discovery and Inventory Rules page of the web interface for FlexNet Manager Suite. Each rule has three parts:

• A target that identifies the machines on which the rule is to be exercised
• Actions that are the be performed on those target machines
• The schedule on which the rule is to be applied.

When an action includes permission to use a .ora file, the relevant inventory beacon uses the locally-available .ora file to ‘filter’ the related target and identify the Oracle database servers from which inventory should be collected. For example, if you target an IP range that covers your server room, and include the action setting to apply the .ora file to this range, then Oracle inventory is collected only from the matching machines listed in the .ora file.

Once a discovery and inventory collection has been completed, the individual Oracle database servers are identified in the list of discovered devices. Should you wish to change to tighter targeting rules, you can use this information to redefine the target until (if you wish) it identifies exactly the Oracle database servers and no others. Keep in mind that if you use this approach, you will need to adjust the target each time you vary the list of your Oracle database servers. To reduce this manual maintenance, keep a target that specifies an appropriate IP range (or ranges), and applies the .ora file to this to identify the individual Oracle database servers from which to collect inventory.

1. In FlexNet Manager Suite, navigate to Discovery & Inventory > Discovery and Inventory Rules (in the Discovery group).

2. If you do not already have a target to reach the Oracle servers from which you want to gather inventory:
   a) On the left side, select the Targets tab.
**Fastpath** • In the hints area across the top of the page, click **Create targets**. These hints can guide you through the process.

a) On the right side, click **Create a target**.

b) The page appearance changes, allowing you to define a target.

c) Complete the details requested, with particular attention on **Define machines to target**.

Notice that:

- After you complete each definition for this control, a + icon is displayed that allows you to add more to your definition of target machines. Use these lines to define a target sufficiently broad to capture your Oracle database servers.

- If you do not want the FlexNet inventory agent to be installed on these Oracle servers, be sure to select **Do not allow these targets to be adopted**.

- You should likely also select **Do not allow application usage tracking on these targets**, since you may not want to collect a large quantity of file evidence from these servers.

d) Click **Save**.

3. If you already have an action for Oracle discovery, you can check its settings; or create a new one:

a) Click the **Actions** tab (or in the hints section, click **Create actions**).

b) If you wish to collect hardware inventory for these servers (perhaps to assist with licensing calculations for your Oracle database license), expand the General accordion and select **Gather hardware and software inventory**.

Tip • You may want to clear the check box for **Discover devices**, if you are limiting this action specifically to inventory collection for known Oracle database servers identified in your .ora file.

c) Expand the **Oracle database** accordion.

d) If you are confident that every Oracle database is identified in your .ora file, you may clear the check box for **Discover Oracle databases**. Alternatively, if you may have rogue servers, leave this check box selected, and the network within your declared target will be probed for other Oracle servers.

e) Select the check box for **Also gather Oracle database inventory**. Additional controls, if not already visible, are exposed.

f) Ensure that the **Port scan** check box is selected, and if necessary use the + icon to add additional ports to the list until every port listed in your .ora file is included.

g) Ensure that the **SNMP scan** check box is selected.

h) It is critically important that you select the **TNS names file** check box.
This setting authorizes the relevant inventory beacons to apply any `.ora` files found in the 'magic path' to the target used for this action (in the rule soon to be completed). This is the mechanism that most efficiently restricts probing to the relevant servers.

i) Adjust other settings in other parts of the accordion to suit your environment, and click **Save**. The action is stored, ready for inclusion in a rule.

4. Select the **Rules** tab (or in the hints area, click the third **Create rules** step).

   a) Do either of the following:

   - If you have an existing rule to review or modify, click the edit (pencil) icon on its right-hand end.

   - Click **Create a rule** (upper right) to define a new rule (as described in the following steps).

   A rule builder work area appears above the list of existing rules.

   b) Return to the **Actions** tab (for example, using the link in the rule builder), and on the row for your edited Oracle action, click **Add to rule builder**. The name of your action appears in the rule builder.

   c) Return to the **Targets** tab (for example, using the link in the rule builder), and on the row for your edited target, click **Add to rule builder**.

5. On the right side of the rule builder, click **Schedule**. The rule builder changes to display controls for scheduling:

   a) Choose a value from the **Frequency** drop-down list. This control sets the style of scheduling. For example, the **Daily** option lets you make further choices about a pattern of days, and does not enforce inventory collection every day.

<table>
<thead>
<tr>
<th>Option</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Once</td>
<td>A single-shot trigger for inventory collection the next time the declared time window occurs (you cannot nominate a future date). For example, if it is 4pm when you set a <strong>Once</strong> schedule for 8am, commencing within 4 hours, inventory collection occurs next morning. <strong>Compare with As soon as possible.</strong> Keep in mind the propagation delays for your changed instructions, as described there.</td>
</tr>
<tr>
<td>Daily</td>
<td>An additional drop-down list, <strong>Every</strong>, appears so that you can choose the pattern of days you want. For example, you may wish to trigger inventory collection every second day. Choose a value from this list as well.</td>
</tr>
<tr>
<td>Weekly</td>
<td>New check boxes appear that allow you to choose specific days within the weekly cycle when inventory should be collected. For example, you may want collection on Sunday and Wednesday every week. Select (check) the boxes for the days you prefer.</td>
</tr>
<tr>
<td>Monthly</td>
<td>New controls appear that allow you to specify a pattern within the month:</td>
</tr>
<tr>
<td></td>
<td>• Choose the option for <strong>On day</strong> to nominate a particular day within the month (such as the third Saturday). Make your choices from the two drop-down lists adjacent. Notice that the option <strong>Last</strong> chooses the fifth</td>
</tr>
<tr>
<td>Option</td>
<td>Notes</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>occurrence in months long enough to have one, and otherwise takes the fourth occurrence.</td>
<td></td>
</tr>
<tr>
<td>• Choose the option for <strong>On date</strong> to nominate the calendar date within the month.</td>
<td></td>
</tr>
<tr>
<td><strong>As soon as possible</strong></td>
<td>This is a single shot trigger which causes each FlexNet inventory agent to randomize an inventory collection within the time window starting when it receives this setting and lasting for the interval you specify in the <strong>Commence within controls</strong>.</td>
</tr>
<tr>
<td><strong>Tip</strong> • Any change you save to these settings is first collected by the inventory beacons on the schedule specified by the <strong>Beacon settings</strong> (further down this web page), by default checked every 15 minutes. Each inventory beacon then prepares new instructions for all the installed FlexNet inventory agents that it manages, which come calling to collect their latest package every 12 hours. Because of these propagation periods, <strong>As soon as possible on average</strong> means starting about six hours from now, or worst case a little over 12 hours from the time you save this change.</td>
<td></td>
</tr>
</tbody>
</table>

6. In the rule builder, click **Save as**, give the rule a name you will recognize later in lists, and click **Save**. If you accepted the default **Enabled** setting, the rule is ready to run on the schedule you have established. (Remember to allow around 15 minutes for the new rule to be distributed to your inventory beacons.) When the rule is executed on an inventory beacon, if a `.ora` file exists in the 'magic path', the systems that lie both within the inventory beacon's assigned subnet(s) and within the `.ora` file are targeted for Oracle inventory collection.
This chapter covers changes you can make to the operations of the OEM adapter by modifying its configuration file. Read the first topic for general guidance on the editing process, and choose the detailed subtopics based on what changes you need.
Reconfiguring the OEM Adapter

During installation, you recorded your preferred settings for the OEM adapter, and no further work is required in the installation process.

If you later wish to modify the configuration of an instance of the OEM adapter:

1. In Windows Explorer, navigate to the correct folder for the appropriate instance of the OEM adapter.

Keep in mind that there may be several instances installed on a computer, accessing distinct instances of Oracle Enterprise Manager.

2. In your preferred plain text (or XML) editor, open the OEM adapter’s configuration file, called OEMAdapter.exe.config.

It is strongly recommended that you make a backup copy of the original configuration file, so that you can easily revert your changes if there are problems.

3. Use the following subtopics to guide your changes to the configuration file.

4. When you have finished, save the updated file.

5. Either wait until the next scheduled run of the OEM adapter, or use the Windows scheduled task interface to trigger an immediate test run to confirm that your changes work as expected.

Updating Connection Details

You can change all details and credentials for connection to the Oracle Enterprise Manager instance.

When the OEM adapter is first run, it encrypts the connection details used to access the Oracle Enterprise Manager implementation. Therefore, the process to edit the connection details is different, based on whether the OEM adapter has been run since the connection details were last recorded. You can tell whether this is so by looking in the configuration file.

The details are all stored in the <connectionStrings> element of the configuration file.

1. If the OEM adapter has been run since the details were recorded in the configuration file, the encrypted <connectionStrings> element appears similar to this:

   ```
   <connectionStrings configProtectionProvider="DataProtectionConfigurationProvider">
   <EncryptedData>
   <CipherData>
   <CipherValue>AQAAANCMnd8BFdERjHoAwE/Cl+sBAAAAeNhcGMAVK0uVGNTqOq/WbQQAACAAA
   AAAADzgAwAAAAABAABACTO9kpj68ptplVsXEqg1UBAAAAASAAAACgAAAAEAADCEyiw5A
   XZw9x2XFEPlIAAAAgaAPJQyE+G9AfScFMJTVgADNdbAgzdRA9nB91DN2A1xeCskUs9+KNjV
   U1PSFkV4yjta40eef31OZy5odyHslrJRCXOGdNhblwh4ISEkpJk/QDna6leCbbXXeqKZLo
   AHQc/pl77UKQgXnkxL5E1P1GfH16ojeEXTZfSN9jElJXc6GDuXQDQhNdfi2o6X1/CDbXgCu
   MonYScLY6e6++4QqPqWyt76aA2D2Fos7/2BvKOW7iOzb6H8Olvrc1SszqVkbVd43YhLpKo
   kQP8orq549B7J74E1v3VUZntelE5gLA5Myb/F9Ah3M5xi12Q6lXTQnVwEGsErvscqr6nYG
   5APxzYV8bKvCcVbOMYUREBbB5W+6/adyf89nY1Dcrtzkap1X12OQs8y7EHSWt3+bFEN3oxh6X
   KF7n7rpe8e5y9TqjBlhkw+kW6AFz2hcdewpJ62kGAr4Ix86gLWqXnomk2puKNF1mhJgqLLiuQ
   x9700Uu2bJ9YFvJUrcuv12hQeOX7c9nqDme1QHQxw8J/eH0Owzwy2Tgcm2M1xXRhQGqC
   eW1T1pucaJYvc79gnJ1kZL3F9B9nMu1C9ncr7MscGDBWoQCMkwvC5+y6FCtt4sPaOeOBqTVIQ
   Tj7MCzruFgDLR9c7wglj7CMml1O3t31GMPRYPV7CPNET3DUVV9AGQUAQAAlEKyjyfExrbe
   YjG2usqY0XNkwx/</CipherValue>
   </CipherData>
   </EncryptedData>
   </connectionStrings>
   ```

In this case, delete the entire element and replace it with a plain text version as shown below.
2. If the OEM adapter has not been run since the configuration file was changed, it has a plain text form similar to this (line wrapping has been added here for legibility). Replace the italicized placeholders with your own values, as described below. Keep the `connectionString` attribute all on one line.

```xml
<connectionStrings>
  <add name="OEMConn"
      connectionString="Data Source=(DESCRIPTION=(ADDRESS=(PROTOCOL=TCP)
                    (HOST=HostIPAddress)
                    (PORT=PortNumber))
                   (CONNECT_DATA=(SERVICE_NAME=ServiceName)));
          User Id=AccountName;Password=UnencryptedPassword;"/>
</connectionStrings>
```

where the following details should be confirmed with your Oracle administrator:

- `HostIPAddress` is the IP address of the Oracle server hosting Oracle Enterprise Manager
- `PortNumber` is the port that the OEM adapter should use to query Oracle Enterprise Manager
- `ServiceName` is the service name established when Oracle was installed on the Oracle server
- `AccountName` is the account (user name) that the Oracle administrator has established for accessing Oracle Enterprise Manager
- `UnencryptedPassword` is a plain text rendition of the password for the same account (remembering that all the connection details are encrypted together as soon as the OEM adapter runs next).

3. Save the amended configuration file.

4. Use the Windows schedule task interface to run a test of the OEM adapter to confirm that the connections details were correctly entered.

## Configure Data Staging

Modify the name and location of the file of Oracle connection information.

The OEM adapter collects information about connections to Oracle systems from which you need to gather inventory information. This file is in a standard Oracle format, used for their `TNSNames.ora` file. It is saved by default where the OEM adapter is executing; but the default location for the OEM adapter does not support automated processing of the `TNSNames.ora` file when the inventory beacon applies rules for gathering Oracle inventory. For the OEM adapter to function seamlessly, you must customize the location as you edit the `OEMAdapter.exe.config` file.

Another reason to customize the file name is if you have multiple instances of the OEM adapter running from the same computer (or if anyone manually adds `TNSNames.ora` files to the processing directory). Each instance must write to a unique file name, so that one output does not over-write the other.

These settings live in an `add` element with the `key` attribute of `ConnectionInfoFile`.

1. In the `OEMAdapter.exe.config` file, locate the appropriate element. Its default values are similar to the following:

   ```xml
   <add key="ConnectionInfoFile" value="C:\Program Files\Flexera\Oracle Enterprise Manager Adapter\TNSNames.ora"></add>
   ```

   This reflects the default location of the OEM adapter, and must be modified.

2. Replace the `value` string with the new file path and name.
Important • The file name must use the extension .ora.

You may use a mapped drive on the local computer to specify a network path. This example shows the file in the recommended ‘magic path’ on the inventory beacon where the .ora file is automatically processed to ‘filter’ the target supplied from the central application server. Also notice the customized file name to avoid naïve overwriting of the TNSNames.ora file name by other copies saved here:

```xml
<add key="ConnectionInfoFile" value="C:\ProgramData\Flexera Software\Repository\TNSNames\TNSNames-01.ora"></add>
```

3. Save the amended configuration file.

4. Use the Windows schedule task interface to run a test of the OEM adapter to confirm that the staging file is saved according to your revised specifications. Check the location (recommended: C:\ProgramData \Flexera Software\Repository\TNSNames\) for the presence of a saved file immediately after the test run (if you wait too long, the resulting file may be automatically uploaded and removed from this staging location).

Managing Email Alerts

You can turn the alerts off, changes their addresses, or switch email servers.

The OEM adapter can send email alerts any time that it encounters an error. Manage the emails with the following XML elements in the OEMAdapter.exe.config file.

1. To stop email alerts entirely comment out the reference to the SmtpAppender like this:

```xml
<appender-ref ref="RollingFileAppender"></appender-ref>
<!-- <appender-ref ref="SmtpAppender"></appender-ref> -->
```

(The character sequence <!-- starts an XML comment, and the sequence --> closes the comment.)

Tip • Using this technique is preferable to deleting this line entirely, as this can be easily reversed if you decide to reinstate email alerts in future. Notice that, depending on the configuration you saved, there may be other elements between the <appender-ref> tags.

2. To reconfigure the email alerts, locate the <appender> element, and modify three of its child elements by changing the example values shown in italics here:

```xml
<appender name="SmtpAppender" type="log4net.Appender.SmtpAppender">
  <to value="toaddress@somedomain.com"></to>
  <from value="fromaddress@somedomain.com"></from>
  <subject value="OEM Adapter Error"></subject>
  <smtpHost value="smtp.somedomain.com"></smtpHost>
</appender>
```

3. Save the amended configuration file.

4.
Configure Logging

Change the path and file name for logging by the OEM adapter.

The log file name and location cannot be set during installation of the OEM adapter, but after installation, they can be modified as follows:

1. In the OEMAdapter.exe.config file, locate the <appender> element called RollingFileAppender.
2. Edit the child <file> element by replacing the drive, path and file name shown as placeholders here:

   ```xml
   <appender name="RollingFileAppender" type="log4net.Appender.RollingFileAppender">
     <file value="drive:\path\path\logfilename.txt"></file>
   </appender>
   ```

3. Save the amended configuration file.

After the next run of the OEM adapter, inspect the log in your new location.
Part VI

ServiceNow Integration with FlexNet Manager Suite

Topics:

- Architecture, Components, and Prerequisites
- Installation and Configuration
- Operational Details
- Appendices

You can exchange a limited set of data between these systems to provide a consistent view of your hardware and software estate, and related contracts.

ServiceNow provides cloud-based IT Service Management, while FlexNet Manager Suite is focused on Software Asset Management. To help provide a unified view of your management data, there are two parts to the integration of these systems, each of which is available independently:

- Data on hardware assets, application installations, and contracts can be exported from FlexNet Manager Suite and imported into ServiceNow
- Data on assets and contracts can be exported from ServiceNow and imported into FlexNet Manager Suite.

This release of the ServiceNow integration package supports the following versions of ServiceNow:

- Geneva Patch 5
- Helsinki.
Architecture, Components, and Prerequisites

This chapter provides the background information you need to get started. It is valuable to understand the concept of 'sources of truth' which guides the flow of information between the two systems:

- FlexNet Manager Suite is authoritative on hardware assets, application installations, and contracts.
- ServiceNow is authoritative on assets and contracts.

These ideas drive the default configuration of exports and imports. (You can also customize the exports, as described in a later chapter.)

Topics:
- Architecture
- Prerequisites
- Download Adapter Tools Archive
Architecture

This big-picture overview provides context for understanding both configuration and operation of the integration between ServiceNow and FlexNet Manager Suite.

Because ServiceNow is cloud-based, and your implementation of FlexNet Manager Suite is on your premises, there is a level of separation required (for example, the products must be accessed in separate browser tabs/windows). The following architecture allows for the necessary data flows between these two distinct systems.

The following two processes (illustrated in the diagram) operate completely independently:

- The export of computer and contract data from ServiceNow for import into FlexNet Manager Suite (gold arrows). For details, see Process for Exports from ServiceNow to FlexNet Manager Suite on page 186.
- The export of computer, application, and contract data from FlexNet Manager Suite into ServiceNow (purple arrow). For details, see Process for Exports from FlexNet Manager Suite to ServiceNow on page 191

Prerequisites

The following are requirements for integrating FlexNet Manager Suite and ServiceNow.

- You must have a license issued by Flexera Software that permits use of the integration package. This license authorizes all communications in both directions through the integration package.
  
  To check, in the web interface navigate to the system menu ( in the top right corner) and click FlexNet Manager Suite License. Check under the Subscription details for ServiceNow integration enabled: Yes.

- You need a functional implementation of FlexNet Manager Suite. This documentation is for release 2016 R1. (The current integration package is supported from FlexNet Manager Suite 2015 R2 SP5, with hotfix applied.)

- The FlexNet Manager Suite feature called ServiceNow Exporter must be installed. To check:
1. On your batch server, navigate to the installation directory for FlexNet Manager Suite.

2. Navigate down to the child directory `DotNet\bin`.

3. Validate that there is a `ServiceNowExport` folder, with content. If so, the check is satisfactorily completed.

4. If the folder is missing, you must re-run the FlexNet Manager Suite installer, and ensure that the ServiceNow Exporter feature is selected for installation. You should also re-run the configuration PowerShell script in order to create the required scheduled task. (For more information, see your copy of the Installation Guide PDF, available through the title page of your online help.)

- You need to download the ServiceNow integration package version 3.01 (or later) (see Download Adapter Tools Archive on page 133).

- You must have an operational ServiceNow instance. This release of the ServiceNow integration package supports the following versions of ServiceNow:
  - Geneva Patch 5
  - Helsinki.

- **For data flows from ServiceNow to FlexNet Manager Suite:**
  - You must have an operational inventory beacon that communicates with your central application server for FlexNet Manager Suite.
  - You need a MID server configured for your ServiceNow implementation.

  **Tip** • If you prefer, your FlexNet Beacon and ServiceNow MID server can be implemented on the same physical computer (provided that there are common communications requirements — for example, you don't have a case where one requires a proxy server setting that the other cannot use).

- **For data flows from FlexNet Manager Suite to ServiceNow:**
  - Your ServiceNow instance must have the Software Asset Management plugin installed and enabled, to allow application import to work.

---

**Download Adapter Tools Archive**

The Adapter Tools archive includes content for many adapters, and is updated on the Flexera Software website from time to time.

Start this procedure using a web browser on a computer that has good network accessibility from all the machines needing installations for your adapter.

1. Do either of the following:

   - Download the Adapter Tools for FlexNet Manager Suite 2016 R1.zip archive from the Flexera Software Product and License Center:
a) Using the credentials supplied by Flexera Software with your order confirmation (or as renewed since), log into https://flexerasoftware.flexnetoperations.com.

b) On the first page, select FlexNet Manager Platform, and on the resulting second page, select the product again.

c) In the list of versions, click the product name for the version you are using (typically the most recent version).

d) In the list of components to download, select the Tier 1 Adapter Tools.zip archive, and save this to a convenient location (such as C:\Temp on a central, accessible server).

• Download the Adapter Tools for FlexNet Manager Suite 2016 R1.zip archive from the Flexera Software Customer Community knowledge base:

    Tip • Access requires your Customer Community user name and password. If you do not have one, use the link on the login page to request one.

  b) Take note of the password identified within that article, at the end of the Synopsis.

c) Click the link Adapter Tools for FlexNet Manager Suite.
    In a new browser tab, when you provide the required password, the download of Adapter Tools for FlexNet Manager Suite 2016 R1.zip commences from the Flexera Software account at box.com.

d) In your browser dialog, choose to save the file, and if the browser allows it, direct the saved file to a convenient working location (such as C:\Temp on a central, accessible server).
    If your browser saves the file to a default location (such as your Downloads folder), move or copy it to the appropriate working location when the download is finished.

2. Right-click the zip archive, and choose Extract All....

The folders are now available for the range of adapters in the Adapter Tools archive.
Because the system involves a number of different servers, there are several installation and configuration steps. These are described in full in the following topics.

The information is divided into three sections:

- **Setting up the Integration** on page 172 — these tasks are common and must be completed for all implementations
- **Setting up Data Flows from ServiceNow to FlexNet Manager Suite** on page 173 — required if you want to import data on assets and contracts into FlexNet Manager Suite
- **Setting up Data Flows from FlexNet Manager Suite to ServiceNow** on page 178 — required if you want the FlexNet Manager Suite data on hardware assets, application installations, and contracts to be available within ServiceNow
Setting up the Integration

Most of the groundwork on the FlexNet Manager Suite side has already been completed as part of product installation. Therefore the balance of the work that is common to both directions of data flow involves setting up ServiceNow.

- In ServiceNow language, you need to set up an 'application' that is to be integrated with ServiceNow (see Installing the ServiceNow Application for FlexNet Manager Suite on page 172).
- There must also be a user account correctly configured in ServiceNow (see Creating a ServiceNow User on page 173).

Installing the ServiceNow Application for FlexNet Manager Suite

Tip • If an existing integration application for FlexNet Manager Suite is installed in ServiceNow, first follow the steps in Removing an Earlier Integration Application on page 204.

This process assumes that you have downloaded the adapter package and unzipped the archive, and that the resulting folders are accessible from your ServiceNow server (for details, see Download Adapter Tools Archive on page 133).

Warning • The ServiceNow documentation warns you to configure imports of update sets outside business hours, as the import process can impact the performance of your ServiceNow instance.

1. Log into ServiceNow as a ServiceNow administrator.
2. In the left-hand navigation bar, expand the System Update Sets group, and click Retrieved Update Sets. A list of already registered updated sets is displayed.
3. Below the list, click the Import Update Set from XML link.
4. Under Step 1: Choose file to upload, click Browse..., navigate in your extracted folder to the ServiceNow subdirectory, and select FlexNet Manager Suite Integration.xml.
5. Click Upload.

When your file finishes uploading, it displays in the list of Retrieved Update Sets with a State value of Loaded.

Tip • From release 3.0 of the integration adapter, the ServiceNow integration application is created in its own private scope. (ServiceNow supports private scopes from its Fuji release. Previous versions of the integration adapter created the application in the global scope.)

6. Click on the hyperlinked Name of your update set.
The **Retrieved Update Set** properties are displayed.

**Tip** • You cannot commit the update set until you have previewed it (as follows) and addressed any problems.

7. Below the properties, click **Preview Update Set**. The **Progress** (preview completion) page indicates when problems are detected with a red **Error** display in the **Completion code** field. You must address any problems that may be detected (see section 3.1 and 3.2 in [http://wiki.servicenow.com/index.php?title=Transferring_Update_sets#Preview_Remote_Update_Sets](http://wiki.servicenow.com/index.php?title=Transferring_Update_sets#Preview_Remote_Update_Sets)).

8. When there are no (remaining) errors, click **Commit Update Set**. The application now appears in the ServiceNow menu, displayed in the left-hand navigation panel as **FlexNet Manager Suite**.

---

**Creating a ServiceNow User**

This simple process sets up the user account used for integration between Service Now and FlexNet Manager Suite, and assigns the user to the appropriate role. Complete this task while you are still logged into ServiceNow as an administrator.

1. In ServiceNow, go to **User Administration > Users**.

2. Click **New**, complete the properties for your new user, and click **Submit**.

**Tip** • Take note of the user ID and password, which you will need again later in the set-up processes.

3. Once the creation process finishes, click the hyperlinked **User ID** for this user, and scroll down to **Roles**.

4. Click **Edit**, and select **x_fls_flexera_fnms.admin** from the collection, and add to **Roles List**.

5. Click **Save**.

6. Close the user properties page.

---

**Setting up Data Flows from ServiceNow to FlexNet Manager Suite**

Details of hardware assets and/or contracts, for which ServiceNow is considered the authoritative source of truth, can be imported into FlexNet Manager Suite from ServiceNow. In summary, the process is:

1. Each data collection is triggered by a scheduled job in Service Now that invokes a script.

2. The script uses ServiceNow database views to gather the required data and transfers it, in chunks, to the appropriate MID server.

3. The MID server writes the chunks into an XML file.
4. A separate schedule configured on the inventory beacon for FlexNet Manager Suite triggers an import through a business adapter, collecting the XML file, transforming it, and uploading it to the central application server.

5. The normal import processes on the application server imports the data (transformed as appropriate) into the operations databases for FlexNet Manager Suite.

If you wish to make use of this data flow, you need to complete the following processes:

- Setting up a MID Server on page 174
- Configuring ServiceNow for Export on page 174
- Configuring FlexNet Beacon for Import on page 176.

No configuration of the central application server is needed, since this part of the integration leverages all standard operating processes.

**Setting up a MID Server**

You may already have an operational MID server (accessible from your chosen inventory beacon) that you wish to use for data transfers from ServiceNow to FlexNet Manager Suite. If so, and the MID server is validated in ServiceNow, you may skip this topic.

On the other hand, you may prefer to set up a specific MID server especially for this integration. Follow these steps while you are still logged into ServiceNow with administrator privileges:

1. In the navigation bar, expand **MID Server** and click **Downloads**.
2. Click the link appropriate for your platform.
3. In the navigation bar, in the **MID Server** group, click **Installation Instructions**, and click the link appropriate to your version of ServiceNow.
   
   The documentation opens in a new tab.
4. Step through those instructions to complete installation of your MID server.
   
   Take particular note of the exact name you give this MID server, as you will need it again soon. (It is also available through **MID Server** > **Servers**.)
5. Be sure to validate your MID server (see link near to the top of the title page of the instructions).

**Configuring ServiceNow for Export**

Now that you have a MID server installed, two further configuration points for ServiceNow remain:

- Identifying the MID server as the one to use for the exports to FlexNet Manager Suite
- Scheduling the exports from ServiceNow.

Continue the following while still logged into ServiceNow with administrator privileges:

1. In the navigation bar, expand the **FlexNet Manager Suite** integration group and expand **Advanced**.
2. Click **Integration Properties**.
3. In the list of Flexera FlexNet Manager Suite Properties, scroll down to the MID Server Name field, and enter the full name of the MID server.

4. Scroll down (if necessary), and click Save.
   The MID server is now registered as the path for data exports from ServiceNow to FlexNet Manager Suite.

5. Navigate in ServiceNow to FlexNet Manager Suite > Scheduled Jobs.
   The list of standard jobs to export data from ServiceNow is displayed, including:

   • Export Assets From ServiceNow
   • Export Contracts from ServiceNow.

   Each of these jobs needs to be configured for your environment.

6. Click the first export task to schedule (such as Export Assets From ServiceNow). The Scheduled Script Execution properties are displayed.

   Note • The MID server collects the exported XML data in chunks, such that the XML file is not well formed until the last chunk has been received. Be sure to schedule sufficient time for the exports to complete before the scheduled import from the MID server into FlexNet Manager Suite.

7. Change the value in the Run field to suit your business needs.
   These data exports may be large, based on the size of your ServiceNow repository. A common practice would be to choose Weekly exports.

   Tip • ServiceNow by default limits its exports from the database to 10,000 records (for a general discussion, see https://community.servicenow.com/community/blogs/blog/2014/08/01/increasing-the-export-limit, but note that this page discusses limits for exports from the ServiceNow user interface grids, which are not relevant to the database exports to FlexNet Manager Suite). You can modify the maximum number of records exported from ServiceNow by having your ServiceNow administrator add the property glide.db.max_view_records and setting a new limit. For instructions on adding the property, see http://wiki.servicenow.com/index.php?title=Adding_a_Property#gsc.tab=0.

8. Use the additional fields that appear to complete your scheduling.
   For example, for Weekly exports, set the Day, and Time of day, when the export should occur. An off-peak time is preferable.

9. Click Update to save your changes.
   Repeat the scheduling for the Export Contracts from ServiceNow task.

10. With both exports now scheduled, run a test of each by clicking Execute Now on the associated Scheduled Script Execution properties page.
    (This same button can be used to run the export if you chose the Run On Demand setting for the schedule.) Use the test to assess the time taken to complete the export and finish a well-formed XML file on the MID server, as a check on your scheduling plans. The test also allows you to troubleshoot any problems.

11. Monitor queue management:
    a) From the ECC group, select Queue.
b) In the Queues list, click the Created column header to show the most recently-created entries at the top of the list.

The MID server agent collects content from this queue.

c) Click the hyperlinked date/time under Created to inspect the contents of each package.

Because data is chunked, the first segment just lays down the opening elements for the XML file; subsequent segments add data entries; and the last closes the XML elements and reports success.

12. Monitor overall progress by navigating to **FlexNet Manager Suite > Export Runs**.

The State column on this view shows the progress of export, and the Stage column displays File Completion when the XML file is done.

13. On the MID server, check for well-formed (complete) XML files.

The files are located in the installation folder of the MID server, which by default is called agent. The file names are of the form $x_fls_flexera_fnms_ExportType.xml$, where the placeholder $ExportType$ is either Asset or Contract. You can check the files in your preferred XML reader, or in Microsoft Internet Explorer.

This completes the configuration of ServiceNow for data flows from ServiceNow to FlexNet Manager Suite. These same data flows also require some configuration of FlexNet Manager Suite to receive the data. This side of the configuration is covered next.

### Configuring FlexNet Beacon for Import

If you are not already familiar with importing business-related data to FlexNet Manager Suite, the following terminology summary may help:

- A “business adapter” is an XML file that allows configuration of a connection to a source of business data, as well as mapping of that data from the source format to the database tables and columns required in FlexNet Manager Suite. The data from ServiceNow is handled as business data, and therefore data transfers make use of business adapters.

- The “Business Adapter Studio” is a utility available on each inventory beacon for customizing and testing business adapters.

- The “Business Importer” is the process that exercises the business adapters to the schedule you define, and controls each import as defined in its business adapter.

In previous tasks, you have configured ServiceNow to run two exports that queue data about hardware assets and contracts and send it to the MID server of your choice. On the MID server, the data is written into XML files. Once these have been completed, two business adapters running on your inventory beacon collect this data and upload it to your central operations databases. You must use the following process to configure these business adapters before they can operate.

**Tip** • Clearly, the inventory beacon and the ServiceNow MID server must access a common folder for the transfer of the XML files. It is possible that the FlexNet Beacon software and the ServiceNow MID server are installed on the same physical machine; but if they are on separate machines, network access allowing a file share is required.
This means you may need to grant at least read access for the share on your MID server to two accounts on your inventory beacon:

- **The local administrator account with which you will log in now for configuring and testing your business adapters**
- **The account that runs your FlexNet Beacon Service, which will exercise the business adapters in production (by default, this is the local SYSTEM account on your inventory beacon).**

As well as access to the MID server, your inventory beacon requires access to the unzipped archive you downloaded for the ServiceNow integration package to complete this process.

1. On your chosen inventory beacon, log in as a local administrator.
2. If necessary, validate that, from this server, you can access the file share where the MID server saves the completed XML files.
3. In the unzipped archive you downloaded for the ServiceNow integration package, open the **Importer** folder and locate the two business adapters `ServiceNowAssets.xml` and `ServiceNowContracts.xml`.
4. Copy these two files to the business adapters folder, `%CommonAppData%\Flexera Software\Beacon\BusinessAdapter`, on the inventory beacon.
5. Start the FlexNet Beacon software from the Windows start menu on the inventory beacon.
6. In the interface for FlexNet Beacon, select the **Business Importer** page from the **Connections** group (in the left-hand navigation pane). The two adapters appear in the list of available business adapters.
7. For each of these adapters in turn, select the adapter from the list, and click **Edit...**. In the following dialog, click **Edit Adapter**. The Business Adapter Studio opens, editing this adapter.
8. In the Business Adapter Studio, select the top level import node (like `ServiceNowAssets` or `ServiceNowContracts`) and locate the **File name** field. Complete the file path and file name for the appropriate XML file on the MID server. If you have already exported data from ServiceNow to the MID server, you may click the ... button and browse to the respective XML file in the folder on the MID server. The following example from the assets adapter shows a path when the MID server and inventory beacon are installed on the same physical computer:

   ```
   C:\ServiceNow\MyMIDServerFolder\agent\x_fls_flexera_fnms_asset.xml
   ```

   The following example from the contracts adapter shows a path when the MID server is separate, using UNC format:

   ```
   \\MyMIDServer\ServiceNow\MyMIDServerFolder\agent\x_fls_flexera_fnms_contracts.xml
   ```

   **Tip** • Be sure not to change the database view name while editing the MID server name in the script.

9. When the file path and name are identified, click **Refresh** (just below the ... button).
10. **Save** the modified adapter; and repeat the process for the other adapter.
11. When both are completed and saved, close Business Adapter Studio.
12. If you have not already created the schedule(s) on which you want to run these adapters, switch to the Scheduling page of the FlexNet Beacon interface, and create one or two now.

You may run these two business adapters on the same schedule, as the inventory beacon queues them and runs them one after the other.

**Important** • Remember that there is a delay between when the scheduled job starts executing in Service Now, and when the MID server finishes assembling the transmitted chunks into a valid XML file. You can test the elapsed time for your environment by triggering each export, and waiting until, in the Export Runs view (in ServiceNow), it reaches the Succeeded state. Allow a safety buffer for future data growth, and set the schedule for the business adapters to run after the exports and assembly of the XML files are completed.

13. In the Business Importer page of the FlexNet Beacon, select each adapter in turn, and:

a) Click Schedule....

b) From the list of available schedules, select the one for each adapter.

c) Click OK.

d) Ensure that the adapter is marked as Enabled.

e) Repeat for the other adapter.

14. At the bottom of the inventory beacon interface, click Save to store your changes.

15. Optionally, if you have test data waiting for a system check, you can select each adapter in turn, and click Execute Now.

The Business Importer takes the raw data from XML files, transforms it into the formats required for FlexNet Manager Suite, and uploads it to the central application server.

To check the status of imports, navigate to the system menu (є in the top right corner) of the web interface for FlexNet Manager Suite and choose either Data Inputs (in the Business Data tab) or System Health > System Tasks.

**Tip** • If you need to interrupt the export from ServiceNow, disable the scheduled jobs in ServiceNow, and disable the relevant schedule(s) in FlexNet Beacon.

---

**Setting up Data Flows from FlexNet Manager Suite to ServiceNow**

For records of applications and hardware inventory, FlexNet Manager Suite is considered the authoritative source of truth. Data on applications and inventory, as well as contracts, can be exported from FlexNet Manager Suite to ServiceNow. In summary, the process is:

1. On the batch server for FlexNet Manager Suite, a Microsoft scheduled task Export to ServiceNow initiates the process.
2. The scheduled task launches an exporter utility for FlexNet Manager Suite which extracts the appropriate data and transfers it to ServiceNow using API calls.

3. In ServiceNow, the FlexNet Manager Suite Integration application processes the data received through the API calls, and schedules imports of that data using the ServiceNow Import Set.

   
   **Tip** • The Transform Maps used during import to switch data from one product’s formats to the other are also defined in the integration application.

If you wish to make use of this data flow, you need to complete the following processes:

- **Configuring ServiceNow for Import** on page 179
- **Configuring FlexNet Manager Suite for Export** on page 180.
- Optionally, you may customize the export from FlexNet Manager Suite using the guidelines in **Configure the Utility for Export from FlexNet Manager Suite** on page 182.

### Configuring ServiceNow for Import

Continue the following while still (or again) logged into ServiceNow with administrator privileges:

1. In the ServiceNow navigation bar, expand FlexNet Manager Suite and Advanced, and click OAuth.

2. In the Application Registries page, click FNMS OAuth Provider. The OAuth provider details are displayed.

3. On the right side, for the Token URL control, click the padlock icon to allow editing, and replace the YOUR-INSTANCE placeholder with the name of your ServiceNow instance (visible in your browser URL field). When done, click the padlock icon again.

4. Repeat that editing process for the Redirect URL, replacing YOUR-INSTANCE with your ServiceNow instance name.

5. Scroll to the bottom of the page, and click Update.

6. In the FlexNet Manager Suite group in the navigation bar, click Generate Token.

7. From the account details you created earlier (see **Creating a ServiceNow User** on page 173), insert the user ID in the Username field and supply the Password, and click Generate OAuth Token. A long Refresh Token appears at the top of the page.

8. Copy this Refresh Token value, and transfer to the web interface of FlexNet Manager Suite.

   **Important** • As configured immediately after installation, the integration application does not allow records that are marked for deletion in FlexNet Manager Suite to be deleted in ServiceNow. This prevents any surprise or accidental deletions during testing and configuration. However, in production, since you have set FlexNet Manager Suite as the source of truth for hardware inventory and application installations, the normal practice would be to allow records in ServiceNow to be removed automatically once marked for deletion in FlexNet Manager Suite. To modify the settings, continue with the next steps.
9. When ready to go into production, and as aligned with your corporate policies, decide whether to allow records in ServiceNow to be deleted once they have been deleted in FlexNet Manager Suite. To do this:
   a) In ServiceNow, navigate to FlexNet Manager Suite > Advanced > Integration Properties.
   b) In that page, set the check box for Set this to YES to delete inventory in ServiceNow if it is deleted in FNMS. This allows hardware inventory records to be deleted in ServiceNow when you have deleted them from FlexNet Manager Suite.
   c) Similarly, set the check box for Set this to YES to delete installation in ServiceNow if it is deleted in FNMS. This allows application installation records to be deleted in ServiceNow when you have deleted them from FlexNet Manager Suite.
   d) Click Save at the bottom of that page.

Configuring FlexNet Manager Suite for Export

You need to complete this configuration once to commence operations. Repeat if your ServiceNow details change at any time in the future. You may also use this same page to trigger an immediate export from FlexNet Manager Suite to ServiceNow.

1. Ensure that you are (still) logged into FlexNet Manager Suite with an account that is a member of the Administrator role, and that this account has the Configure access right.

2. In the web interface, navigate to the system menu ( in the top right corner) > System Settings, and select the ServiceNow tab.

   Tip • The ServiceNow tab is only visible when your account has the access rights described above.

3. In Instance URL, enter the protocol and path to your ServiceNow website (for example, https://YOUR-INSTANCE.service-now.com).

4. In Username, enter the account you use to access ServiceNow. This must exactly match the User ID value shown in the ServiceNow interface (see Creating a ServiceNow User on page 173).

5. Paste the Token value from ServiceNow into the Token field on this page (see Configuring ServiceNow for Import on page 179).

   Tip • The Username is mandatory for FlexNet Manager Suite to commence the export process, but it is not transferred back to ServiceNow, as the Token value alone is now sufficient for authentication.

   Note • In future, if you wish to temporarily disable these data exports from FlexNet Manager Suite, you can either disable the edit the Windows scheduled task Export to ServiceNow or remove any one or more values from Instance URL, Username, or Token.
6. If necessary, change the default selection of data types to export to ServiceNow. It is best practice to export all available data types.

**Warning** • Hardware inventory details are critical to the ServiceNow data set. Contracts and applications both have dependencies on assets in that system. If you clear the Hardware inventory check box, you may produce gaps in the contract and software records imported into ServiceNow.

7. Click **Save**.

When details are complete, the export from FlexNet Manager Suite to ServiceNow is triggered weekly at 3am on Sunday mornings by default (if required, you may edit the Windows scheduled task Export to ServiceNow to modify the schedule). If you need to trigger an additional export (for example, when commencing integrated operations), continue with the rest of this process.

**Tip** • While the first export of any given data type is always a full export of all relevant data, subsequent data transfers from FlexNet Manager Suite to ServiceNow are differential (that is, only data that is new or changed since the last export of the same type is included). If you wish to make your additional export transfer all available data (rather than the differential data set), select the **Perform full export** check box before continuing.

8. Optionally, click **Export** to trigger an immediate export using the settings saved in the fields displayed above.

**Tip** • The export from FlexNet Manager Suite to ServiceNow is delayed if any of the following processes are already running:

- A previous instance of the export to ServiceNow
- An inventory import
- A license reconciliation.

The **Export** button, and the scheduled task, trigger the command-line executable fnmp_servicenow_export.exe, which:

- Extracts the required data of the first data type from your operations database (the normal order when all are selected is inventory, contracts, applications)
- Segments the data for easier transmission across the Internet, minimizing time-out risks with ServiceNow
- Reassembles the data into staging tables in ServiceNow
- Repeats the process for the next selected data type.

Separate transforms on your ServiceNow instance then map each data type from the staging tables to your operational ServiceNow CMDB.
To verify progress of a test run:

1. In the ServiceNow navigation bar, expand **FlexNet Manager Suite > Import Transactions**. Each of these transactions represents a data chunk* or segment transferred to ServiceNow. The segmentation is necessary because of the large number of records that may need to be transferred. When the data is received by ServiceNow, the integration application separately schedules each transaction for import into the operational database tables in ServiceNow. As each transaction is completely imported, its **State** column value is set to **Succeeded**.

2. Similarly, navigate to **FlexNet Manager Suite > Import Runs**. Each data type exported from FlexNet Manager Suite creates a separate entry here for import into ServiceNow. For each data type, when all its individual transactions have succeeded, the **State** value on the overall Import Run is also set to **Succeeded**.

3. Finally, when all the data types transferred have been successfully imported, a status report is sent to FlexNet Manager Suite. On the **System Settings** page in the **ServiceNow** tab, the status is displayed under **Last completed export**.

* The default configuration for data transfers from FlexNet Manager Suite to ServiceNow uses these values:
  
  - The number of database records included in each transferred segment: 8000
  - The number of retries if ServiceNow returns a connection failure: 10
  - The length of time to wait for ServiceNow to respond before timing out: 30 seconds
  - The maximum number of records of each data type to be included in the transfer, by type:
    - Inventory: 500,000
    - Contracts: 500,000
    - Applications: 2,000,000.

For details of configuring these additional elements in an on premises implementation, see **Configure the Utility for Export from FlexNet Manager Suite** on page 182.

### Configure the Utility for Export from FlexNet Manager Suite

Optionally, the configuration file for the export utility may be customized to suit your environment.

Several settings for the utility for exporting data from FlexNet Manager Suite are configurable, including:

- The maximum number of records for each data type (applications, contracts, and inventory) that may be transferred to ServiceNow in each export
- The maximum number of records in each data segment or ‘chunk’ transferred
- Log file location
• Maximum retries after failure of a web request.

All reside in one configuration file, called `fnmp_servicenow_export.exe.config`, located in the same folder as the executable `fnmp_servicenow_export.exe` (which performs the data export from FlexNet Manager Suite to ServiceNow) on your batch server (or, in a smaller implementation, the server hosting the equivalent functionality). The default path is `installation-directory\DotNet\bin\ServiceNowExport`.

1. Save a backup copy of the configuration file, for example as `fnmp_servicenow_export.exe.config.orig`, so that you can revert if there are problems.
2. Open the configuration file `fnmp_servicenow_export.exe.config` in your preferred XML or plain text editor. (Do not edit in a word processor that cannot save plain text files.)
3. Optionally, customize the values for data segmentation, retries, and timeout when the executable is accessing ServiceNow.

<table>
<thead>
<tr>
<th>Path/element</th>
<th>Attribute</th>
<th>Default</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;configuration&gt;</code></td>
<td><code>maxRetries</code></td>
<td>&quot;10&quot;</td>
<td>When ServiceNow is not responding, the executable will retry each connection (one for each data segment being transferred) this many times. If this number of retries is reached for any data segment, the export fails. Each successful connection resets the count to zero. (If this attribute is omitted, the executable uses a default value of 10.)</td>
</tr>
<tr>
<td><code>&lt;configuration&gt;</code></td>
<td><code>timeout</code></td>
<td>&quot;30000&quot;</td>
<td>The maximum number of milliseconds to wait for a response from ServiceNow. This timer is applied independently to each connection request (at least one per data segment being transferred). If ServiceNow does not respond within this interval (default 30 seconds), a new request is issued (up to <code>maxRetries</code>). (If this attribute is omitted, the executable uses a default value of 30000.)</td>
</tr>
<tr>
<td><code>&lt;configuration&gt;</code></td>
<td><code>maxRows</code></td>
<td>&quot;500000&quot;</td>
<td>Specifies the maximum number of application records that can be exported in a single export.</td>
</tr>
<tr>
<td><code>&lt;configuration&gt;</code></td>
<td><code>maxRows</code></td>
<td>&quot;500000&quot;</td>
<td>Specifies the maximum number of contract records that can be exported in a single export.</td>
</tr>
</tbody>
</table>
### Installation and Configuration

<table>
<thead>
<tr>
<th>Path/element</th>
<th>Attribute</th>
<th>Default</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;contract /&gt;</code></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>&lt;configuration&gt;</code></td>
<td><code>&lt;fnmpGroup&gt;</code></td>
<td><code>&lt;fnmp&gt;</code></td>
<td><code>&lt;inventory /&gt;</code></td>
</tr>
<tr>
<td><code>&lt;configuration&gt;</code></td>
<td><code>&lt;fnmpGroup&gt;</code></td>
<td><code>&lt;fnmp&gt;</code></td>
<td><code>&lt;records /&gt;</code></td>
</tr>
</tbody>
</table>

4. Optionally, configure the location for your log files.

<table>
<thead>
<tr>
<th>Path/element</th>
<th>Attribute</th>
<th>Default</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;configuration&gt;</code></td>
<td><code>&lt;log4net&gt;</code></td>
<td><code>&lt;appender&gt;</code></td>
<td><code>&lt;file /&gt;</code></td>
</tr>
</tbody>
</table>

With the other default values for the elements under appender, multiple passes on the same date append to the end of the log file, and a new log file is commenced each day.
Operational Details

Topics:

• Process for Exports from ServiceNow to FlexNet Manager Suite
• Process for Exports from FlexNet Manager Suite to ServiceNow

Standard operation is automatic.

The exchange of data between ServiceNow and FlexNet Manager Suite happens in a pair of independent processes driven by schedules (either Windows scheduled tasks or schedules built in to the products).

As these schedules by default run on a weekly cycle, you may expect the data to be synchronized after the weekly runs and up until either system is subsequently updated. If you require an intermediate synching after an important update to one system or the other, you can also trigger either process manually.

The process flows are described in detail in the following topics. Notes about configuration and customization are included.

For your on premises implementation of FlexNet Manager Suite, the command-line utility is also documented here, should you choose to run that directly.
Process for Exports from ServiceNow to FlexNet Manager Suite

Here is how the import of data from ServiceNow works.

Prerequisites

- You have licensed the option for ServiceNow integration from Flexera Software. As previously mentioned (see Prerequisites on page 168), this license authorizes all communications through the integration package.
- You have loaded the XML customization into your ServiceNow instance (see Installing the ServiceNow Application for FlexNet Manager Suite on page 172).
- Your MID server (Setting up a MID Server on page 174) is accessible across the network from your inventory beacon, and read permissions have been set on the file share on the MID server for the accounts used on the inventory beacon (Configuring FlexNet Beacon for Import on page 176).
- The two supplied business adapters for reading asset data and contract data from ServiceNow are configured on your inventory beacon.

Process Details

1. Two scheduled reports are run independently in ServiceNow.

   Note • These reports are visible in System Definition > Scheduled Jobs as Export Assets from ServiceNow and Export Contracts from ServiceNow. Click the report names to make them active or inactive, to modify the schedule, or to execute either one immediately.

2. When either report is triggered:

   a. ServiceNow adds a record in the FlexNet Manager Suite > Export Runs view (for information about the main columns, see Export Runs Properties on page 187).

   b. Database views gather the required data in ServiceNow. These views are accessible in the FlexNet Manager Suite > Advanced > Database Views page:

      - For assets, the view x_fls-flexera_fnms_asset reads from the alm_hardware, cmdb_ci_computer, and sys_user database tables.
      - For contracts, the view x_fls-flexera_fnms_contract reads from the cmdb_model and ast_contract database tables.

   Tip • To preview the records for an export (without actually invoking the export), click the view name in that page to display the properties of the view; and under the Related Links heading, click Try It.
c. In the installation folder of your MID server, any previous XML file is overwritten, replaced with the opening tags for the new XML file. This XML file is named for the database view used to extract its data.

d. Data is transferred to the MID server in segments (to prevent time-out issues with large files), and gradually assembled into the XML file.

e. The closing tags for the XML file are written.

f. In Export Runs, ServiceNow updates the state to Succeeded.

3. Two independent business adapters from FlexNet Manager Suite (on potentially independent schedules) connect from your inventory beacon to your MID server, and collect the latest XML files saved there, converting them into the intermediate data form required for business data uploads. (For details of the mapping between source data in ServiceNow and destination fields in the FlexNet Manager Suite database, see Business Adapter Mappings on page 188.)

---

Important • The business adapters will fail if they are run while the XML files on the MID server are incomplete. Be sure that the schedules for export from ServiceNow, and the running of the business adapters, allow sufficient time for the export to be completed. For large datasets, this may be several hours.

---

4. As the adapters complete their run, the dataset is uploaded immediately to the application server for FlexNet Manager Suite. (There is also a catch-up upload task that runs overnight to retry any failed uploads.)

5. On a separate schedule, the batch server starts a business import job. This imports data from the data package into the FlexNet Manager Suite database.

At the completion of this process, data exported from ServiceNow is reflected in your FlexNet Manager Suite data set.

Export Runs Properties

These are the major properties of the entries in the FlexNet Manager Suite > Export Runs view created as ServiceNow commences each data export.

<table>
<thead>
<tr>
<th>Column</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>An automatically-generated sequential numbering of each created record in this listing.</td>
</tr>
<tr>
<td>Export Type</td>
<td>The type of data being exported, either Contract or Asset.</td>
</tr>
<tr>
<td>Stage</td>
<td>May have the following values:</td>
</tr>
<tr>
<td></td>
<td>• File Creation — Displayed when the integration application sends the opening XML tag to the MID Server to be commence writing the XML file.</td>
</tr>
</tbody>
</table>
### Column

<table>
<thead>
<tr>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Data Collection — Displayed while the integration application gathers the data and sends it to MID Server to be written into the XML file. The data is sent in multiple chunks of 500 records each.</td>
</tr>
<tr>
<td>• File Completion — Displayed when the closing XML tag has been sent to the MID Server.</td>
</tr>
</tbody>
</table>

### State

Provides additional insight into the Data Collection stage in particular. Values include:

<table>
<thead>
<tr>
<th>State</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>• New</td>
<td>This default state is set when a record is created in the Export Runs listing.</td>
</tr>
<tr>
<td>• Processing</td>
<td>The integration application is reading from the ServiceNow database and compiling a chunk of data.</td>
</tr>
<tr>
<td>• Processed</td>
<td>All database records required for the current chunk (maximum: 500) have been prepared.</td>
</tr>
<tr>
<td>• Waiting</td>
<td>The data chunk is being transferred to the MID server.</td>
</tr>
<tr>
<td>• Ready</td>
<td>The MID server has notified that the data chunk has been added to the XML file. At this point, the integration application sets the state back to Processing and prepares the next chunk of data.</td>
</tr>
<tr>
<td>• Succeeded</td>
<td>All data chunks have been transferred, and no more are required.</td>
</tr>
<tr>
<td>• Failed</td>
<td>For some reason (unspecified here), the export has failed.</td>
</tr>
</tbody>
</table>

### Counter

The number of database records that the integration application has read and processed. Because the data is transferred to the MID server in a number of chunks, the counter value is used as a cursor for reading the correct records from the database for the next data chunk.

---

**Business Adapter Mappings**

Two business adapters are supplied as a standard part of the ServiceNow integration package for FlexNet Manager Suite, and are used in the process of transferred asset and contract data from ServiceNow to FlexNet Manager Suite. The following lists show the source data from ServiceNow, and the target (destination) fields in FlexNet Manager Suite, for each of these adapters in turn.

**Tip** • For special purposes, mappings can be added, removed, or changed by editing the business adapter(s) in Business Adapter Studio on your inventory beacon.
In each listing, the first field shown is used for matching existing records (a key). During import, if the value in this field already exists in the compliance database, the record is updated with the other values imported for this item. Otherwise, a new record is automatically created in FlexNet Manager Suite.

In both listings below, "display" names are the names visible in the two products' web interfaces; and the **Source Field** column shows a compound name made up of:

- An abbreviated reference to a ServiceNow database table name (see below)
- An underscore character
- The field name in the relevant database table (which name may contain additional underscores).

The mapping of the abbreviated references to the actual database table names in the ServiceNow database is:

- `acntrct` represents `ast_contract`
- `ahrdwr` represents `alm_hardware`
- `cicomp` represents `cmdb_ci_computer`
- `cmdbmdl` represents `cmdb_model`
- `sysusr` represents `sys_user`.

### Assets Imports

- **Business adapter file name:** ServiceNowAssets.xml
- **Original data source:** ServiceNow database view `x_flx_flexera_fnms_asset`
- **Destination table in FlexNet Manager Suite database:** Asset

<table>
<thead>
<tr>
<th>Source Display Name</th>
<th>Source Field</th>
<th>Target Display Name</th>
<th>Target Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>Serial number</td>
<td>cicomp_serial_number</td>
<td>Serial Number</td>
<td>SerialNumber (key)</td>
</tr>
<tr>
<td>Asset tag</td>
<td>ahrdwr_asset_tag</td>
<td>Asset Tag</td>
<td>AssetTag</td>
</tr>
<tr>
<td>Configuration Item</td>
<td>ahrdwr_ci</td>
<td>Name</td>
<td>ShortDescription</td>
</tr>
<tr>
<td>Installed</td>
<td>cicomp_install_date</td>
<td>Installed on</td>
<td>InstallationDate</td>
</tr>
<tr>
<td>Manufacturer</td>
<td>cicomp_manufacturer</td>
<td>Manufacturer</td>
<td>Manufacturer</td>
</tr>
<tr>
<td>Model number</td>
<td>cicomp_model_number</td>
<td>Model</td>
<td>ModelNo</td>
</tr>
<tr>
<td>Status</td>
<td>ahrdwr_install_status</td>
<td>Status</td>
<td>AssetStatusID [Note 1]</td>
</tr>
</tbody>
</table>

**Notes:**

1. **AssetStatusID** is a foreign key to the AssetStatus table, from which display values are drawn.

---

**Note** • **AssetStatusID** is a mandatory field for asset records in FlexNet Manager Suite. If a record in ServiceNow has a **Status** value that does not exist in FlexNet Manager Suite:
• The new status value is inserted into the AssetStatus table (you may also need to customize localized values of this status, if other languages are in use within your enterprise)

• An AssetStatusID is automatically created for this new entry

• The AssetStatusID is inserted into the asset record.

If you are 'round-tripping' this data (that is, copying it back from FlexNet Manager Suite to ServiceNow at some future point, to maintain synchronization), the new value is returned when appropriate.

Contracts Imports

• Business adapter file name: ServiceNowContracts.xml

• Original data source: ServiceNow database view x_flx_flexera_fnms_contract

• Destination table in FlexNet Manager Suite database: Contract

<table>
<thead>
<tr>
<th>Source Display Name</th>
<th>Source Field</th>
<th>Target Display Name</th>
<th>Target Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contract number</td>
<td>acntrct_vendor_contract</td>
<td>Contract no.</td>
<td>ContractNo (key)</td>
</tr>
<tr>
<td>Description</td>
<td>acntrct_description</td>
<td>Information</td>
<td>Comments</td>
</tr>
<tr>
<td>Display name</td>
<td>cmdbmdl_display_name</td>
<td>Contract type</td>
<td>ContractTypeID [Note 1]</td>
</tr>
<tr>
<td>Ends</td>
<td>acntrct_ends</td>
<td>Expiry date</td>
<td>EndDate</td>
</tr>
<tr>
<td>Short description</td>
<td>acntrct_short_descrip</td>
<td>Description</td>
<td>ContractName</td>
</tr>
<tr>
<td>Starts</td>
<td>acntrct_starts</td>
<td>Start date</td>
<td>StartDate</td>
</tr>
<tr>
<td>State</td>
<td>acntrct_state</td>
<td>Status</td>
<td>ContractStatusID [Note 2]</td>
</tr>
</tbody>
</table>

Notes:

1. ContractTypeID is a foreign key to the ContractType table, from which display values are drawn. Also see note below.

2. ContractStatusID is a foreign key to the ContractStatus table, from which display values are drawn.

**Note** • ContractTypeID is a mandatory field for contract records in FlexNet Manager Suite. If a record in ServiceNow has a Display name value that does not exist in FlexNet Manager Suite:

• The new contract type is inserted into the ContractType table (you may also need to customize localized values of this type, if other languages are in use within your enterprise)

• An ContractTypeID is automatically created for this new entry

• The ContractTypeID is inserted into the contract record.
If you are 'round-tripping' this data (that is, copying it back from FlexNet Manager Suite to ServiceNow at some future point, to maintain synchronization), the new value is returned when appropriate.

Process for Exports from FlexNet Manager Suite to ServiceNow

Prerequisites

- You have licensed the option for ServiceNow integration from Flexera Software. As previously mentioned (see Prerequisites on page 168), this license authorizes these exports, as well as all other communications through the integration package.
- The utility `fnmp_servicenow_export.exe` is installed in `installation-directory\DotNet\bin\ServiceNowExport` (see Prerequisites on page 168).
- The configuration file `fnmp_servicenow_export.exe.config` is installed in the same directory, and customized to your requirements (for example, for logging).
- A Windows scheduled task `Export to ServiceNow` is configured to trigger the utility (by default, weekly at 3am on Sunday morning).
- The "emergency switch" has not been turned off to interrupt exports (this is a value in the ComplianceSettings database table, EnableServiceNowExport). Naturally, this defaults to on, allowing exports.

Process Details

1. On your central application server, the scheduled task triggers the utility (`fnmp_servicenow_export.exe`).

   **Tip** • If you are in an administrator role, you can also trigger an export through the web interface for FlexNet Manager Suite. Navigate to the system menu (⌘ ▼ in the top right corner) System Settings > ServiceNow.

   The executable performs the following checks:

   - It validates all the command-line parameters. If validation fails, it exits with code 4 on the command line, or shows an error in the web interface (under Last completed export on the same page).

   - It checks for a valid license from Flexera Software for the ServiceNow integration option. If the license is not found, it exits with code 3 on the command line, or shows an error in the web interface.

   - It checks the connection to ServiceNow, passing the credentials you have configured. (Failure writes an exit code of 2 to the command line.) If the credentials are good, ServiceNow passes back a connection code. If the command-line parameter `-connectionTest` is true, the executable exits with code 0 on the command line, and the process ends at this point.

2. The utility checks whether ServiceNow is able to accept an import at this time:
• It checks whether a record in Scheduled Data Imports, and another in Data Sources, have been created by the integration application. (Links to the relevant pages where you can inspect the records in ServiceNow are under FlexNet Manager Suite >Advanced.)

• It ensures that no prior import is already in process, checking that there is no record in the Import Runs table or the Import Transactions table that are incomplete (that is, have a State other than Succeeded or Failed). Both lists are available for inspection in the FlexNet Manager Suite group.

If either of the checks fails, the utility abandons the export and displays an appropriate error.

3. The utility checks the connection with the operations databases for FlexNet Manager Suite. (If there is any failure, the utility abandons the export and displays an appropriate error.)

4. All being well, the data export, transfer, and import processes are run for all data types (unless any of them have been specifically excluded) in the following order:
   a. Hardware inventory and assets
   b. Contracts
   c. Applications and installation details.

Caution • In ServiceNow, contracts and applications/installations both have dependencies on computers/assets. It is recommended that you do not exclude the hardware inventory and asset transfer, as this may result in unpredictable gaps in other records when the correct dependencies cannot be established.

The data is collected in the way specified by the command-line options, for which see Command-line Tool for Export to ServiceNow on page 199. To prevent timeout issues, each data set is split into segments for transfer to ServiceNow. Each segment is identified with a transaction id, transaction type, and the data in an XML file. ServiceNow returns a connection code for each segment of data.

• If the connection code shows a failure, the segment is retransmitted for a maximum number of tries (the default value of 10 can be changed in the configuration file), after which the utility exits (skipping any remaining exports) and returns 1 to the command line.

• While success continues, the utility waits for each stage to complete before commencing the next stage (although it does not wait for a result after the last segment of application data is uploaded).

5. In ServiceNow, as the first data segment is received, the integration application creates a record in the Import Runs table. (For details of the main columns in the Import Runs table, see Import Runs Properties on page 194.)

6. For each data segment (including the first), ServiceNow creates a record in the Import Transactions table. (For details of the main columns in the Import Transactions table, see Import Transactions Properties on page 194.)

7. When the transaction record is created, it returns a success code to FlexNet Manager Suite, which then processes and transmits the next data segment. This loop continues until all the records of a particular export type have been transmitted.

8. In ServiceNow, the inbound data segments are written to staging tables (visible in the navigation panel under FlexNet Manager Suite) based on the transaction type:
9. In ServiceNow, the integration application uses the Scheduled Data Imports and Data Sources records to process each Import Transaction record. The integration application queues the transaction records, and as each record is processed sets its State to Succeeded. When all the transaction records for an Import Run are completed, the integration application also sets the State to Succeeded.

10. During this processing loop, FlexNet Manager Suite continues polling the API for status. Only when it receives a successful completion message does it resume the process with the next required data type.

11. When the data has been collated from the individual transactions to the staging tables, Transform Maps are executed to map the fields in the import set tables to fields in ServiceNow database tables. The final tables for data from each transaction type are shown below. (For a complete set of the transform mappings, see Transform Maps for ServiceNow Integration on page 195.)

<table>
<thead>
<tr>
<th>Transaction type</th>
<th>Ultimate Data Tables in ServiceNow</th>
</tr>
</thead>
<tbody>
<tr>
<td>application_export</td>
<td>Software Models, Discovery Models, and Software Installations (all in the Software Asset Management group). The process updates the tables in the order above, as later tables reference the previous one.</td>
</tr>
<tr>
<td>contract_export</td>
<td>Contracts (Navigate to Contracts Management &gt; Contracts &gt; All)</td>
</tr>
<tr>
<td></td>
<td>![Tip](Note that this is hardware inventory)</td>
</tr>
<tr>
<td></td>
<td><strong>Tip</strong> • Check the Contract used by field near the bottom of the page of contract properties. This references all computers linked to the contract.</td>
</tr>
<tr>
<td>inventory_export</td>
<td>Computers (Navigate to Computers Table.Configuration &gt; Base Items &gt; Computers)</td>
</tr>
</tbody>
</table>

12. When all the data has been transformed into the ServiceNow database, a check is made of the system properties controlling deletion of records. These are visible in FlexNet Manager Suite > Advanced > Integration Properties page, as check boxes for Set this to YES to delete dataType in ServiceNow if it is deleted in FNMS (where dataType is either inventory (hardware) or installation (of applications). When true (expected for normal operations, but requiring your configuration as described in Installing the ServiceNow Application for FlexNet Manager Suite on page 172), all the affected tables in ServiceNow are checked for...
items on which the data flag `u_fnmp_isdeleted` has been raised by FlexNet Manager Suite. These items are now deleted to bring the data sets into alignment.

**Tip** • If you do an initial import (which is always a full import rather than a differential one) with these preferences turned off, the records of computers deleted in FlexNet Manager Suite are not created in ServiceNow. If you subsequently turn these options on to make FlexNet Manager Suite the source of truth for hardware inventory and application installations, you should force another full export so that any records already in ServiceNow but marked for deletion in FlexNet Manager Suite are cleaned up.

At the completion of this process, data exported from FlexNet Manager Suite is reflected in your ServiceNow data set.

### Import Runs Properties

These are the major properties of the entries in the **FlexNet Manager Suite** > **Import Runs** view created as ServiceNow commences each data import.

<table>
<thead>
<tr>
<th>Column</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>An automatically-generated sequential numbering of each created record in this listing.</td>
</tr>
<tr>
<td>Import Id</td>
<td>A GUID created by FlexNet Manager Suite as it exports the data, used to track activity and exchanges for this particular import into ServiceNow.</td>
</tr>
<tr>
<td>Import Type</td>
<td>The type of data being imported, being one of <strong>Asset</strong> (for inventory data), <strong>Contract</strong>, or <strong>Application</strong>.</td>
</tr>
<tr>
<td>State</td>
<td>Values include:</td>
</tr>
<tr>
<td></td>
<td>• New — This default state is set when a record is created in the <strong>Import Runs</strong> listing.</td>
</tr>
<tr>
<td></td>
<td>• Waiting — ServiceNow has received the final data chunk for the particular <strong>Import Type</strong>.</td>
</tr>
<tr>
<td></td>
<td>• Succeeded — All data chunks for this <strong>Import Run</strong> have been processed by ServiceNow.</td>
</tr>
<tr>
<td></td>
<td>• Failed — For some reason (unspecified here), the import has failed.</td>
</tr>
</tbody>
</table>

### Import Transactions Properties

These are the major properties of the entries in the **FlexNet Manager Suite** > **Import Transactions** view created as ServiceNow receives each data segment for import.
### Transform Maps for ServiceNow Integration

These transform maps map hardware, license, and contract data collected from FlexNet Manager Suite into ServiceNow.

Data collected from FlexNet Manager Suite is initially held in staging tables within ServiceNow, and must be transformed for insertion in the operational tables in your ServiceNow implementation. For example, the FNMP Inventory Imports set has columns that are matched with the Computers table in ServiceNow. Contract data is first mapped into the Contracts table in ServiceNow, and a second Transform Map is run to provide links to relevant Configuration Items (Computers).

The following tables show the standard transformations from the staging tables (the source) to operational tables (the target) within ServiceNow. Items marked [Script] involve a data transformation, which may involve finding the foreign key to another record, or conversion of units such as bytes to MB.

In each transform, the "(key)" fields are used for record matching. If a record already exists with identical values for fields so marked, it is updated; and if not, a new record is created.

**Note** • There are specialized properties (three for the computer transforms, and two for the remainder) that define:

- Whether a new record should be created in ServiceNow when a match for incoming data is not found
- Whether an existing record should be updated when a match is found

<table>
<thead>
<tr>
<th>Column</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>An automatically-generated sequential numbering of each created record in this listing.</td>
</tr>
<tr>
<td>Import Run</td>
<td>The ID of the import run of which this transaction is a part.</td>
</tr>
<tr>
<td>Import Type</td>
<td>The type of data being imported, being one of Asset (for inventory data), Contract, or Application.</td>
</tr>
<tr>
<td>State</td>
<td>Values include:</td>
</tr>
<tr>
<td></td>
<td>• New — This default state is set when a record is created in the Import Transactions listing.</td>
</tr>
<tr>
<td></td>
<td>• Waiting — ServiceNow is processing another transaction received earlier.</td>
</tr>
<tr>
<td></td>
<td>• Processing — Set when the integration application invokes import of this transaction.</td>
</tr>
<tr>
<td></td>
<td>• Succeeded — ServiceNow has completed the import of this transaction.</td>
</tr>
<tr>
<td></td>
<td>• Failed — For some reason (unspecified here), the import of the transaction has failed.</td>
</tr>
<tr>
<td>Payload</td>
<td>The segment of data, in XML format, that makes up this transaction.</td>
</tr>
</tbody>
</table>


• *(For computer transforms only)* whether a record marked for deletion in FlexNet Manager Suite should be deleted from ServiceNow.

*These properties can be modified in ServiceNow by navigating to FlexNet Manager Suite > Advanced > Integration Properties. For more information, see Configuring ServiceNow for Export on page 174 (final step).*

**Computer Transform**

• Original data from FlexNet Manager Suite: Inventory.

• Staging table in ServiceNow: cmdb_ci_computer

<table>
<thead>
<tr>
<th>Source Display Name</th>
<th>Source Field</th>
<th>Target Display Name</th>
<th>Target Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>SerialNo (key)</td>
<td>u_serialno</td>
<td>Serial number</td>
<td>serial_number</td>
</tr>
<tr>
<td>[Script]</td>
<td>[Script]</td>
<td>RAM (MB)</td>
<td>ram</td>
</tr>
<tr>
<td>[Script]</td>
<td>[Script]</td>
<td>Correlation ID</td>
<td>correlation_id</td>
</tr>
<tr>
<td>[Script]</td>
<td>[Script]</td>
<td>Disk space (GB)</td>
<td>disk_space</td>
</tr>
<tr>
<td>AssetID</td>
<td>u_assetid</td>
<td>FlexNet Asset ID</td>
<td>x_fls_flexera_fnms_asset_id</td>
</tr>
<tr>
<td>CalculatedUser</td>
<td>u_calculateduser</td>
<td>Calculated User</td>
<td>x_fls_flexera_fnms_calculated_user</td>
</tr>
<tr>
<td>ChassisType</td>
<td>u_chassistype</td>
<td>Chassis type</td>
<td>chassis_type</td>
</tr>
<tr>
<td>ComputerID</td>
<td>u_computerid</td>
<td>FlexNet Computer ID</td>
<td>x_fls_flexera_fnms_computer_id</td>
</tr>
<tr>
<td>ComputerName</td>
<td>u_computername</td>
<td>Name</td>
<td>name</td>
</tr>
<tr>
<td>ComputerStatus</td>
<td>u_computerstatus</td>
<td>Status (hardware_status)</td>
<td>hardware_status</td>
</tr>
<tr>
<td>ComputerType</td>
<td>u_computertype</td>
<td>Subcategory</td>
<td>subcategory</td>
</tr>
<tr>
<td>DiscoveredDate</td>
<td>u_discovereddate</td>
<td>Discovered date</td>
<td>x_fls_flexera_fnms_discovered_date</td>
</tr>
<tr>
<td>Domain</td>
<td>u_domain</td>
<td>Domain</td>
<td>sys_domain</td>
</tr>
<tr>
<td>InventoryConnection</td>
<td>u_inventoryconnection</td>
<td>Inventory Connection</td>
<td>x_fls_flexera_fnms_inventory_connection</td>
</tr>
<tr>
<td>InventorySource</td>
<td>u_inventorysource</td>
<td>Inventory Source</td>
<td>x_fls_flexera_fnms_inventory_source</td>
</tr>
<tr>
<td>IPAddress</td>
<td>u_ipaddress</td>
<td>IP Address</td>
<td>ip_address</td>
</tr>
<tr>
<td>IsDeleted</td>
<td>u_isdeleted</td>
<td>Is deleted</td>
<td>x_fls_flexera_fnms_isdeleted</td>
</tr>
<tr>
<td>LastLoggedInUser</td>
<td>u_lastloggeduser</td>
<td>Last logged in user</td>
<td>x_fls_flexera_fnms_last_logged_in_user</td>
</tr>
<tr>
<td>MACAddress</td>
<td>u_macaddress</td>
<td>MAC Address</td>
<td>mac_address</td>
</tr>
<tr>
<td>Manufacturer</td>
<td>u_manufacturer</td>
<td>Manufacturer</td>
<td>manufacturer</td>
</tr>
<tr>
<td>MaxClockSpeed</td>
<td>u_maxclockspeed</td>
<td>CPU speed (MHz)</td>
<td>cpu_speed</td>
</tr>
</tbody>
</table>
### Computer Model Transform

- Original data from FlexNet Manager Suite: Inventory.
- Staging table in ServiceNow: cmdb_model

<table>
<thead>
<tr>
<th>Source Display Name</th>
<th>Source Field</th>
<th>Target Display Name</th>
<th>Target Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>ModelNo</td>
<td>u_modelno</td>
<td>Model number</td>
<td>model_number</td>
</tr>
<tr>
<td>ChassisType</td>
<td>u_chassistype</td>
<td>Type</td>
<td>type</td>
</tr>
<tr>
<td>ComputerType</td>
<td>u_computertype</td>
<td>Model categories</td>
<td>cmdb_model_category</td>
</tr>
<tr>
<td>Manufacturer</td>
<td>u_manufacturer</td>
<td>Manufacturer</td>
<td>manufacturer</td>
</tr>
<tr>
<td>ModelNo</td>
<td>u_modelno</td>
<td>Name</td>
<td>name</td>
</tr>
</tbody>
</table>

### Contracts Transform

- Original data from FlexNet Manager Suite: Contracts.
- Staging table in ServiceNow: ast_contract

<table>
<thead>
<tr>
<th>Source Display Name</th>
<th>Source Field</th>
<th>Target Display Name</th>
<th>Target Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>ContractNumber (key)</td>
<td>u_contractnumber</td>
<td>Contract number</td>
<td>vendor_contract</td>
</tr>
<tr>
<td>ContractName</td>
<td>u_contractname</td>
<td>Description</td>
<td>short_description</td>
</tr>
<tr>
<td>ContractStatus</td>
<td>u_contractstatus</td>
<td>State</td>
<td>state</td>
</tr>
<tr>
<td>ContractType</td>
<td>u_contracttype</td>
<td>Short Description</td>
<td>short_description</td>
</tr>
<tr>
<td>EndDate</td>
<td>u_enddate</td>
<td>Ends</td>
<td>ends</td>
</tr>
<tr>
<td>IsDeleted</td>
<td>u_isdeleted</td>
<td>Is deleted</td>
<td>x_fls_flexera_fnms_is_deleted</td>
</tr>
<tr>
<td>StartDate</td>
<td>u_startdate</td>
<td>Starts</td>
<td>starts</td>
</tr>
</tbody>
</table>
### Contract Instance Transform

- Original data from FlexNet Manager Suite: Contracts.
- Staging table in ServiceNow: ast_contract_instance

<table>
<thead>
<tr>
<th>Source Display Name</th>
<th>Source Field</th>
<th>Target Display Name</th>
<th>Target Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>ContractNumber (key)</td>
<td>u_contractnumber</td>
<td>Contract</td>
<td>ast_contract_instance -&gt; vendor_contract</td>
</tr>
<tr>
<td>ContractType</td>
<td>u_contracttype</td>
<td>Contract Type</td>
<td>contract_type</td>
</tr>
<tr>
<td>See note.</td>
<td>See note.</td>
<td>Configuration Item</td>
<td>ci_item</td>
</tr>
</tbody>
</table>

*Note* • Script is run to query `cmdb_ci_computer` table. If the CI is found, the script returns the `sys_id` for REF. If the CI is not found, this field is left blank.

### Software Installation Transform

- Original data from FlexNet Manager Suite: Application.
- Staging table in ServiceNow: cmdb_sam_sw_install

<table>
<thead>
<tr>
<th>Source Display Name</th>
<th>Source Field</th>
<th>Target Display Name</th>
<th>Target Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>ApplicationID (key)</td>
<td>u_applicationid</td>
<td>FlexNet Application ID</td>
<td>x_fls_flexera_application_id</td>
</tr>
<tr>
<td>[Script] (key)</td>
<td>[Script]</td>
<td>Installed on</td>
<td>installed_on</td>
</tr>
<tr>
<td>[Script]</td>
<td>[Script]</td>
<td>Is deleted</td>
<td>x_fls_flexera_fnms_is_deleted</td>
</tr>
<tr>
<td>ApplicationVersion</td>
<td>u_applicationversion</td>
<td>Version</td>
<td>version</td>
</tr>
<tr>
<td>DiscoveredAt</td>
<td>u_discoveredat</td>
<td>Last Discovered</td>
<td>x_fls_flexera_fnms_last_discovered</td>
</tr>
<tr>
<td>DiscoveredBy</td>
<td>u_discoveredby</td>
<td>Discovered by</td>
<td>x_fls_flexera_fnms_discovered_by</td>
</tr>
<tr>
<td>DisplayName</td>
<td>u_displayname</td>
<td>Display name</td>
<td>display_name</td>
</tr>
<tr>
<td>FlexeraID</td>
<td>u_flexeraid</td>
<td>Discovery model -&gt;</td>
<td>discovery_model</td>
</tr>
<tr>
<td></td>
<td></td>
<td>prod_id</td>
<td></td>
</tr>
<tr>
<td>FlexeraID</td>
<td>u_flexeraid</td>
<td>Prod id</td>
<td>prod_id</td>
</tr>
<tr>
<td>LastScanned</td>
<td>u_lastscanned</td>
<td>Last scanned</td>
<td>last_scanned</td>
</tr>
<tr>
<td>Publisher</td>
<td>u_publisher</td>
<td>Publisher</td>
<td>publisher</td>
</tr>
</tbody>
</table>
Software Model Transform

- Original data from FlexNet Manager Suite: Application.
- Staging table in ServiceNow: cmdb_software_product_model

<table>
<thead>
<tr>
<th>Source Display Name</th>
<th>Source Field</th>
<th>Target Display Name</th>
<th>Target Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>FlexeraID (key)</td>
<td>u_flexeraid</td>
<td>FlexNet Manager Id</td>
<td>x_fls_flexera_fnms_id</td>
</tr>
<tr>
<td>ApplicationName</td>
<td>u_applicationname</td>
<td>FlexNet Application Name</td>
<td>x_fls_flexera_fnms_application_name</td>
</tr>
<tr>
<td>ApplicationVersion</td>
<td>u_applicationversion</td>
<td>Version</td>
<td>version</td>
</tr>
<tr>
<td>Classification</td>
<td>u_classification</td>
<td>Type</td>
<td>type</td>
</tr>
<tr>
<td>FlexeraID</td>
<td>u_flexeraid</td>
<td>Short description</td>
<td>short_description</td>
</tr>
<tr>
<td>ProductName</td>
<td>u_productname</td>
<td>Name</td>
<td>name</td>
</tr>
<tr>
<td>Publisher</td>
<td>u_publisher</td>
<td>Manufacturer</td>
<td>manufacturer</td>
</tr>
</tbody>
</table>

Command-line Tool for Export to ServiceNow

This tool extracts data from the FlexNet Manager Suite operations database, and imports it into ServiceNow.

Note • This utility may be triggered in three different ways:

- Automatically by a scheduled task
- Manually by an operator through the web interface for FlexNet Manager Suite. Navigate to the system menu ( diarr in the top right corner) System Settings ➤ServiceNow.
- From the command line, as described in this topic.

In all cases, it exports the data specified to ServiceNow. However, when it is run manually from the command line, the behavior of the utility then differs: it does not update the results in the web interface for FlexNet Manager Suite. For this reason, automatic operations are the preferred method of operation; but this command line is available for testing and troubleshooting.

fnmp_servicenow_export.exe
- url ServiceNow-URL
- user ServiceNow-account-name
- token ServiceNow-token
- endpoint ServiceNow-endpoint
- changes Boolean
- changesPeriod -numberofDays
- changesSince YYYY-MM-DD
- connectionTest true
- withApplications Boolean
- withContracts Boolean
- WithHardwareInventory Boolean
<table>
<thead>
<tr>
<th>Option</th>
<th>Sample value</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>-url</td>
<td><a href="https://YOUR-INSTANCE.service-now.com">https://YOUR-INSTANCE.service-now.com</a></td>
<td>Mandatory. The URL to your ServiceNow server instance in the cloud. Use the HTTPS protocol.</td>
</tr>
<tr>
<td>-user</td>
<td><a href="mailto:account@mydomain.com">account@mydomain.com</a></td>
<td>Mandatory. This is the user name specified in the appropriate credentials set within ServiceNow, the same credentials from which the token is collected.</td>
</tr>
<tr>
<td>-token</td>
<td>86 random alpha-numeric characters</td>
<td>Mandatory. This is the refresh token copied from ServiceNow.</td>
</tr>
<tr>
<td>-endpoint</td>
<td>fnmp.do or api/ x_fls_flexera_fnms/ integration/fnmstosn</td>
<td>Mandatory. Leave the value unchanged. This is the integration point for ServiceNow.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Tip • While the endpoint is visible in ServiceNow and could be modified there, it is also recorded in the operations database for FlexNet Manager Suite. Changing it in ServiceNow without a matching change in the operations database will cause automated exports to fail.</td>
</tr>
<tr>
<td>-changes</td>
<td>true</td>
<td>Optional, with a default of true if it is not present. When this option is not present, or when it is present with a value of true (case insensitive), only differential changes are included in all data exports to ServiceNow. For the baseline from which differences are measured, see the -changesSince or -changesPeriod options. When this option is present and has a value false, all data (from the relevant period) is exported from the relevant tables in FlexNet Manager Suite (which is likely to make the data transforms in ServiceNow considerably more time-consuming).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Tip • You may use the default value even for an initial data transfer, or for the first transfer after an upgrade from an earlier version of the executable. Initial transfers are always the full data set, with differential transfers following thereafter.</td>
</tr>
<tr>
<td>-changesPeriod</td>
<td>-5</td>
<td>Optional (no effect when not present). When present, specifies the time window (as a number of days) before the export for which changes are included in the export. The negative sign is mandatory. The example means that changes in the previous five days are exported. Days are measured as complete 24-hour blocks prior to the time of the export.</td>
</tr>
</tbody>
</table>
| -changesSince | 2015-02-28                                       | Optional. Use only when necessary to override the default date, which is the last run of...
<table>
<thead>
<tr>
<th>Option</th>
<th>Sample value</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>batch scheduler</td>
<td></td>
<td>the batch scheduler on the central batch server for FlexNet Manager Suite (or, for smaller on premises implementations, the server hosting this functionality). The format is YYYY-MM-DD.</td>
</tr>
<tr>
<td>-connectionTest</td>
<td>true</td>
<td>Optional. If this option is provided, and has a value true (case insensitive), no data exports are attempted. The executable attempts a connection to ServiceNow, and reports the results (0 or 2 as described below) on the console. In order to transfer data from FlexNet Manager Suite to ServiceNow, this parameter must either be omitted, or set to false.</td>
</tr>
<tr>
<td>-withApplications</td>
<td>false</td>
<td>Optional. When omitted, it is assumed to be true, and applications are included in the export. If set to false, applications are excluded from the export. Note that at least one of these -with* parameters must be true.</td>
</tr>
<tr>
<td>-withContracts</td>
<td>false</td>
<td>Optional. When omitted, it is assumed to be true, and contracts are included in the export. If set to false, contracts are excluded from the export. Note that at least one of these -with* parameters must be true.</td>
</tr>
<tr>
<td>-WithHardwareInventory</td>
<td>false</td>
<td>Optional. When omitted, it is assumed to be true, and hardware devices are included in the export. If set to false, hardware devices are excluded from the export. Note that at least one of these -with* parameters must be true.</td>
</tr>
</tbody>
</table>

**Caution •** In ServiceNow, contracts and applications/installations both have dependencies on computers/assets. It is recommended that you do not exclude the hardware inventory and asset transfer, as this may result in unpredictable gaps in other records when the correct dependencies cannot be established.

### Result Codes

<table>
<thead>
<tr>
<th>Result Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Success</td>
</tr>
<tr>
<td>1</td>
<td>A data upload to ServiceNow has failed through the maximum number of retries set in the configuration file.</td>
</tr>
<tr>
<td>2</td>
<td>Connection failure, being either of:</td>
</tr>
<tr>
<td></td>
<td>• Failed to connect to ServiceNow. Check the URL and account details for connection.</td>
</tr>
<tr>
<td></td>
<td>• Failure to connect to the FlexNet Manager Suite compliance database.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>3</td>
<td>There is no valid license for execution of the export utility recorded for your enterprise.</td>
</tr>
<tr>
<td>4</td>
<td>Incomplete set of command-line parameters provided (see syntax listing above). Help information is displayed in this case.</td>
</tr>
<tr>
<td>5</td>
<td>An invalid tenantUID was provided. (Not applicable to on premisers implementations.)</td>
</tr>
<tr>
<td>6</td>
<td>Export from FlexNet Manager Suite cannot proceed because ServiceNow has not completed previous pending imports.</td>
</tr>
</tbody>
</table>

**Examples**

This example runs a connection test (because of the final parameter). Although the defaults are set for all data transfers (applications, contracts, and hardware inventory), no exports occur. The command-line result is 0 for good credentials, and 2 for bad credentials.

```
fnmp_servicenow_export.exe
  -token DBBNKvekyBVGxPXe7TAGooeyb5bsByB
  -user myname@mycorp.com
  -url https://myserver.service-now.com
  -endpoint fnmp.do
  -connectionTest true
```

The following example restricts the export to collect only hardware inventory. Because it is not mentioned, the default true value includes hardware inventory, with the other two possibilities excluded. Because the `-changes` and `-changesSince` options are both missing, only hardware changes occurring since the last scheduled export are included.

```
fnmp_servicenow_export.exe
  -token DBBNKvekyBVGxPXe7TAGooeyb5bsByB
  -user myname@mycorp.com
  -url https://myserver.service-now.com
  -endpoint fnmp.do
  -withContracts false
  -withApplications false
```

This example covers all export types from FlexNet Manager Suite, but including only changes that occurred in the previous 3 days, measured back in 24-hour blocks from the time the export is run. Assuming this example is run at 1pm Thursday, it will export only changes from 1pm Monday to 1pm Thursday (all times are local on the batch server). Strictly, `-changes true` is redundant, since this is the default.

```
fnmp_servicenow_export.exe
  -token DBBNKvekyBVGxPXe7TAGooeyb5bsByB
  -user myname@mycorp.com
  -url https://myserver.service-now.com
  -endpoint fnmp.do
  -changes true
  -changesPeriod -3
```
The following topics cover removal of any previously-installed integration application (required before installing the new version on ServiceNow), and improving the performance of ServiceNow with additional database indexes. A possible exception in the ServiceNow log files is also explained.
Removing an Earlier Integration Application

The integration application for ServiceNow (from version 3.0 and later of the adapter) is a scoped application. Scoping is a feature introduced by ServiceNow with its Fuji release, and all previous integration applications used global scope. Now, the integration application has its own private application scope; as such, it is totally different from previous versions of the integration application.

While, technically speaking, two integration applications could be present in ServiceNow at the same time (with their different scopes), it is recommended that you remove any previously-installed integration application for FlexNet Manager Suite before installing the current version.

**Note** • Using the following process to remove all the components of the previous integration application (including its menu, tables, scripts, and user interface components). However, this process does not remove any records from ServiceNow core tables.

1. In ServiceNow, navigate to System Applications > Applications, and click FlexNet Manager Suite Integration.
2. On the page that appears, click Delete. A confirmation dialog appears asking you to type in the word “delete”.
3. Enter delete in the dialog, and click Ok. The application deletion progress dialog appears, and the integration application is deleted.

**Tip** • Sometimes deleting the integration application fails to remove the Scheduled Jobs it created. To check, or to delete them manually:

a) In ServiceNow, navigate to System Scheduler > Scheduled Jobs > Scheduled Jobs.
b) Filter the list of scheduled jobs to find those with Name starting with Export.
c) If the following scheduled jobs exist, delete them manually:
   - Export Assets From ServiceNow
   - Export Contracts From ServiceNow.

Additional ServiceNow Indexes for Performance

Creating additional indexes on your ServiceNow instance substantially improves the intake of data exported from FlexNet Manager Suite.
From the Fuji release, ServiceNow enables you to create your own database indexes. A worked example suggests that, with the following indexes added, you can expect better than four-fold performance increase in the initial data transforms to finish the import of data that has been exported from FlexNet Manager Suite.

<table>
<thead>
<tr>
<th>Database table</th>
<th>New column indexed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contract [ast_contract]</td>
<td>vendor_contract</td>
</tr>
<tr>
<td>Software Model [cmdb_software_product_model]</td>
<td>x_flx_flexera_fnms_id</td>
</tr>
<tr>
<td>Product Model [cmdb_model]</td>
<td>model_number</td>
</tr>
<tr>
<td>Computer [cmdb_ci_computer]</td>
<td>x_flx_flexera_fnms_computer_id</td>
</tr>
<tr>
<td>Software Installation [cmdb_sam_sw_install]</td>
<td>x_flx_flexera_fnms_application_id</td>
</tr>
</tbody>
</table>

**Exception in Log File for ServiceNow**

When using the integration application for version 3.0 (or later), the ServiceNow log file shows an exception like the following (line wrapping amended):

```
[2016-06-14 14:38:49] - [ERROR]: ServiceNowConnectionTest.SendTestConnection:
Error Checking Connection to endpoint: fnmp.do
System.Net.WebException: The remote server returned an error:
(401) Unauthorized.
at FNMP.ServiceNow.HTTP.ServiceNowRequest.GetResponseString(HttpWebRequest request)
in d:\SRC\FNMS\trunk\mgs\Compliance\Importer\Connectors\ServiceNow\FNMP.ServiceNow.Console\HTTP\ServiceNowRequest.cs:line 105
at FNMP.ServiceNow.HTTP.ServiceNowRequest.Post(String content)
in d:\SRC\FNMS runk\mgs\Compliance\Importer\Connectors\ServiceNow\FNMP.ServiceNow.Console\HTTP\ServiceNowRequest.cs:line 68
at FNMP.ServiceNow.HTTP.ServiceNowConnectionTest.SendTestConnection()
in d:\SRC\FNMS runk\mgs\Compliance\Importer\Connectors\ServiceNow\FNMP.ServiceNow.Console\HTTP\ServiceNowConnectionTest.cs:line 30
```

If this exception appeared for version 2 (or earlier) of the integration application, it would mean that the connection information for either ServiceNow or FlexNet Manager Suite was incorrect.

However, for version 3.0 (or later) of the integration application, a single exception of this type is expected, and may be safely ignored. It occurs for the following reasons:

- The ServiceNow export utility simultaneously supports both the version 2 and version 3 architectures.
- The export utility first tries the version 2 endpoint.
- When this version 2 endpoint fails, ServiceNow posts the exception in the log file, and immediately tries the connection to the version 3 endpoint.
- Provided that the connection information is correctly specified in the web interface of FlexNet Manager Suite (through the system menu at **System Settings** > **ServiceNow** tab, available only when the operator is a member of an administrator role), the connection to the version 3 endpoint succeeds and the data transfer can proceed.

This means that, should there ever be a failure with the version 3 connection, two of these exceptions will be logged in rapid succession (the first for version 2 and the second for version 3).
Part VII

XenApp Server Adapter

Topics:
- Architecture, Operations and Prerequisites
- Setting Up the XenApp Server Adapter
- Command-Line Options
- Validation, Troubleshooting, and Limitations
- Database Impacts

The Flexera Software XenApp server adapter allows you to collect software inventory from Citrix XenApp and import it into FlexNet Manager Suite. Depending on the type of virtualized applications being served, the evidence appears in either the installer evidence list (for App-V or streaming profile applications delivered through XenApp), or in the file evidence list (for file-based applications managed through XenApp).

In either case, the evidence must be linked to an application record. This can happen in either of two ways:

- Where the evidence is matched by an existing inventory rule for an application, it is automatically linked to that application record.
- Where required details (below) are incomplete, or there is no existing exact match in any existing evidence rules/records (either supplied by the Application Recognition Library or created locally in your enterprise), the evidence is left in the Discovered Evidence (and All Evidence) page with its Assigned property set to No. The fields that require matching are:
  - For installer evidence, the application name, version and publisher
  - For file evidence, the file name, version, company, and description.

Once the evidence is linked to an application, the application must be linked to a license. The license should then be linked to purchase records to determine your entitlements. Of course, these are manual tasks outside the scope of the adapter's operations.

The term XenApp Server is used in this documentation as a generic term to cover the differently-named control servers for different versions of XenApp:

- In version 6.x, the XenApp Server was officially named the Zone and Data Collector. One such controlling server was required per farm.
- In version 7.5 and later, the XenApp Server is called the Delivery Controller. One such controlling server is required per delivery site.
**Supported versions**

The adapter links the current version of FlexNet Manager Suite to one of the following versions of XenApp:

- Version 6.0
- Version 6.5
- Version 7.5
- Version 7.6.

If it happens that you have multiple of these versions of XenApp in operation (for example in different domains), you can use the same structure described in this section to link them all to FlexNet Manager Suite.
This chapter provides a useful framework for your understanding of the more detailed content to follow.
Architecture and Operation

In order to track licenses for applications delivered remotely to users from a Citrix XenApp environment, FlexNet Manager Suite needs information about which users and devices have access to which applications. There are several sources of such data available from XenApp Servers, depending on the version of XenApp:

• For XenApp 6.0 and 6.5:
  • Access control lists (ACLs)
  • Streaming profiles
  • Citrix EdgeSight servers

• For XenApp 7.5 and later:
  • Access control lists (ACLs)
  • App-V 5 packages (and the applications they contain)
  • For XenApp 7.6 and later, the XenDesktop database supplied as part of XenApp that tracks application usage.

Tip  No usage tracking is possible for XenApp 7.5, as in this release Citrix did not include usage tracking capabilities in XenApp.

Each of these sources is discussed in turn in the following sections.

Access control lists (ACLs)

These are lists which specify the permissions associated with an object, such as an application’s executable file, on a server. The FlexNet Manager Agent for XenApp Server (XenApp Server agent) is a tool that extracts information about users and which applications they can access remotely, and transfers that information to an inventory beacon for use in licensing calculations in FlexNet Manager Suite. To do this, the XenApp Server agent must be installed:

• For XenApp 7.5 and later, on one Delivery Controller for each Delivery Site. If you have multiple Delivery Sites, you may choose either of the following:
  • Install the FlexNet XenApp Server agent on one Delivery Controller in each Delivery Site
  • Use only a single FlexNet XenApp Server agent, and provide that agent with the required network access and credentials to access all required XenApp Delivery Controllers.

• For XenApp 6.0 or 6.5, on one controlling XenApp Server in each Citrix farm.

Tip  While the XenApp Server agent is installed only on one server per farm, for XenApp 6.x you also need software inventory from every XenApp Server, in order to identify the editions of applications available to users and computers. This separate inventory of the XenApp Servers can be obtained either by installing the FlexNet inventory...
agent on the XenApp Server, or using Zero footprint inventory collected by an inventory beacon. Do not get the two separate agents (FlexNet inventory agent, and XenApp Server agent) confused. The main focus of this adapter documentation is the XenApp Server agent.

The XenApp Server agent is supplied as an integral part of the XenApp Server adapter.

---

**Tip** • In previous releases, the XenApp Server agent extracted Active Directory names and details of users and devices from the XenApp Server. Now, the XenApp Server agent collects only Active Directory SIDs (a large performance improvement). As a result, best practice is that your inventory beacon completes its import of Active Directory data before importing XenApp data, so that all Active Directory SIDs can be resolved against the user names, devices, and groups collected directly from Active Directory.

---

**Streaming profiles (for XenApp version 6.0 and 6.5)**

The XenApp Server agent is also able to read the contents of the `.profile` and the key executable files associated with streamed applications published to your XenApp Servers.

---

**Tip** • As the streaming profile is not stored in the XenApp Server’s database, the XenApp Server agent must have at least read access to the streaming profile location to be able to read and extract this information.

As these applications are not physically installed on your XenApp Server, combining the XenApp Server agent’s data from `.profile` files with EdgeSite server information may be the only way for FlexNet Manager Suite to recognise usage of such applications.

---

**Note** • FlexNet Manager Suite is only able to recognize usage of files streamed to a XenApp Server, not those streamed directly to client devices.

---

**Citrix EdgeSight servers (for XenApp 6.0 and 6.5)**

Citrix EdgeSight for XenApp monitors and profiles the usage of remote and streamed applications by users, telling you both who is using that application, and on what device. The data from EdgeSight is very valuable for FlexNet Manager Suite: you may use it for license optimization (for example, tightening access through ACL permissions to exclude users who evidently do not need to use the applications); or it may be critical for any user-based or usage-based licensing of applications delivered through XenApp 6.0 or 6.5.

EdgeSight agents may be installed on each XenApp Server, and report back to a central EdgeSight server, which can keep track of application usage on multiple XenApp machines, belonging to one or more farms. The FlexNet Beacon can connect to each EdgeSight server and collect this usage information for use in compliance calculations.

Unlike data from the XenApp Server agent, EdgeSight data does contain details of which devices access a particular application. Thus, EdgeSight data is usually more valuable to an enterprise for calculating license compliance than the data about application availability returned by the XenApp Server agent alone. If, however,
your enterprise deploys streamed applications, EdgeSight usage data may need to be supplemented by XenApp Server agent information to accurately recognize these applications.

The following information is returned from the EdgeSight server:

- A list of applications (product name, version, publisher, and description) and the users who use them
- The devices on which users request and run applications
- The XenApp Servers from which users request applications
- The farms to which the XenApp Servers belong.

**Tip** • The EdgeSight data does not include application editions. Because different XenApp Servers may have different editions installed (and available to users), it is important to take software (and hardware) inventory of the XenApp Servers themselves, using the FlexNet inventory agent (either installed locally on each server or operating remotely from an inventory beacon). This inventory reveals the software editions available on each of the servers, which can be combined with the information listed above to give complete usage data required for license calculations. For example, if server XenApp01 offers Visio Standard, while server XenApp02 offers Visio Professional, the inventory from XenApp01 and XenApp02, combined with the data listed above, allows the license consumption calculations to link users to the appropriate license.

To use EdgeSight data, you must create a database connection to the EdgeSight SQL server database.

**App-V 5 packages (for XenApp 7.5 or later)**

The XenApp Server agent is able to inspect the contents of App-V 5 packages and recover the name, version, and publisher of the application contained in each package. The agent also returns the user’s ability to access these App-V packages (as recorded in the ACLs described earlier). However, in the ability to track which users actually use the applications, there are differences across versions:

- Version 7.5 has no technology like the EdgeSight server available in version 6.x, and so cannot report application usage
- From version 7.6, XenApp again allows tracking application usage through connection to the XenDesktop database incorporated in XenApp 7.6 and later.

**VDI images (for XenApp 7.5 or later)**

The same capabilities apply to VDI images. The XenApp Server agent interrogates any VDI device managed by the XenApp Server to read the applications listed in all VDI master images available (including spinning up any images that are currently dormant to inspect their applications). As with App-V packages:

- For XenApp version 7.5, there is no ability to track who uses any VDI image, or when
- For XenApp 7.6 and later, the included XenDesktop database allows collection of application usage information.
**Changed architecture across versions**

Because XenApp release 7.5 follows an extensive rewrite of the XenApp line by Citrix, the architectures of the two systems (and therefore the ways that the adapter integrates with the architecture) are quite different from version 6.x to 7.x.

**Tip** • The following three diagrams do not include the import of Active Directory data by the inventory beacon, as this is not part of the adapter itself. However, the prior import of Active Directory data (typically, by the same inventory beacon connecting to the staging database) is a prerequisite for operation of the adapter.

This diagram represents the architecture and data flows for the adapter connected to XenApp 6.0 or 6.5 (the key numbers are referenced in the table below):

![Diagram](image)

The next diagram shows the architecture and data flows when connected to XenApp 7.5. The diagram is laid out similarly to highlight the changes in architecture, and in particular the absence of usage information:
Finally, the third diagram shows the architecture and data flows when connected to XenApp 7.6 or later. The main point to note is the return of usage information:
The following table shows the data collected by the adapter through the different channels numbered in the three diagrams.

**Table 1: Lists imported by XenApp adapter**

<table>
<thead>
<tr>
<th>List</th>
<th>Case 1</th>
<th>Case 2</th>
<th>Case 3</th>
<th>Case 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>User SIDs, Active Directory Group SIDs</td>
<td>Y</td>
<td>Y</td>
<td></td>
<td></td>
</tr>
<tr>
<td>File evidence (.exe) details – file name, version, company, description</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td></td>
</tr>
<tr>
<td>Installer evidence (from App-V/streaming profiles) details – name, version, publisher</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Application access rights per user SID</td>
<td>Y</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Application usage per user</td>
<td></td>
<td>Y</td>
<td>Y*</td>
<td></td>
</tr>
<tr>
<td>Client computer SIDs (with user SIDs)</td>
<td></td>
<td>Y</td>
<td></td>
<td></td>
</tr>
<tr>
<td>XenApp Servers with applications present for delivery</td>
<td>Y</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>App-V packages (and the applications therein) managed by XenApp</td>
<td></td>
<td></td>
<td></td>
<td>Y</td>
</tr>
<tr>
<td>List</td>
<td>Case 1</td>
<td>Case 2</td>
<td>Case 3</td>
<td>Case 4</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>--------</td>
<td>--------</td>
<td>--------</td>
<td>--------</td>
</tr>
<tr>
<td>XenApp Servers that served applications</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Applications available in App-V packages (creates App-V 'evidence' records too)</td>
<td></td>
<td>Y</td>
<td>Y</td>
<td></td>
</tr>
<tr>
<td>Applications available as streaming profiles</td>
<td></td>
<td></td>
<td></td>
<td>Y</td>
</tr>
</tbody>
</table>

* Application usage by users and devices for XenApp 7.6 is limited to applications delivered in App-V packages. (Usage based on imported file evidence is not collected.)

**Operation with XenApp 7.5 and later**

The XenApp Server agent is installed on the XenApp Server (at your discretion, on only one server that can access all other controllers for XenApp in your enterprise, or as many as one per XenApp site).

Triggered by a Windows scheduled task, the agent runs according to your settings. It may collect inventory details only from the XenApp Server on which it is installed (default), or it may collect from several controlling XenApp Servers in sequence (identified with the `-s` command line option, detailed in XenApp Server Agent Command Line Options on page 229).

**a. VDI images**

Based on information found on the XenApp Server, the agent may connect to any relevant XenApp servers hosting VDI images that contain applications. XenApp allows an administrator to nominate applications within VDI images for delivery

1. As individual applications only
2. Within a VDI (delivered as a whole environment) only
3. Either as individual applications or within a VDI.

The XenApp Server agent collects information on all applications within the VDI master images that are identified for individual delivery (options 1 or 3 above). The VDI evidence is returned to FlexNet Manager Suite as file evidence. (For XenApp version 7.6, usage tracking is not available for the file evidence.)

💡 Tip • To track inventory delivered within an entire VDI environment (option 2 above), use XenDesktop discovery and inventory through the rules-based process in the web interface of FlexNet Manager Suite.

**b. App-V packages**

Again based on information gathered from the XenApp Server, the agent connects to any Microsoft App-V publication server to inspect any App-V packages registered for delivery through XenApp. Because XenApp requires App-V version 5 (or later) for integration, the agent can interrogate the packages to identify the applications inside. The App-V evidence is returned to FlexNet Manager Suite as installer evidence.

For XenApp version 7.6 and later (but not for version 7.5), a connection is also made to the XenDesktop database from the appropriate inventory beacon. This collects details of App-V application packages that users and devices have accessed. This additional information restores the ability (missing for version 7.5) to determine which users and devices have actually used each application, as distinct from merely having access to them. This may allow
for more accurate license consumption calculations in later compliance calculations for applications delivered in this way.

### c. Processing

So both kinds of applications are returned to FlexNet Manager Suite as evidence:

- From VDI images, file evidence is produced that normally includes file name, version, company, and description.
- For App-V packages, installer evidence is returned that normally includes application name, version, and publisher.

When the data is finally imported into FlexNet Manager Suite:

- The incoming evidence is tested against existing evidence records (including "rules" generalized with wild cards) already linked to applications (either from the Application Recognition Library or from records produced in your enterprise).

- If the incoming evidence matches any existing rule or record, it is recorded against the linked application, and its presence is recorded in the properties of the appropriate user or device as an "installation" record. For XenApp 7.6 (or later), a usage record is automatically created for each user and each device shown to have accessed the application.

- If the incoming evidence is not matched, it is displayed in evidence listings (for example, navigate to **License Compliance > Evidence** group > **Discovered Evidence**, selecting the **Installer evidence** tab for App-V applications and the **File evidence** tab for VDI applications). You can select the evidence in the appropriate tab, and click **Assign** to choose an application record (or create a new one) to link to the evidence. (You only need do this the first time that new evidence is reported. Once linked to the application, your evidence serves as a 'rule' for matching future imports of the same evidence.)

- Once the incoming evidence is linked to an application (either automatically or manually), license reconciliation attempts to calculate consumption through XenApp on any license linked to the application. For this to take effect, you must correctly configure at least one license attached to the application:
  1. Navigate to the **Use rights & rules** tab of the license properties.
  2. Ensure that the **License consumption rules** heading is expanded (if not, click the heading).
  3. Select **Access granted to users, or usage, consumes license entitlements** to expose additional controls.
  4. Depending on the terms of your license, choose one of **Consume one entitlement for each user** or **Consume one entitlement per device owned by each user**.
  5. For XenApp 7.5, set **License entitlements based on** to **Access** (because only access records are available through XenApp 7.5). For other versions tracking App-V applications, check the terms of your license to see whether usage-based licensing is acceptable for this application, and make selections accordingly.
Prerequisites

The XenApp server adapter requires the following:

- The executable and supporting files for the XenApp server agent. These are available as described in Creating the Staging Database on page 220.

- The XenApp Server (on which the XenApp server agent is installed) requires:
  - .NET version 4.5 or greater
  - PowerShell 2.0 or greater.

- A staging database that can run in a convenient Microsoft SQL Server instance. For example, this may be a database running on the inventory beacon, or on the XenApp Server hosting the XenApp server agent, or on your central operations databases for FlexNet Manager Suite. For more about the requirements for this database, see Creating the Staging Database on page 220.

- An inventory beacon (or multiple if required) that collects Active Directory data for the domain(s) where your XenApp Server(s) are located.

- An inventory beacon (possibly the same as in the previous point) that can connect to your staging database and upload the inventory to the central FlexNet Manager Suite database.

- If you are using XenApp 6.x with the recommended EdgeSight server, an inventory beacon (almost invariably the same one as in the previous point) that can connect to the EdgeSight database.

  Tip • For XenApp 6.x with EdgeSight, also be sure to take inventory from your XenApp Servers so that edition information is available to your license consumption calculations. This inventory may also be collected by an appropriate inventory beacon.

- If you are using XenApp 7.6 or later, an inventory beacon (usually the same one) that can connect to your XenDesktop database, and uploaded the imported data to your central operations databases.

The adapter links the current version of FlexNet Manager Suite to one of the following versions of XenApp:

- Version 6.0
- Version 6.5
- Version 7.5
- Version 7.6.
Setting Up the XenApp Server Adapter

Topics:

- Creating the Staging Database
- Installing the XenApp Server Agent
- Create a Scheduled Task
- Create Connections for Data Upload

The xenapp server adapter is available for different versions of xenapp:

- For version 6.0 and 6.5, it augments information available from Edgesight, particularly about streamed applications
- For version 7.5, it is the primary means of gathering inventory information from xenapp
- For version 7.6 and later, it again augments information about application usage collected from the xendesktop database included with xenapp.

The adapter is automatically saved as part of the standard installation of flexnet manager suite. Installation consists of five main activities, all described in the following topics:

- Setting up the staging database for the inventory that is collected (see _Creating the Staging Database_ on page 220)
- Copying the appropriate folder for the adapter to your chosen xenapp server(s) (see _Installing the XenApp Server Agent_ on page 221)
- Ensuring an appropriate account is available to run the adapter (also in _Installing the XenApp Server Agent_ on page 221)
- Setting up a local scheduled task to run the agent as you require (see _Create a Scheduled Task_ on page 222)
- Setting up a connection from an appropriate inventory beacon to the staging database (see _Create Connections for Data Upload_ on page 224).
Creating the Staging Database

The staging database allows the XenApp server agent to drop collected data in a conveniently close location. From here, an inventory beacon collects the data for transfer to the central operations databases for FlexNet Manager Suite.

The staging database can be installed in any convenient Microsoft SQL Server 2008 (or later) database:

- If your inventory beacon is located on a SQL server, the staging database can be on the inventory beacon.
- If your central operations databases for FlexNet Manager Suite are accessible from the XenApp Server, the staging database tables are already present on your central SQL Server.
- Where there is an inventory beacon with network access to your XenApp Server (and XenApp is running its database in SQL Server), the staging database can be installed into the same database as used by XenApp.
- If none of these suit, any other SQL Server instance that allows network access both from the XenApp server agent on the XenApp Server and from the inventory beacon.

It is a small footprint database (half a dozen tables and one stored procedure) that is size-limited by the scale of your XenApp implementation, with data being replaced at each upload. Installation is by script, as follows:

1. Using Windows Explorer, locate the temporary location where you unzipped the downloaded product archive to install FlexNet Manager Suite.
2. In your unzipped archive, navigate into the `Citrix XenApp Server Agent` subdirectory.
3. Further navigate into the appropriate sub-folder for your version of XenApp:
   - XenAppAgent6
   - XenAppAgent65
   - XenAppAgent75
   - XenAppAgent76.

   **Note** • If it happens that you have multiple different versions of XenApp (for example, in different domains), you may use a single database for all versions of XenApp. The following script is identical in all these folders.

4. From your chosen folder, collect a copy of the database creation/update script `SetupXenAppAgentStagingDatabase.sql`.
5. On your selected SQL Server, drop a copy of this file, and execute it in SQL Server Administration Studio against your chosen database instance.

An appropriate SQL Server database instance:

- Is accessible from the XenApp Server(s) running the XenApp server agent
- Is accessible from the inventory beacon responsible for uploading collected inventory to FlexNet Manager Suite
• Grants read/write access to the account running the scheduled task for the XenApp server adapter (if you choose to use Windows Authentication — if not, take note of the account name and password for database access that you will include in the database connection string)

• Grants read access to the service account running the inventory beacon engine (if you choose to use Windows Authentication — if not, take note of the account name and password for database access that you will include in the database connection string)

The script generates the SQL schema for the database, including creating the appropriate stored procedure. Takes notes for the connection string needed to connect to this database.

Installing the XenApp Server Agent

This procedure assumes you have already located the installation folder where the XenApp server adapter awaits.

1. In your unzipped archive, navigate into the \Citrix XenApp Server Agent subdirectory.
2. Copy the appropriate sub-folder to match your installed version of XenApp:
   • XenAppAgent6
   • XenAppAgent65
   • XenAppAgent75
   • XenAppAgent76.

   **Tip** • If you have different versions of XenApp deployed in different domains, install the appropriate agents on the correct XenApp Servers. Agents for different versions may connect to a single staging database.

3. Using your network, a memory stick, or other available means, paste the entire folder into an appropriate location on your XenApp Server(s).
   For example, you could paste the folder at the root level (such as C:\XenAppAgent75). Keep in mind that for version 6 and 6.5, you must install the agent on a single XenApp Server for each Citrix farm. For version 7.5 (or later), you may choose to install an agent on one XenApp Server in each site, or to install on only one XenApp Server that has network access (and credentials) for all your sites.

4. Ensure that, on your XenApp Server (Delivery Controller), there is an account with sufficient privileges to run the agent in production.
   Such an account:
   • Can run a Windows scheduled task on the XenApp Server where the agent is installed
   • Has read access to the file system on the XenApp Server(s) where it is to collected inventory
   • Has read access to any file shares used to house XenApp packages (versions 6 and 6.5 only), App-V packages, or applications hosted in VDI images
   • For versions 6 and 6.5, is a Citrix Admin account (a limitation in the PowerShell API for those versions means that only a Citrix Admin can retrieve the list of XenApp Servers in a farm)
• For version 7.5 (or later), is a Citrix Read only admin account, with read access to the file systems of any other XenApp Servers sharing locally published applications for which inventory is to be collected

• Is recognized by the SQL Server hosting the shared database (if you prefer to use Windows Authentication for access to the staging database; otherwise, you may choose to include an account name and password in the connection string for the staging database).

Create a Scheduled Task

The XenApp server agent must be run locally on the XenApp Server, where it collects inventory and transfers the data immediately to the staging database. This is triggered by a Windows scheduled task on the XenApp server.

Because the XenApp server agent, as its first action for each inventory collection, clears all old data from the staging database, it is important that the XenApp server agent does not run at the same time as the inventory beacon collects data from the staging database (otherwise, corrupt or incomplete data may result). A buffer of 2 hours provides a good safety margin (depending on the scale of your XenApp implementation).

Another consideration is that you want your XenApp inventory uploaded to the central FlexNet Manager Suite database before the system import and compliance calculations take place. Typically, this process starts around 2am central server time. A two-hour upload buffer should be more than adequate.

These considerations suggest (within a single time zone) a collection schedule around 10pm, an inventory beacon connection around midnight, and everything in place for the nightly compliance calculation.

The process for setting up Windows scheduled tasks varies across different editions of Windows Server. The following example is for Windows Server 2012. Adjust for your XenApp server's conditions.

1. In Windows Explorer, navigate to Control Panel > System and Security > Administrative Tools, and double-click Task Scheduler.

   The Task Scheduler window appears.

2. In the navigation tree on the left, select Task Scheduler Library, and then in the Actions list on the right, click New Folder....

   A dialog appears for entering the folder name.
A suggested value is FlexNet Manager Suite.

3. Click OK, and select the new folder in the navigation tree.

4. Select Action > Create Task....
   The Create Task dialog appears.

5. Enter an appropriate Name, such as FlexNet Manager Agent for XenApp Server, and add any Description to help future maintenance of this task.
   Your description may be something like Collects application and access information from a Citrix XenApp server and transfers this information to a staging database.

6. Click Change User or Group....
   The Select User, Service Account, or Group dialog appears.

7. Enter the account name that is to run the scheduled task, and click OK.
   This is the account you identified in Installing the XenApp Server Agent on page 221, and you can check the requirements for this account there.

8. Further down in the Security options group, select Run whether user is logged in or not.

9. Switch to the Triggers tab, and click New....
   The New Trigger dialog appears.

10. Ensure that the default setting Begin the task On a schedule is selected, set the parameters for the schedule, and from the Advanced settings group, be sure that Enabled is selected.
The suggested schedule is daily at 10pm local time, but be sure that this suits the upload procedures for your enterprise.

11. Switch to the Action tab, and click New...
   The New Action dialog appears.

12. Ensure that the default Action, Start a program, is selected, and browse to your local copy of FnmpXenAppServerAgent.exe.

13. In the Add arguments (optional) field, specify all the command-line arguments you need for the agent.
   All command line arguments are documented in XenApp Server Agent Command Line Options on page 229. For common implementations, you need to define only the connection string to the staging database. In addition, if you are using XenApp 7.5 (or later) and want a single agent to collect inventory from multiple servers, you need the option to define those servers.

   Example 1: Command line arguments to connect to your staging database.
   
   ```
   -d "Data Source=192.168.13.38;Initial Catalog=MyStaging;User ID=accountName;Password=password"
   ```

   Example 2: For XenApp 7.5 (or later), accessing multiple XenApp Servers and recording their details in a common staging database (all on one line):
   
   ```
   -d "Data Source=192.168.13.38;Initial Catalog=MyStaging;User ID=accountName;Password=password"
   -s "localhost, xda01.fqdn.com"
   ```

14. Click OK.

15. Optionally, make any preferred adjustments to the Conditions or Settings tabs (normally the defaults are acceptable).

16. Click OK to close the Create Task dialog.
   The new task appears in the list of scheduled tasks for this server.

17. Right-click the new task, and click Run in the context menu.
   This checks that the scheduled task completes successfully.

18. Validate operations in the following ways:
   - Review the log file (FnmpXenAppAgent.log in the same folder as the agent’s executable file) for any errors or warning messages.
   - Use Microsoft SQL Server Management Studio to check the contents of the staging database.

---

Create Connections for Data Upload

The XenApp server agent gathers inventory information from your XenApp Server, and saves it in a staging database. Now an inventory beacon is responsible for uploading the data to the central operations databases of FlexNet Manager Suite. This requires two things:

- Defining a connection to the staging database.
- Defining a schedule to trigger collection of inventory data from the staging database.
In addition, with the exception of XenApp version 7.5, a connection to the appropriate database is strongly recommended, as this allows tracking who is actually using applications:

- If you are using XenApp 6.0 or 6.5, the connection is to your EdgeSight server database
- If you are using XenApp 7.6 or later, the connection is to the XenDesktop database included with XenApp.

Perform this process on the inventory beacon.

1. Log in to your selected inventory beacon.

   \[\text{Tip}\] Starting the Inventory Beacon interface requires that you are logged in with administrator privileges.

2. If you have not already specified a schedule (or two) that can be linked to the connection(s) you are about to create, it's convenient to do so now.

   There are two connections for each version of XenApp except version 7.5, which needs only one. Remember that you already decided on the schedule for data collection on the XenApp Server (see Create a Scheduled Task on page 222), and the schedules on the inventory beacon need to tie in with that plan. For example, you might schedule the connection to the staging database at midnight, and the secondary connection for usage data at 12:15am. For details about creating a schedule on the inventory beacon, see FlexNet Manager Suite Help > Inventory Beacons > Scheduling Page > Creating a Data Gathering Schedule.

3. In the navigation pane on the left, select the Inventory systems page, and towards the bottom of the page, click **New...**

   The Create SQL Source Connection dialog opens.

   \[\text{Tip}\] The **New...** button defaults to creating a connection for Microsoft SQL Server. If you use the down arrow on the split button, you can also select between Microsoft SQL Server, Other, and Spreadsheet connections.

4. Complete the values in the dialog, as follows:

<table>
<thead>
<tr>
<th>Control</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection name</td>
<td>A descriptive name for this connection, such as <code>XenApp ServerName Staging DB</code>.</td>
</tr>
<tr>
<td>Source Type</td>
<td>Select <strong>Citrix XenApp (Server Agent)</strong>. (Don't be confused by <strong>Citrix XenApp (EdgeSight)</strong>, which you may use shortly.)</td>
</tr>
<tr>
<td>Server</td>
<td>Type the server name or IP address. Use the special value <code>(localhost)</code> if the database is installed on this same inventory beacon server. If the database instance you need is not the default one on the server you identify, add the instance name, separated with a backslash character. Example: <code>(localhost)\myInstance</code></td>
</tr>
<tr>
<td>Authentication</td>
<td>Select one of:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Windows Authentication</strong> — Select this option to use standard Windows authentication to access the database server. The credentials of the account (on the inventory beacon) running the scheduled task for importing inventory</td>
</tr>
</tbody>
</table>
Control | Comments
---|---
| are used to access the SQL Server database. This account must be added to a security group that has access to the database.
• **Windows (specific account)** — Specify an account on the inventory beacon that can make a connection to the SQL database.
• **SQL Authentication** — If you select this option, you must then specify an account and password already known to SQL Server on the target database. This account is used to access the database, regardless of the local account running the scheduled task on the beacon server.

| Username | The account name used for SQL authentication, or Windows (specific account). (Not required for Windows Authentication.)
| Password | The password for the account name required for SQL authentication, or Windows (specific account). (Not required for Windows Authentication.)
| Database | Enter the name of the database, or use the pull-down list to select from database names automatically detected on your specified server.
| Connection is in test mode (do not import results) | Controls the uploading and importing of data from this connection:
• When this check box is clear, the connection is in production mode, and data collected through this adapter is uploaded to the central server and (in due course) imported into the database there.
• When the check box is set:
  • The adapter for this connection is exercised, with data written to the intermediate file in the staging folder on the inventory beacon (%CommonAppData%\Flexera Software\Beacon\IntermediateData)
  • The immediate upload that normally follows data collection is suppressed, so that you can inspect the contents of the file
  • The catch-up process that retries stalled uploads, normally scheduled overnight, runs as usual and uploads the file to the central server
  • At the central server, the file contents are discarded (and not imported into the central database).
| Overlapping Inventory Filter | This control does not apply to XenApp inventory records, and you may leave it at the default setting.

5. **Click Test Connection.**

• If the inventory beacon can successfully connect to the nominated database using the details supplied, a **Database connection succeeded** message displays. Click **OK** to close the message. Click **Save** to complete the addition. The connection is added to (or updated in) the list.

• If the inventory beacon cannot connect, a **Database connection failed** message is displayed, with information about why that connection could not be made. Click **OK** to close the message. Edit the connection details and retest the connection.
You cannot save the connection details if the connection test fails. If you cannot get the connection test to succeed, click **Cancel** to cancel the addition of these connection details.

6. When the connection to the staging database is successful, and if you are using any XenApp version other than 7.5, repeat the steps above to define a second connection to the usage database (EdgeSight database for version 6.x, and XenDesktop database for version 7.5 and later). This time through, for all these versions set the **Source Type** control to **Citrix XenApp (EdgeSight)** (including for XenApp version 7.5 and later).

7. On the **Inventory systems** page, from the list of connections select the one to the staging database you created in this process, and below the list, click **Schedule**.

8. In the resulting dialog, choose the schedule you wish to use for this connection, and then click **OK** to close the dialog, and **Save** to apply the selected schedule to your connection.

9. For any XenApp version other than 7.5, on the **Inventory systems** page, from the list of connections select the EdgeSight connection, and repeat the scheduling process, choosing the second schedule you created.

Don't forget, as you move this XenApp adapter into production, to ensure that **Connection is in test mode (do not import results)** is clear (not checked).
3

Command-Line Options

Topics:

- XenApp Server Agent Command Line Options

For those times when you want to control execution of the command-line agent directly, this chapter covers all options.
XenApp Server Agent Command Line Options

Details for manual operation from the command line.

The FlexNet Manager Agent for XenApp Server (fnmpXenAppAgent.exe), or XenApp server agent, is a command line tool which runs regularly on a Citrix XenApp server to determine which end-users have the right to run applications through that server. The data it collects is sent back to FlexNet Manager Suite and processed further once the inventory import process runs.

Syntax

fnmpXenAppAgent.exe [options...]

Options

-d connection
-h
-i true/false
-o output_file
-s servers
-t timeout
-v 0|1

where

-d connection A database connection string to your staging database. Refer to http://www.connectionstrings.com/sql-server-2008 for some examples. If you do not have a staging database but connect directly to your central inventory database, create the connection string for that database.

Note • Do not use the -d option and the -o option at the same time.

-h Displays usage for the XenApp server agent.

-i true/false (Default false.) Ignore errors. Used only for debugging purposes so that the adapter runs end-to-end and logs all issues in the log file (in the same directory as the agent executable).

-o output_file The full path of a file to store the output of the XenApp server agent as it runs. Use such an output file for debugging purposes, to see the content collected by the agent. The output file is not required for normal operations (the collected data is uploaded directly to the staging database).

Note • Do not use the -d option and the -o option at the same time.

-s servers Option only for Citrix XenApp 7.5 (and later). For both 6.5 (which does not support this option) and 7.5 or later (where the option may be omitted), the XenApp server agent assumes that it is running on the XenApp Server from which it is to collect inventory. In both systems, therefore, you may handle multiple XenApp Servers by

-t timeout

-v 0|1
installing the XenApp server agent on each one. When the agent is installed locally on the XenApp Server from which it gathers inventory, omit this option.

In Citrix XenApp 7.5 or later, you have the option for a XenApp server agent installed on a single XenApp Server to collect the inventory for all XenApp Servers in a server farm. To do this, create a comma-separated list of fully-qualified domain names or IP addresses for all the servers from which this agent should collect inventory. Inside such a list, use the keyword `localhost` to include the server on which the XenApp server agent is installed.

---

**Note** • The account executing the XenApp server agent must have permissions to connect to each of the servers named in your list.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>-t</code> <code>timeout</code></td>
<td>The timeout period (in seconds) when connecting to the staging database (default 600 seconds). If the timeout expires, the upload fails, and the data collected from the XenApp Servers on this occasion is lost. An entry is made in the log file (in the same directory as the agent executable) to record the failed connection.</td>
</tr>
<tr>
<td><code>-v</code> `0</td>
<td>1`</td>
</tr>
</tbody>
</table>

**Examples**

The following examples are split across several lines for readability. Run each example on a single command line.

Use Windows Authentication (for the account running the scheduled task, or the command line) to connect to the staging database with a ten minute (600 second) timeout:

```
FnmpXenAppAgent.exe
   -d "Server=192.168.13.38;Database=MyStaging;Trusted_Connection=yes;"
   -t=600
```

Use a particular user name and password to connect to the staging database:

```
FnmpXenAppAgent.exe
   -d "Data Source=192.168.13.38;Initial Catalog=MyStaging;UserID=accountName;Password=password"
```

Collecting inventory (in Citrix XenApp 7.5) from two servers, and for debugging purposes, saving the collected data in an XML file:

```
FnmpXenAppAgent.exe
   -s "localhost, xda01.fqdn.com"
   -o "c:\XenAppTest.xml"
```
Validation, Troubleshooting, and Limitations

Topics:

- Validation and Problem Solving
- Limitations

This chapter may assist in diagnosing operations of the adapter, as well as explaining certain inherent limitations in its operation.
Validation and Problem Solving

Because the XenApp server adapter has a number of moving parts, validation and problem solving may also involve multiple steps.

After initial implementation, the simplest validation is simply to inspect the additional installer evidence (for App-V applications) and file evidence (for VDI applications) that are collected by the adapter, and displayed in the web interface for FlexNet Manager Suite. Keep in mind that to complete the end-to-end process, you may need to

- Manually link the evidence to an appropriate application
- Ensure that the application is linked to a suitable license
- Record entitlements on the license, typically by linking purchases to it.

Also remember that you must be importing information from Active Directory prior to importing inventory through the XenApp server adapter.

When more detailed analysis is required, you may use the following checks.

XenApp server agent

The XenApp server agent, installed on your XenApp Server, records a log file in the same folder where it is installed. The log file is replaced at each inventory collection (that is, each time the scheduled task triggers the agent). Review the log for details of any problems. To increase the level of detail, run the agent with the command-line option `-v 1`.

To see all the information that the XenApp server agent has collected, run the agent without a `-d` option (the path to the staging database) and instead using a `-o` option with a path to a convenient local folder. This saves a plain-text XML file of the collected inventory that you can inspect in your preferred text editor. This is a valuable check point when some inventory is being returned, but particular expected applications seem to be missing. If these are missing from a file output with the `-o` option, look for reasons preventing agent access to the source information. Examples might include credentials or access rights to folders containing packages.

If you use the `-o` option, don't forget to replace it with the `-d` option for normal operations!

Staging database

When records missing from the web interface for FlexNet Manager Suite are present in the output of the XenApp server agent (see previous section), next use Microsoft SQL Server Administration Studio to inspect the contents of the staging database. Recall that the contents of the staging database are over-written with each inventory collection by the XenApp server agent. This means that there may be legitimate differences between an output file obtained in the previous section, and the database contents examined in this section. Such differences may come about if there is additional access granted to XenApp applications (the source data) in between the time the agent is run to output the test file, and the time it is run to populate the staging database. In general, however, there should be a high degree of correlation between the two data sets.

The inventory beacon intermediate file

Next, you can validate the data set that the inventory beacon collects from the staging database. Simply trigger the connection to the staging database in test mode, as described in Create Connections for Data Upload on page 224. This allows you to inspect the zip archive, which would otherwise be uploaded to the central server, in
%CommonAppData%\Flexera Software\Beacon\IntermediateData on the inventory beacon. Provided that you make comparisons before the next run of the XenApp server agent, you should find 1:1 correspondence between the data in the staging database and the intermediate file.

**Uploads and imports**

If the required data has made it into the intermediate file on the inventory beacon, you may need to debug uploads from the inventory beacon to the central server (for example, see FlexNet Manager Suite Help > Inventory Beacons > Inventory Beacon Reference > Troubleshooting: Inventory Not Uploading).

Keep in mind that there is a delay between the upload from the inventory beacon to the central server, and the appearance of the data in the web interface for FlexNet Manager Suite. There must be an inventory import and compliance calculation that occurs between these two events. If you are a member of the Administrator role, in the web interface you may manually trigger an import and compliance calculation.

**Limitations**

The following limitations apply to the XenApp adapter:

- Information about who has access to applications on the one hand, and about who actually uses applications on the other, is collected separately. Usage data relies on a Citrix EdgeSight server (for XenApp 6.x) or the XenDesktop database included with XenApp version 7.5 and later. Since XenApp 7.5 does not support it, no usage information is available for this version; and if you are using any other version without the appropriate database connection, again no usage information is available.

- When the XenApp server agent connects to a VDI image to read the applications it contains, and the image is not currently running, the agent attempts to start up a server running the image for interrogation (and will shut it down again afterward). This relies on the remote support of power actions (on and off, and so on) for the master image. Where these are not available, or the XenDesktop does not have sufficient resources to spin up another image, the start-up attempt fails. In these cases, the agent imports the name of the executable, but it is missing the version, company, and description details. These cases appear in the list of file evidence with the executable name, but with the name, version, company, and description columns blank.

- XenApp supports “application delivery from a remote PC” and “application delivery from the cloud”. Neither of these is supported by the adapter, and no inventory is returned for such cases.

- To improve performance compared with earlier versions of the XenApp adapter, the XenApp server agent no longer collects user names and computer names through the XenApp Server. Instead, it collects only the Active Directory security IDs (SIDs) from XenApp, and relies on the separate import from Active Directory to flesh out the SIDs with more complete identities. This has two immediate implications:

  - If you are upgrading from an earlier version of the XenApp adapter, the data from the access control lists (ACLs) on the XenApp Server is removed on upgrade. An import from Active Directory is then required to populate the SIDs and other identity details. After the first inventory import in the upgraded system, the access data is repopulated.

  - If Active Directory information is not imported by an inventory beacon for the domain(s) in which the XenApp Servers (the ones hosting the XenApp server agent) are located, users and computers newly
registered in Active Directory (since the last import of Active Directory data) will not be recognized or displayed in FlexNet Manager Suite.

- For XenApp version 7.6 and later, application usage information is available only for App-V packages and applications, and streaming profile applications. Usage information is not available for file-based applications, including VDI applications delivered through XenApp.
This chapter provides an overview of database tables within FlexNet Manager Suite that are affected by the adapter. These brief notes can be augmented by reviewing the Schema Reference document for the current release.
Affected Database Tables

The XenApp server adapter causes data to be imported to the following database tables in the operations databases for FlexNet Manager Suite (specifically the compliance database). You may prepare custom reports against these:

- **ComplianceDomain** records the domain of the XenApp Server where the XenApp server agent is installed. If the record does not already exist, on import both the FQDN and the flat name are populated.

- **ComplianceUser** records are created for any user names identified in the XenApp inventory but not previously in the operations databases. In these new records, only the **UserName**, **SAMAccountName**, and domain are available and saved (with **ComplianceUserID** calculated automatically). (The domain is a link to the **ComplianceDomain** table, which once again is updated as required with any new records. Such updates should be rare, since domains should be identified from Active Directory.) Because the **ComplianceUser** records created from XenApp inventory imports are far from complete, you may want to enhance these with additional information.

- **ComplianceComputer** records may be created if a **ComplianceUser** record is created (or identified) that has no link to an existing **ComplianceComputer** record. For many types of license, the consumption record is linked to an individual **ComplianceComputer**, so when it is impossible to identify a computer for a particular **ComplianceUser**, a new skeleton computer record is created. These have a computer name of the form

  **UserName (Remote)**

  and have their type shown as Remote Device. (This type is identified through a foreign key to the **ComplianceComputerType** table.) They are also linked to the **ComplianceUser** for whom they are created.

  **Tip** • If, in future, inventory from another source identifies the same **ComplianceUser** as either the assigned user or the calculated user for a computer identified by that inventory, then this placeholder record for the remote device is removed, and any license consumption recorded against it is moved to the newly-identified (real) computer that belongs with the user.

- For App-V applications managed by XenApp 7.5 or later, or any XenApp applications managed by version 6.x:
  - **InstallerEvidence** records are created as the primary inventory data for the use of those applications.
  - **InstalledInstallerEvidence** records are create to link that evidence to the appropriate **ComplianceComputer** records.

  Where the application name, version, and publisher in the **InstallerEvidence** table match an existing evidence rule for an application, an entry is created in the **SoftwareTitleInstallerEvidence** table to link (by foreign keys) the installer evidence to the application record in the **SoftwareTitle** table.

- For VDI applications managed by XenApp 7.5 or later:
  - **FileEvidence** records are created as the primary inventory data for the use of those applications.
  - **InstalledFileEvidence** records are create to link that evidence to the appropriate **ComplianceComputer** records.
• Where the file name, version, company, and description in the FileEvidence table match an existing evidence rule for an application, an entry is created in the SoftwareTitleFileEvidence table to link (by foreign keys) the file evidence to the application record in the SoftwareTitle table.

• InstalledApplications records are created for any applications identified in the SoftwareTitle table, linking the application to the ComplianceComputer record.